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Getting help and support

Technical support

Tektronix values your feedback on our products. To help us serve you better,
please send us your suggestions, ideas, or comments on your application or
oscilloscope. Contact Tektronix through mail, telephone, or the Web site,
www.tektronix.com.

When you contact Tektronix Technical Support, please include the following
information (be as specific as possible):

General Information All instrument model numbers

®» Hardware options, if any
= Probes used
®  Your name, company, mailing address, phone number, FAX number

m  Please indicate if you would like to be contacted by Tektronix about your
suggestion or comments.

Software version number

Application Specific
Information

Description of the problem such that technical support can duplicate the
problem

m Ifpossible, save the setup files for all the instruments used and the
application.

m  Ifpossible, save the TekExpress setup files, log.xml, *.TekX (session files
and folders), and status messages text file.

m Ifpossible, save the waveform on which you are performing the
measurement as a .wfm file.
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Overview and key specifications

Overview and key specifications

The TekExpress HDM Advanced Analysis and Compliance Solution gives you
the tools to easily run high definition multimedia interface (HDMI) tests under
the HDMI Compliance test specifications 2.0. It provides a complete and reliable
solution for quick testing.

The application functionality is generally divided into three parts: the Source
Suite, the Sink Electrical Suite, and the Sink Protocol Suite. You can select which
suite and which version of the CTS you would like to use by clicking on the
Setup panel and clicking the DUT tab.

Supported Tests:

TekExpress HDM Source supports these automated Single ended and
Differential tests.

TekExpress HDM Sink supports these automated Sink fests.

Supported Resolutions: HDM Source supports these resolutions.

HDM Sink supports these resolutions.

Iso: . :
See also Equipment connection setup HDM Source

Equipment connection setup HDM Sink
Install the software

Application directories and usage

File name extensions

Instrument control settings

TekExpress HDM Advanced Analysis and Compliance Solution 3



Overview and key specifications

Supported tests- HDM Source

TekExpress HDM Source supports automation of following differential and
single-ended tests:

Differential tests

HF1-2: Source TMDS Electrical — 6G — TRISE, TFALL

This test confirms that the rise times and fall times on the TMDS differential
signals fall within the limits of the specification.

HF1-3: Source TMDS Electrical — 6G — Inter-Pair Skew

This test confirms that the skew between two data lanes on the TMDS
differential signals fall within the limits of the specification.

HF1-5: Source TMDS Electrical — 6G — Differential Voltage

This test confirms that the voltage level of the TMDS differential signals
complies with the limits mentioned in specification.

HF1-6: Source TMDS Electrical — 6G — Clock Duty Cycle and Clock Rate

This test confirms that the duty cycle and clock rate of the TMDS differential
clock complies with the limits mentioned in specification.

HF1-7: Source TMDS Electrical — 6G — Clock Jitter

This test confirms that the clock jitter of the TMDS differential clock
complies with the limits mentioned in specification.

Single ended tests

HF1-8: Source TMDS Electrical — 6G — Data Eye diagram

This test confirms that the HDMI Data output has signal quality that meets
the eye opening required by the specification

HF1-1: Source TMDS Electrical — 6G — VL and VSwing

This test confirms that the low voltage level of the TMDS single ended
signals complies with the limits mentioned in specification.

HF1-4: Source TMDS Electrical — 6G — Intra-Pair Skew

This test confirms that the skew between the positive and negative lane of the
TMDS single ended signals complies with the limits mentioned in
specification.
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Overview and key specifications

Supported tests- HDM Sink

TekExpress HDM Sink supports the following automated HDM Sink Electrical
and Sink Protocol tests.

These tests are supported for CTS Version 2.0:

HDM Sink Electrical tests

= HF 2-1-Min/Max Differential Swing Tolerance

= HF 2-2-Intra-Pair Skew

= HF 2-3-Jitter Tolerance

HDM Sink Protocol tests

= HF2-6 Sink Video Timing - 6G - 2160p 24 bit Color Depth
= HF2-7 Sink Video Timing - 6G - 2160p Deep Color

= HF2-8 Sink Video Timing - 6G - 2160p 3D

= HF2-23 Sink Pixel Decoding YCBCR 4:2:0

= HF2-24 Sink Pixel Decoding YCBCR 4:2:0 Deep Color

= HF2-25 Sink Video Timing - 21:9

= HF2-36 Sink Video Timing - 6G - Non-2160p 24 bit Color Depth
= HF2-37 Sink Video Timing - 6G - Non-2160p Deep Color
= HF2-38 Sink Video Timing - 6G - Non-2160p 3D

These tests are supported for CTS Version 1.4:

HDM Sink Electrical tests

= Test ID 8-5: TMDS-Min/Max Differential Swing Tolerance
= Test ID 8-6: TMDS-Intra-Pair Skew

m  Test ID8-7: TMDS-Jitter Tolerance

HDM Sink Protocol tests

m  Test ID 8-15: Character Synchronization

= Test ID8 -16: Acceptance of All Valid Packet Types

= Test ID 8-19: Pixel Encoding Requirements

= Test ID 8-20: Video Format Timing

= Test ID8-21: Audio Clock Regeneration

m  Test ID 8-22: Audio Sample Packet Jitter

= Test ID 8-23: Audio Formats

= Test ID 8-24: Interoperability with DVI

= Test ID 8-25: Deep Color

= Test ID 8-28: One Bit Audio

TekExpress HDM Advanced Analysis and Compliance Solution 5



Overview and key specifications

m  Test ID 8-29: 3D Video Format Timing
= Test ID 8-30: 4K 2K Video Format Timing
m  Test ID 8-31: Extended Colors and Contents

Supported resolutions- HDM Source

CTS 2.0: All of the TekExpress HDM tests can be performed for DUTs
operating in resolutions between 3.4 GHz to 6 GHz. Other resolutions that fall
within this range can be entered in the Low Resolution and High Resolution
fields on the DUT tab of the Setup panel.

When Low and High resolutions are the same, the software performs the test at
that one resolution.

Table 1: Supported resolutions (Source)

DUT Configuration

Measurement name Highest supported TMDS Lowest supported TMDS
Character rate Character rate

HF 1-1: V|, and Vswing N/A Yes

HF 1-7: Trise and TearL Yes N/A

HF 1-3: Inter-Pair Skew Yes N/A

HF 1-3: Inter-Pair Skew Yes N/A

HF 1-5: Differential Voltage

Eye Width N/A Yes

Maximum Differential Voltage | N/A Yes

Maximum Differential Voltage | N/A Yes

HF 1-6: Clock Duty Cycle and

Clock rate

Maximum Duty Cycle Yes Yes

Minimum Duty Cycle Yes Yes

Clock Rate Yes Yes

HF 1-7- Clock Jitter Yes N/A

Vswing Yes N/A

HF 1-8-Data Eye Diagram Yes N/A

Supported resolutions- HDM Sink

CTS 2.0: All of the TekExpress HDM Sink tests can be performed at data rates
2.97 GHz, 3.71 GHz, 4.46 GHz and 5.94 GHz.

CTS 1.4: All of the TekExpress HDM Sink tests can be performed at data rates
27 MHz, 74.25 MHz, 148.5 MHz, 222.75 MHz and 297 MHz.
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Operating basics

Equipment connection setup (HDM Source)

You need the following equipment to run HDM Source tests. (For details, see
Minimum system requirements):

A supported Tektronix oscilloscope

Four differential probes — P7313SMA, for single ended and differential tests
Four differential probes — P7720, for single ended and differential tests
Device under test (DUT)

TF-HDM-TPA-S fixture

A PWS4205, PWS2185, Keithley 24XX or 2220-30-1/ 2220J-30-1 Dual
Power Supply (if using external power supply option)

Any approved EDID analyzer

Connection diagrams and the tests they apply to are listed below.

Single-ended and differential tests

NOTE. In case of single stack 2 channel oscilloscopes, you need to make
appropriate channel configurations in TekExpress HDM software:
DPO750025SX, DPO75902SX, and DPO77002SX.

Table 2: Source differential tests

Test number and characteristic tested Setup diagram

HF1-2: Source TMDS Electrical - 6G — TRISE, | Source differential diagram

TFALL Source differential diagram for SX series
oscilloscopes

HF1-3: Source TMDS Electrical — 6G — Inter- Source differential diagram

Pair Skew Source differential diagram for SX series
oscilloscopes

HF1-5: Source TMDS Electrical — 6G — Source differential diagram

Differential Voltage Source differential diagram for SX series
oscilloscopes

HF1-6: Source TMDS Electrical - 6G — Clock | Clock diagram

Duty Cycle Clock diagram for SX series oscilloscopes

HF1-7: Source TMDS Electrical - 6G — Clock | Clock diagram

Jitter Clock diagram for SX series oscilloscopes
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Operating basics

Schematic for Source differential diagram

Differential measurement

& 6 6
L@ @

Power supply *

i
| 7 T~CLOCK_N

q‘\ CLOCK_P

5 | EDID emulator / EDID PCB

‘*\wggi
DUT (17 ’\;x,‘

o gy DATOP A
\ =" DATAON L
Second row of 1 %}\j\—"'

connectors below ~ ;
| 447 CLK CLOCK_P

i

TN CLOCK_N
Notes:

Connect to Biased 5002 Termination of all unoccupied lanes.

*
Scope has the capability to support the probe termination voltage. oese1s

Schematic for Source differential diagram for SX series scopes
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Differential measurement

=0

Cin

ooy

Power supply *

CJ CLOCK_I_D
W EDID emulator / EDID PCB

DUT

A DATAO_P M
— | X

ﬁ‘»@/ DATAON |
Second row of v;;@/
connectors below —

| CLK CLOCK_P

. CLOCK N

Notes: —(Pullup)

Con nect to Biased 5002 Termination of all unoccupied lanes.
Scope has the capability to support the probe termination voltage. 0926061
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Operating basics

Table 3: Source single ended tests

Test number and characteristic tested Setup diagram

HF1-8: Source TMDS Electrical - 6G — Data Source data eye diagram
Eye Diagram Source data eye diagram
HF1-1: Source TMDS Electrical - 6G — VL and | Source single ended diagram
VSwing Source single ended diagram

HF1-4: Source TMDS Electrical - 6G — Intra- | Source single ended diagram
Pair Skew

Schematic for Source data eye diagram

NOTE. In case of single stack 2 channel oscilloscopes you have to make
appropriate channel configurations in TekExpress HDM software:
DPO723025X, DPO733025X, DPO750025X, DPO759028X, and DPO770028SX

Data eye diagram measurement

I=
I
|

Power supply
[03.30]
S ."s" /I - - l ’
Yl g S| /"".
- el
= 1 7~ Data_PIN
ey 7 TCLOCKN
(3 CLOCK_P
;W; EDID emulator / EDID PCB
DUT [ ]
A
(-
Second row of
connectors below -
CLK CLOCK_P
CLOCK_N
Notes:
Connect to Biased 5002 Termination of all unoccupied lanes.
*Soope has the capability to support the probe termination vollage. 026028
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Operating basics

Source data eye diagram for SX series oscilloscopes

Data eye diagram measurement

Power supply

Power supply * @

)Y -
: ~g
] \CLOCK_P

_T‘Ni— EDID emulator / EDID PCB

e CPulp)
A
R by pataop A
Yo DATAON A
Second row of wi
|y
connectors below ~
| g@; CLK CLOCK_P
L
N CLOCK_N
Notes:
Connect to Biased 502 Termination of all unoccupied lanes.
Scope has the capability to support the probe termination voltage. 826063
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Source single ended diagram

Single ended measurement

Power supply *

—_—

|
T‘J EDID emulator / EDID PCB

/ D2  DATA2P
W) DATA2_N

DUT J_ "‘gf\"’
N S

Second row of
connectors below

1 ﬁ/“ CLK CLOCK P

1 3 ( —
L cLockn
Notes:

Connect to Biased 50€2 Termination of all unoccupied lanes.

*
Scope has the capability to support the probe termination voltage.

0926028

12 TekExpress HDM Advanced Analysis and Compliance Solution



Operating basics

Source single ended diagram for SX series oscilloscopes

Single ended measurement

e ]

Power supply *

J7———CLOCK_P

9 [

L—‘HW EDID emulator / EDID PCB

D2 DATA2 P ST
DATA2N /DT
DUT

L

Second row of \v;é@

connectors below w‘ y
| CLK CLOCK_P
L
CLOCK_N
Notes:
Connect to Biased 50Q2 Termination of all unoccupied lanes.
Scope has the capability to support the probe termination voltage. 0926062
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Schematic for Clock diagram

Differential measurement

Power supply *

“&y )~ “CLOCKN

}\CLOCK_P

c ‘ EDID emulator / EDID PCB

-
\ )
Secondrowof N A \(Pulw)

connectors below | .
I 472 CLK CLOCK P
LS

A CLOCK_N

Notes:
Connect to TF-HDMI-TPA-T termination fixture
*Scope has the capability to support the probe termination voltage
. Wifiniags p - -
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Schematic for Clock diagram for SX series oscilloscopes

Differential measurement

(miron

_J

[ ]

Power supply *

ﬁ CLOCK_P
W EDID emulator / EDID PCB

&
J

&
|

i

T 4 CLK CLOCK_P
- CLOCK_N

Second row of
connectors below

Notes:

Connect to TF-HDMI-T termination fixture

*Scope has the capability to support the probe termination voltage. (626080
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See Also

Equipment connection setup (HDM Sink)

About algorithms

Equipment connection setup (HDM Sink for CTS 2.0)

16

You need the following equipment (for details, see Minimum system
requirements):

A supported Tektronix oscilloscope

Device under test (DUT)

Two TCA-SMA connectors

An AFG3102, AFG3102C, AFG3252, or an AFG3252C

Eight 12 GHz Bias T (mini circuit bias T model number zx85-12G-s+)
Two 120 psec Rise time filters (5115110-120)

A Power supply external (PWS4721, PWS4602, PWS4323, PWS4305, or

PWS4205)

Two AWG70002A instruments with option 01, 03 and 225, or two
AWG7122C instruments with option 1, 2/6, 8

TF-HDM-TPA-S

10 SMA cables (174-1428-00)
Four BNC to SMA converters
A BNC T connector

Four BNC cables of similar length

112 ps Delay Lines-Quantity 6#, Any recommended Delay
Line( SPECTRUM 8001-SM21-02)

0.15 Tbit skew- Quantity 6#, S018CCSF from Carlisle Interconnect

Technologies

Connection diagrams and the tests they apply to are listed below.

NOTE. GPIB connection is supported only for AWG7122C. If using AWG7122C
and GPIB connections, three NI-GPIB cables are needed.

NOTE. In case of single stack 2 channel oscilloscopes you have to make
appropriate channel configurations in TekExpress HDM software:
DP0O723025SX, DPO7330258X, DPO75002SX, DPO759028X, and DPO770025X.
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Sink tests

Table 4: Sink Electrical tests for 2.0

Test number and characteristic tested

Setup diagram

*HF 2-1: Min/Max Differential Swing Tolerance

Sink Electrical min diagram for AWG70002A
Sink Electrical max diagram for AWG70002A
Sink min/max diagram for AWG7122C

*HF 2-2: Intra-Pair Skew

Sink Electrical intra-pair skew diagram for
AWGT70002A
Sink intra-pair skew diagram for AWG7122C

*HF 2-3: Jitter Tolerance

Sink Electrical jitter tolerance diagram for
AWG70002A
Sink jitter tolerance diagram for AWG7122C

Table 5: Sink Protocol tests for CTS 2.0

Test number and characteristic tested

Setup diagram

HF2-6 Sink Video Timing - 6G - 2160p 24 bit
Color Depth

Sink Protocol diagram for AWG70002A
Sink Protocol diagram for AWG7122C

HF2-7 Sink Video Timing - 6G - 2160p Deep
Color

Sink Protocol diagram for AWG70002A
Sink Protocol diagram for AWG7122C

HF2-8 Sink Video Timing - 6G - 2160p 3D

Sink Protocol diagram for AWG70002A
Sink Protocol diagram for AWG7122C

*HF2-23: Sink Pixel Decoding YCBCR 4:2:0

Sink Protocol diagram for AWG70002A
Sink Protocol diagram for AWG7122C

HF2-24 Sink Pixel Decoding YCBCR 4:2:0 Deep
Color

Sink Protocol diagram for AWG70002A
Sink Protocol diagram for AWG7122C

HF2-25 Sink Video Timing - 21:9 (64:27)

Sink Protocol diagram for AWG70002A
Sink Protocol diagram for AWG7122C

HF2-36 Sink Video Timing - 6G - Non-2160p
24 bit Color Depth

Sink Protocol diagram for AWG70002A
Sink Protocol diagram for AWG7122C

HF2-37 Sink Video Timing - 6G - Non-2160p
Deep Color

Sink Protocol diagram for AWG70002A
Sink Protocol diagram for AWG7122C

HF2-38 Sink Video Timing - 6G - Non-2160p 3D

Sink Protocol diagram for AWG70002A
Sink Protocol diagram for AWG7122C

TekExpress HDM Advanced Analysis and Compliance Solution
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Schematic for Sink Protocol, Electrical (min, intra-pair skew, jitter
tolerance) tests for AWG70002A

AFG WExt Refln

10 MHz Ref
AWGT0002A Out (Master)

AWGT0002A (Slave) w

©

CLK

120 ps TTC Filter
T
DC -— Bias \‘\ 1 ’4-[)0
vollage‘ ‘ | ‘
RF+DC = ——»=RF+DC
Power supply
J/
/
HARHEHEEEE
SHEHEEEE
‘: ‘2 Ly |5 lz]s |2

3 I

=

B

]

HDMI Connector

Sink DUT
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Schematic for Sink Protocol, Electrical (min, intra-pair skew, jitter
tolerance) tests for AWG70002A for SX series scopes

AFG WEXI RefIn

s = 599006 AWGT0002A (smveﬂ
Trig In A i <

10 MHz Ref
Qut (Master)

AWGT70002A

0 =
CLK
~ DPOTOD00SX Series
120 ps TTC Filler ‘ P
| T =
| A | ' =
l l 155!3* { A
DG =YY YY Bias gias Y Y Y Y —pc
‘ I { voltage voltage ‘
RF+DC ~—T 1T Y TTT [—=RF0C
|
Power supply
W 2y
_/

olol9lo|lo|lolo|o

[l el o = B D B Y

SEHEEHEHE

Clolzl=l=z|]=

o2

0

HDMI Connector

Sink DUT

TekExpress HDM Advanced Analysis and Compliance Solution 19



Operating basics

Schematic for Sink Electrical max test for AWG70002A

AFG \Exl Refln

1 = §
Trig In A l

T

10 MHz Ref
AWGT0002A Out (Master)

AWGTO0002A (Slave) \

Analog
Analog
120 ps TTC Filmrﬁa((
W
0C 131 - DPO/DSAMSO 70000 Series . L:"' oc
] e oo 1]
RF+DC~—T1T1T11 Y [ TT [—=RFDC
-
Power supply
7
J
olelolo|lololo|lo
= E=l = BN SR S B B
3|12[2]|2|2|Z]|E |8
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1

HDMI Connector

Sink DUT
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Schematic for Sink Electrical max test for AWG70002A for SX series scopes

AFG w Ext Ref In

10 MHz Ref
AWGT70002A Qut (Master)

AWGT0002A (Slave) w
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Power supply
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>
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=

-

HDMI Connector

Sink DUT

NOTE. For AWG7122C, the connection remains the same as the nominal pattern.
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Schematic for Sink Electrical (jitter tolerance, intra-pair skew, and min/
max) tests for AWG7122C

AWGT122C (m MHz Ref Out (Master)
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AWGT122C (Slave)

RF+DC «——

22
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HDMI Connector

Sink DUT
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Schematic for Sink Electrical (jitter tolerance, intra-pair skew, and min/
max) tests for AWG7122C for SX series scopes

AFG w ExtRef In

) AWGT122C (Siave) )

AWGT122C ﬁo WHz Raf Out (Master)
- 1
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CLK Do
120ps Y
TTC
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e I
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i #

HDMI Connector

Sink DUT

TekExpress HDM Advanced Analysis and Compliance Solution



Operating basics

Schematic for Sink Protocol test for AWG7122C

R

AWGT7122C (m WHz Ref Out (Master) AWGT122C (Slave)
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Schematic for Sink Protocol test for AWG7122C for SX series scopes
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TekExpress HDM Advanced Analysis and Compliance Solution 25



Operating basics

Equipment connection setup (HDM Sink for CTS 1.4)

26

Sink tests

You need the following equipment (for details, see Minimum system
requirements):

A supported Tektronix oscilloscope

Device under test (DUT)

Two TCA-SMA connectors

An AFG3102,AFG3102C,AFG3252, or an AFG3252C

Eight 12 GHz Bias T (mini circuit bias T model number zx85-12G-s+)
Eight 6.4 GHz filter (5115110-120)

A Power supply external (PWS4721, PWS4602, PWS4323, PWS4305, or an
PWS4205)

Two AWG70002A instruments with option 01, 03 and 225, or two
AWGT7122C instruments with option 1, 2/6, 8

NOTE. The AWG7122C should not be used for CTS 1.4.

TF-HDM-TPA-S

10 SMA cables (174-1428-00)
Four BNC to SMA converters
One BNC T connector

Three BNC cables

One BNC T connector

Four BNC cables of similar length

Connection diagrams and the tests they apply to are listed below.

NOTE. GPIB connection is supported only for AWG7122C. If using AWG7122C
and GPIB connections, three NI-GPIB cables are needed.
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Table 6: Sink Electrical tests for 1.4

Test number and characteristic tested Setup diagram

Test ID 8-5: TMDS-Min/Max Differential Swing | Sink electrical min diagram for AWG70002A

Tolerance Sink Max diagram for AWG70002A

Test ID 8-6: TMDS-Intra-Pair Skew Sink Intra pair skew diagram- single lane for
AWG70002A
Sink Intra pair skew diagram - all lanes for
AWG70002A

Test ID 8-7: TMDS-Jitter Tolerance Sink jitter tolerance diagram for AWG70002A

Schematic for Sink protocol, sink jitter tolerance, sink min test for AWG70002A
(CTS 1.4)
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Schematic for Sink Intra pair skew for single lane test for AWG70002A
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Schematic for Sink intra pair skew all lanes test for AWG70002A

AFG w ExtRefIn

10 MHz Ref
Out (Master)

AWGT70002A

AWGT70002A (Slave) W

]

@ )
2

Marker

’_“uﬂ

output

i

120ps TTC Filter

il
1

120ps TTC Filter

Bias
voltage

d ¥0010

y

(-

_

HDMI Connector

Sink DUT

TekExpress HDM Advanced Analysis and Compliance Solution

)

N Zvlva

29



Operating basics

Schematic for Sink Max for AWG70002A
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Table 7: Sink Protocol tests for CTS 1.4

Test number and characteristic tested Setup diagram

Test ID 8-15: Character Synchronization Sink Protocol diagram for AWG70002A
Test ID 8-16: Acceptance of All Valid Packet Sink Protocol diagram for AWG70002A
Types

Test ID 8-19: Pixel Encoding Requirements Sink Protocol diagram for AWG70002A
Test ID 8-20: Video Format Timing Sink Protocol diagram for AWG70002A
Test ID 8-21: Audio Clock Regeneration Sink Protocol diagram for AWG70002A
Test ID 8-22: Audio Sample Packet Jitter Sink Protocol diagram for AWG70002A
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Test number and characteristic tested

Setup diagram

Test ID 8-23: Audio Formats

Sink Protocol diagram for AWG70002A

Test ID 8-24: Interoperability with DVI

Sink Protocol diagram for AWG70002A

Test ID 8-25: Deep Color

Sink Protocol diagram for AWG70002A

Test ID 8-28: One Bit Audio

Sink Protocol diagram for AWG70002A

Test ID 8-29: 3D Video Format Timing

Sink Protocol diagram for AWG70002A

Test ID 8-30: 4K 2K Video Format Timing

Sink Protocol diagram for AWG70002A

Test ID 8-31: Extended Colors and Contents

Sink Protocol diagram for AWG70002A

Application directories and usage

The application directory and associated files are organized as follows:

Bin

Compliance Suites
Documents
Examples

ICP

Images

Lib

Report Generator

Tools

The following table lists the default directory names and their usage.

Table 8: Application directories and usage

Directory names

Usage

InstallDinTekExpress\TekExpress HDM

Contains the application and associated files

TekExpress HDM\Bin

Contains miscellaneous HDM application
libraries

TekExpress HDM\Compliance Suites

Contains compliance-specific files and filter files

TekExpress HDM\Documents

Contains the technical documentation for the
HDM application

TekExpress HDM\Examples

Contains various support files

TekExpress HDM\ICP

Contains instrument and HDM application-
specific interface libraries

TekExpress HDM Advanced Analysis and Compliance Solution
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Directory names Usage

TekExpress HDM\Lib Contains utility files specific to the HDM
application

TekExpress HDM\Report Generator Contains style sheets for report generation

TekExpress HDM\Tools Contains instrument and HDM application-
specific files

See Also View test-related files

File name extensions

The TekExpress HDM software uses the following file name extensions:

File name extension Description

.TekX Session files are saved in this format but the extensions may not
be displayed

.py The test sequence file

xml The encrypted XML file that contains the test-specific

configuration information
The log file extension is also xml

wfm The test waveform file

.mht Test result reports are saved in this format by default. Test
reports can also be saved in MHTML or PDF formats.

.pdf Test report can also be saved in pdf format.

fit Filter file used with transmitter tests

See Also Application directories and usage
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Installing the software

Compatibility =~ The TekExpress HDM application runs on the following Tektronix oscilloscopes:
For CTS 2.0

= DPO/DSA/MS072004C, DPO/DSA/MS0O71604C Digital Oscilloscopes with
Option DJA

= DPO/DSA73304D and DPO/DSA72504D Digital Oscilloscopes with Option
DJA

= DPO/MS072304DX, DPO/MS072504DX, DPO/MSO73304DX with
Option DJA

= DPO75002SX, DPO75902SX, DPO77002SX, DPO72304SX, and
DPO73304SX with option DJA

NOTE. You can also use a 12.5 GHz bandwidth oscilloscope, but there may be a
10% variation in the measurement result.

For CTS 1.4

= DPO/DSA/MS072004C and/or DPO/DSA/MSO71604C Digital
Oscilloscopes

= DPO/DSA73304D and DPO/DSA72504D Digital Oscilloscopes
= DPO/MS072304DX and/or DPO/MSO72504DX, DPO/MS0O73304DX
= Supports oscilloscopes > =4 GHz

= DPO750025X, DPO75902SX, DPO77002SX, DPO72304SX, and
DPO73304SX with option DJA

See Also.

Minimum system requirements
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Minimum system  The following table shows the minimum system requirements for an oscilloscope

requirements  to run TekExpress.

Table 9: System requirements

Component

Description

Oscilloscope

For CTS 2.0

BW = 16 GHz, 16 M Record Length/Ch - Opt.
4M/2XL or more (for Eye Diagram and Jitter
tests), and 20XL for Inter Pair Skew tests.
For a list of compatible oscilloscopes, see
Compatibility.

Processor

Same as the oscilloscope

Operating system

Same as the oscilloscope

Memory Same as the oscilloscope
Hard disk Same as the oscilloscope
Display Same as the oscilloscope
Software = TekExpress HDM Advanced analysis and
Compliance software
= DPOUJET, Jitter and Eye Diagram Analysis
Tool Ver 6.2.1 and above
= Microsoft Internet Explorer 6.0 SP1 or later
= Microsoft Photo Editor 3.0 or equivalent
software for viewing image files
= Adobe Reader 8.0 or equivalent software
for viewing portable document format (PDF)
files
Probes

= Four differential probes — P7313SMA for
Single-Ended and Differential tests

= Four differential probes - P7720 for Single-
Ended and Differential tests

HDM sources

= HDMTxDUTs

= HDM Ref waveforms

TDR tests

= Oscilloscope — DSA8200 or equivalent with
80E03 and 80E04 modules and |-Connect
software

1 If TekExpress is running on an instrument having a video resolution lower than 800 x 600 (for example, a sampling oscilloscope), it is recommended

34

that you connect a secondary monitor, which must be enabled before launching the application.
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Component Description
HDM Generator for Sink

= Two AWG70002A with option 01, 03 and
225 or two AWG7122C with option 1, 2/6,

8
= One AFG3102/AFG3102C/AFG3252/
AFG3252C
HDM fixtures For CTS 2.0 HDM fixture kits from Tektronix

= TF-HDM-TPA-S

= TF-HDMI-TPA-T (Termination fixture)
®  TF-HDM-TPA-STX

= TF-HDMD-TPA-STX

HDM accessory kit ( to be used with AWG) TF-HDM-DS-Acc kit from Tektronix contains the
following:

= Eight Bias Tees from Mini-Circuits —
ZX85-12G-S+

= For CTS 2.0: Two 120 ps TTC filters from
Picosecond Pulse Labs (5915-100-1200)

Other devices = Microsoft compatible mouse or compatible
pointing device
= Four USB ports (two USB ports minimum)
= PCI-GPIB or equivalent interface for
instrument connectivity 2
= 10 SMA cables, 174-1428-xx
= Four BNC cables
= One BNC T connector
= Four BNC-to-SMA adapter
= External power supply PWS4721/
PWS4602/PWS4323/PWS4305/PWS4205
= Any approved DDC Master
= Any approved EDID analyzer
See Also.
Compatibility

2 If TekExpress is installed on a Tektronix oscilloscope, the virtual GPIB port will be used by TekExpress for communicating with oscilloscope
applications. If external GPIB communication devices such as USB-GPIB-HS or equivalent are used for instrument connectivity, ensure that the Talker
Listener utility is enabled in the DPO/DSA oscilloscope's GPIB menu. For ease of use, connect to an external (secondary) monitor.
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Windows 7 user accounts ~ Windows 7 instruments need to have the User Account Control Settings set to
Never Notify. To set User Account Control Settings:

1. Go to Control Panel > User Accounts > Change User Account Control
settings.

2. Set it to Never Notify as shown in the image.

'&' User Account Control Settings = | B

Choose when to be notified about changes to your computer

User Account Control helps prevent potentially harmful programs from making changes to your computer,
Tell me more about User Account Control settings

Always notify
- - Never notify me when:
*  Programs try to install software or make changes to
my computer
- - ® Imazke changes to Windows settings
rﬁ. Mot recommended. Choose this only if you need to
use programs that are not certified for Windows 7
- - because they do not support User Account Control.
Mever notify

Install the software  The software can be installed on any compatible instrument running Windows 7.
1. Close all applications (including the TekScope application).

2. Go to the www.tek.com Web site and search for HDMI to locate the
installation file. Download the file HDM Weblnstaller.exe.

3. Double-click the executable file to extract the installation files. After
extraction, the installer launches and displays the InstallShield Wizard.

4. The software automatically installs in the following location:
m  C:\Program Files\Tektronix\TekExpress\TekExpress HDM

5. The installer updates the TekScope Analyze menu to include TekExpress
HDM:
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MyScope | Analyze | Utilities | Help n

Search...
Mark...
Jitterand Eye Analysis (DPOJET)}
Protocol Decode Event Tabe

HDMI Compliance Test Software(1.4)
TekExpress MHL

TekExpress Thunderbolt

TekExpress SAS

TekExpress HDM

See Also.
Minimum system requirements

Compatibility
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Activate the license  Activate the license using the option installation wizard on the oscilloscope.
Follow these steps to activate the TekExpress HDM license:

1. From the oscilloscope menu bar, click Utilities > Option Installation.

The TekScope Option Installation wizard opens.

2. Instructions for using the Options Installation window to activate licenses for
installed applications is provided in the oscilloscope online help. Press the F1
key on the oscilloscope keyboard to open the Option Installation help topic.
Follow the directions in the topic to activate the license.

See Also.

View version and license information

38 TekExpress HDM Advanced Analysis and Compliance Solution



Getting started

View version and license  Use the following instructions to view application version information and
information  version information for the application modules such as the Programmatic
interface and the Programmatic interface client.

To view version information:

From the Options menu, select About TekExpress.

/' Pbout Tektronix TekExpress HDM

D

TekExpress

Autornated Solutions

Tektronix

To view license information:
1. From the oscilloscope Help menu, select About TekScope.

The Options section in the dialog box displays a list of installed options,
including TekExpress HDM.

2. To view the Option key, look in the Option Installation Key section. When
finished, click OK to close the dialog box.

NOTE. For information regarding HDMXpress option, refer License section of
HDMXpress Online Help

See Also.
Activate the license

Options menu
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Run the application

To run the HDM application, do either of the following:

= Select Analyze > TekExpress HDM from the TekScope menu.
= Double-click any saved HDMI session file.

When you open the application after installation, the application checks for a file
called Resources.xml located in the C:\Users\<username>\My Documents folder.
The Resources.xml file gets mapped to the X: drive when the application
launches. Session files are then stored inside the X:\HDM folder. The
Resources.xml file contains information about available network-connected
instruments. If this file is not found, the application runs an instrument discovery
program before launching HDM to locate available instruments.

If the application license was not installed using the TekScope menu Utilities >
Option Installation selection, you can open the application up to 10 times in
evaluation mode. Each time you open the application without supplying a valid
license key, one of the free trials is used.

Exit the application

Use the following method to exit the application:

" aul)
Click o on the application title bar.

2. Do one of the following:

= [fyou have an unsaved session or test setup open, you are asked to save
it before exiting. To save it, click Yes. Otherwise click No. The
application closes.

= A message box appears asking if you really want to exit TekExpress. To
exit, click Yes.

NOTE. Using other methods to exit the application results in abnormal
termination of the application.
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Application controls and menus

Application controls  Table 10: Application control descriptions

Item Description

Options menu Opens the Options menu for access to global
controls

Panels Visual frames with sets of related options

Command buttons Buttons that initiate an immediate action such as

the Start, Stop, Pause, Continue, and Clear
command buttons

Start button

Start

Starts continuous measurement acquisition and
analysis. If prior acquired measurements have
not been cleared, the new measurements are
added to the existing set.

Stop button
Stop

Stops (aborts) the current measurement
acquisition.

Pause \ Continue button

Pause Continue

Use the Pause button to temporarily interrupt the
current acquisition. When a test is paused, the
button name changes to Continue.
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Item

Description

Clear button

Clear

Clears all existing measurement results. Adding
or deleting a measurement, or changing a
configuration parameter of an existing
measurement, also clears measurements. This
prevents the accumulation of measurement
statistics or sets of statistics that are not
coherent. This button is available only on the
Results panel.

Clear Log

(o)

This button is available only on the Status panel.

Save

This button is available only on the Status panel.

Application window move icon

Place the cursor over the three-dot pattern in the
upper left corner of the application window.
When the cursor changes to a hand, drag the
window to the desired location.
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Options menu

Options menu overview. The Options menu is located in the upper right corner of

the application.

The Options menu has the following selections:

Options menu
Default Test Setup
Open Test Setup
Save Test Setup
Save Test Setup As
Open Recent

Instrument Control Settings

Keep On Top
Email Settings

Open Current Suite RunSession

Help
About TekExpress
Menu Function
Default Test Setup Opens an untitled test setup with defaults selected.
Open Test Setup Opens a saved test setup.
Save Test Setup Saves the current test setup selections.
Save Test Setup As Creates a new test setup based on an existing one.

Open Recent

Displays a menu of recently opened test setups from which to
select.

Instrument control settings

Shows the list of instruments connected to the test setup and
allows you to locate and refresh connections to connected
instruments.

Keep On Top

Keeps the TekExpress HDM utility on top of other open windows
on the desktop.

Email settings dialog box

Use to configure email options for test run and results
notifications.

Open Current Suite Opens current Suite's run session. This option is selected in the

RunSession Options menu when you select Suite as Sink Electrical and Sink
Protocol in the DUT tab.

Help Displays TekExpress Help.

About TekExpress

= Displays application details such as software name, version
number, and copyright.

= Provides access to software version and license information
for your HDM installation.

= Provides a link to the Tektronix Web site.
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See also.

Application controls

Instrument control settings. Use the TekExpress Instrument Control Settings
dialog box to search for and list the connected resources (instruments) found on
specified connections (LAN, GPIB, USB, and so on) and each instruments
connection information. You access this dialog box from the Options menu.

TekExpress Instrument Control

DPOTIZ04D Flash Failed
DPOTIZ04D 0200020
MSOT1 2540 C250009
ANGTI G Bos0 e
DPOTI004C B130216
ANGTT2C 8030149

Use the Instrument Control Settings feature to and view instrument connection
details. Connected instruments displayed here can be selected for use in the
Global Settings tab in the configuration section. See step 1 of Configure Tests for
details.

See also.

Options menu overview
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Email settings dialog box overview. Use the Email Settings dialog box to enable
TekExpress to send an email message when a test completes, produces an error,
or fails. Select the type of test run information to attach to the email (such as test
reports and test logs), the email message format, and the email message size
limit.

Open the Email Settings dialog box from the Options menu.

NOTE. Recipient email address, sender’s address, and SMTP Server are
mandatory fields.

See also.

Configure email settings
Options menu

Select test notification preferences
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Configure email settings. To be notified by email when a test completes, fails, or
produces an error, configure the email settings.

1. Select Options > Email Settings to open the Email settings dialog box.

2. (Required) For Recipient email Address(es), enter one or more email
addresses to which to send the test notification. To include multiple
addresses, separate the addresses with commas.

3. (Required) For Sender’s Address, enter the email address used by the
instrument. This address consists of the instrument name, followed by an
underscore, followed by the instrument serial number, the @ symbol and
then the email server used. For example:

DPO72004C _B130099@yourcompany.com.

4. (Required) In the Server Configuration section, type the SMTP Server
address of the Mail server configured at the client location, and the SMTP
Port number, in the corresponding fields.

If this server requires password authentication, enter a valid login name,
password, and host name in the corresponding fields.

NOTE. If any of the above required fields are left blank, the settings will not
be saved and email notifications will not be sent.

5. In the Email Attachments section, select from the following options:
= Reports: Attach the test report to the notification email.

= Status Log: Attach the test status log to the notification email. If you
select this option, then also select whether you want to receive the full
log or just the last 20 lines.

6. In the Email Configuration section:
m  Select the message file format to send: HTML (default) or plain text.

= Enter a maximum file size for the email message (message plus
attachment files). Messages with attachments larger than this limit will be
truncated. The default is 5 MB.

= Enter the number in the Number of Attempts to Send field, to limit the
number of attempts that the system makes to send a notification. The
default is 1. You can also specify a timeout period.

7. Select the Email Test Results When complete or on error check box. Use
this check box to quickly enable or disable email notifications.

8. To test your email settings, click Test Email.
9. To save your settings, click Apply.
10. Click Close when finished.
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Setup panel

Setup panel overview

Set DUT parameters

48

Source

The Setup panel contains sequentially ordered tabs that help guide you through a
typical test setup process.

Set the DUT parameters.

Select test(s).

Set lane acquisition source.
Configure the selected tests.

Select test notification preferences.

Items selected in a preceding Setup tab may change options available in the
following tabs. You can switch between the tabs in any order to modify your test
parameters.

Sink

The Setup panel contains sequentially ordered tabs that help guide you through a
typical test setup process.

Set the DUT parameters.

Select test(s).

Configure the selected tests.

Select test notification preferences.

Items selected in a preceding Setup tab may change options available in the
following tabs. You can switch between the tabs in any order to modify your test
parameters.

Use the Setup panel DUT tab to select parameters for the device under test. The
settings are global and apply to all tests for the current session. DUT settings also
affect the list of available tests in the Test Selection tab.

Source
1. Source
Click Setup > DUT.
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Suite > Source

_-',;’A,’TekExpress HDM - {Untitled)™ n 900
!
@ DuT DUTID DUTOM @

Acguire live waveforms = Use pre-recorded waveform files

viw [Gompiance |v]

( Results ) B CERpETE Device |HDM Physical Layer Solution ‘ v |

ar— B Test Selection

n Preferences Guite |Suurce |V | Versinn|CTS 20 |V ‘

Device Profile
Data Rate(Ghps) Frobe Atten

Lowest [.71 Single Ended 125 | ¥ |
Highest 5.94 Differential n

Woltage Thit For DataRate (ps)

viamed B3 | [ Recalc oIt
D Waltage LowestToit PO

Y HighestTet g5

Multi-Lane @

Selected Lanes
Clock, DO, D1, D2

Ready. |

Table 11: DUT tab settings (Source)

Setting Description

Acquire live waveforms Acquire active signals from the oscilloscope for testing.

Use pre-recorded waveform | Run tests on a saved run session file. Select a run session file
files from the list.

View Determines where to access the test configuration settings:

= Compliance: View configuration settings by clicking
Setup > Test Selection > Configure

= Advanced: Enables the Setup > Configuration tab in
which to view configuration settings.

DC Voltage Internal\External Other\Tek Power Supply

Data Rates (Gbps) Highest: Select the Highest data rate to include in the tests.
Lowest: Select the Lowest data rate to include in the tests

TBit For High Data Rate (ps) | Sets the TBit calculated for highest data rate
TBit For Low Data Rate (ps) | Set the TBit calculated for lowest data rate

Probe Attenuation (X) Differential: 12.5/2.5
Single-Ended: 12.5/2.5
Recalc TBit Check or Uncheck Recalc TBit. TBit Should be calculated for

at least once.
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Setting Description

Number of Lanes to Test Select the number of lanes to be tested: 1 Lane / 2 Lanes /
3 Lanes /4 Lanes

Setup button Opens Test Lane Setup dialog box
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Suite > Sink Electrical Sink Electrical for CTS 1.4

DUTID DUTOM

L Aveuire live waveforrs

view [Compience |v]

Device |HDM Physical Layer Solution | ¥ |

Suite |Smk Electrical | v | version CTS 1.4 | ¥ |

Device Profile

DC Voltage Tek Power Supply | ¥ |
B .

Farmat | 720x480p@60Hz_2 8Bit RGB GREY [v]

Sink Electrical for CTS 2.0

DUTID CUTam @

Device ‘HDM Physical Layer Solution | v ‘

Suite  Sink Electrical | ¥ | Wersion:cTS 2.0

Device Profile

DC Yaltage

TekExpress HDM Advanced Analysis and Compliance Solution 51



Application basics

52

Table 12: DUT tab settings (Sink Electrical CTS 1.4 and 2.0)

Setting Description
For CTS 1.4: Clock Rate Select data rate or clock rate from Device Profile
(Gbps)

For CTS 2.0: Data Rate
(Gbps)

Format

Select format from Device Profile

DC Voltage

Select DC Voltage from the Device Profile
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Suite > Sink Protocol Sink Protocol for CTS 1.4

DUTID DUTOO

e Aceuire live waveforms

vew [Compiance |v]

Device |HDM Physical Layer Salution | ¥ |

Suite |Sink Protocol ‘ v | Version ‘CTS 1.4 | A |

Device Profile

DC Voltage | Tek Power Supply n

Sink Protocol for CTS 2.0

DUTID DUTO0

Device ‘HDM Physical Layer Solution

Suite ‘Smk Protocal

Device Profile

DC Voltage
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Table 13: DUT tab settings (Sink Protocol for CTS 1.4 and 2.0)

Setting Description

DC Voltage If Tek Power Supply is connected, select DC voltage as “Tek
Power Supply’ or “External”.

2. (Optional) Enter the ID for the device. The default value is DUTO001. The
DUT ID parameter is added to reports.

3. (Optional) To add comments to the test report, click the note pad icon (£) to
the right of the DUT ID field. Enter comment text up to 256 characters. To
enable or disable displaying comments in the test report, see Select report
options.

4. Settings that do not apply to compliance testing cannot be changed and are
grayed out.
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Selecttests  Use the Test Selection tab to select the tests to run on the connected DUT.
1. Click Setup > Test Selection.

Source Electrical 2.0

HDM Physical Layer Solution : Source : CTS 2.0

El' Source TMDS Electrical- BG
&[] Diflerential
HF1-2- TRISE, TFALL
HF1-3- Inter-Pair Skew
HF1-5- Differential Yoltage
HF1-8- Clock Duty Cycle and Clock Rate
HF1-7- Clock Jitter
ingle Ended
HF1-1- %L and ¥Swing
- HF1-4- Infra-Pair Skew
~{w] HF1-8- Data Eye Diagram

Test Description

This test confirms that the skew betweentwo =
data lanes on the TMDS differential signals fall
within the limits ofthe specification

Sink Electrical 1.4

HDM FPhysical Layer Solution : Sink Electrical : CTS 1.4

Sink Electrical

Test|D 8-5: TMDES-MiniMax Differential Swing Tolerance
; Test D 8-6: TMDE-Intra-Pair Skew
: Test|D 8-7: TMDE-Jitter Tolerance

Test Description

Please select 3 test name 1o view its
description
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Sink Electrical for CTS 2.0

HDM Physical Layer Solution : Sink Electrical : CTS 2.0

Sink Electrical

F2-1- Min/Max Differential Swing Tolerance
F2-2- Intra-Pair Skew
F2-3- Jitter Tolerance

Test Description

Please select a test name to view its Description  + i

Sink Protocol 1.4

HOM Physical Layer Solution : Sink Protocol : CTS 1.4

=] E Sink Protocol

TestID 8-14: Character Synchronization
est 1D B-16: Acceptance of All Valid Packet Types
est D 8-19: Pixel Encoding Requirernents
est D 8-20: Video Forrnat Timing
est|D 8-21: Audio Clock Regeneration
est|D 8-22: Audio Bample Packet Jitter
est 1D 8-23: Audio Formats
estID 8-24: Interoperability with D]
est|D 8-25: Deep Color
est 1D 8-28: One Bit Audio
est|D 8-29: 3D Video Format Timing
estID 8-30: 4K 2K Video Format Timing
Test|D 8-31: Extended Colors and Contents

Test Description

Please select 2 test name to view its
description

Sink Protocol 2.0
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HDM Physical Layer Solution : Sink Protocol : CTS 2.0

(soats)
E-{w] Sink Protocol

HF2-6: Sink Video Timing-63-2160p 24 hit Color Depth

HF2-7: Sink Video Timing -6G -2160p Deep Color

HF2-8: Sink Video Timing -6G -2160p 3D

HF2-23: Sink Pixel Decoding YCBCR 4:2:0

HF2-24: Sink Pixel Decoding YCBCR 4:2:0 Deep Color

HF2-24: 5ink Video Timing -21:9

HF2-36: Sink Video Timing -6G Mon -2160p 24hit Color Depth
F2-37: Sink Video Timing -6G Non-2160p Deep Colar

fefar| HF2-38: Sink Video Timing -6G Mon -2160p 3D

Test Description

This test Confirms that the Sink OUT Suppoarts
b Cr4.2:0 Pixel Decoding and Signaling

2. Select the test(s) to run:
= Click one or more check boxes adjacent to each test.
®=  Click Deselect All to deselect all tests. All tests are selected by default.
m  Click Select All to select all tests.

3. Click Schematic to display a schematic diagram that shows the DUT test
setup. Use the diagram to verify the test setup before running the test.
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Set acquisition parameters
(source only)

58

Use the Acquisitions tab to set the signal source (channel) used to acquire data.
Acquisition options are available only when acquiring a live waveform.

1. Click Setup > Acquisitions.

HDM Physical Layer Solution : Source : CTS 2.0

Lane Source Lane Source ﬁ

Clock CH1 Do CH2 Eie e

= =y
o1 Ch2 b2 Ch4 |/ Enable Filter @

 Acquisition -

HF1—27 TRISE, TFALL Clock : Short Record-length for Rise F'

D0 - Short Record-length for Rise Fall
D1 Short Record-length for Rise Fall
D2 - Short Record-length for Rise Fall
Clock : Short Record-length for Differe
D0 : Short Record-length for Differenti
D1 Short Record-length for Differenti
D2 - Short Record-length fnrD\ﬁerentia

——————————

l- Show Acquire Parameters

2. Select Source field to select the oscilloscope channels to use for those lanes.
3. Select probe type from Probe Type field as Differential, Single-Ended, or
Eye-Diagram.

4. Check or uncheck the Enable Filter check box and configure the Filter
Configuration by clicking the Filter Config button and choose from the
displayed field.

—Fil'lser Configuration o
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Set test notification =~ Use the Preferences tab to set the application to send an email when a test
preferences measurement completes:

1. Click Setup > Preferences.

2. Select the Email Test Results when complete check box in the Email
Settings dialog box. Click Email Settings to configure the email settings.

See also.

Select report options

Configure test parameters  About configuring test parameters (source only). Use the configuration settings to
view the measurement parameters for selected tests. How the test configurations
are accessed depend on the View selected in the DUT tab.

NOTE. The View option is not applicable for Sink Electrical and Sink Protocol.

= Ifyou selected Compliance View in the DUT tab, then in the Test Selection
tab, select the desired test in the list and then click the Configure button.

= Ifyou selected Advanced View in the DUT tab, click the Configuration tab
in the Setup panel.

See also.
Configure tests parameters

Configure test parameters. The Configuration parameters let you set global and
individual test parameters. To return to test selection from the Configuration tab
or panel, click the Test Selection button.

NOTE. You cannot change test parameters that are grayed out.

Source and Sink.
1. Modify Global settings as desired:

m  To select the instruments for testing, click Global Settings. In the
Instruments Detected section, click in the shaded areas to activate the
drop-down lists and select an instrument. If you do not see the desired
instrument in the list, see Instrument control settings.

2. To modify any individual test measurement settings, click Measurements,
select the test in the tree view, and change the settings.
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Test parameters. Source - Global Settings

(+) Compliance Mode || User Defined Mode
oo e
Ingtruments Detected

| Real Time Scope DPO72504D (GPIB3:: 1INSTR) |

(+) Compliance Mode () User Defined Mode

Instruments Detected

I oo (s 1asTR) (ke
Signal Source (Master AWG)

Signal Seurce (Slave AWG)

AWG Synchronization Method

Tek Power Supply

Scope Connection
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Source - Measurement

(+) Compliance Mode | User Defined Mode

- Diffarsntial
HF1-2- TRISE, TFALL
HF1-5- Dfferential Voltage
HF16- Clock Duty Cycle and Clock Rate
HF1-7-Clock Jiter
& Single Ended
|~ HF1-1- VL and VSwing
HF1-4- Intra-Pair Skew
HF1-8- Data Eye Diagram

Setlings

Sink Electrical - Measurement

{+) Compliance Mode | User Defined Mode

[E—

[ S Blectrical
HF2-1- Min/Max: Difevential Swing Tolerance
HF2-2- Intra-Pair Skew
HF2-3- Jiter Tolerance

Patiem Fatlern Type

Seftings (- Standard Patiern () Custorn Palern
ANG

Seftings

Selected Pattern © 4096x2160p@60Hz_102 8Bit RGB GRAY 5,94

Others
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The following table lists common and specific test settings and parameters based
on the Suite selected in the DUT tab.

Table 14: Common and specific parameters and values

Parameter type Parameter
Common
Mode Determines whether test parameters are in compliance mode or can be

edited (User Defined Mode).
= Compliance: Most test parameter values cannot be edited.

m  User Defined: Most test parameter values can be edited.

Global Settings

These settings apply to all tests selected for the current session. You can
change only some of these settings.

m  Scope Settings: Specifies the instrument channel to use as the
source for the trigger. This can be changed.

Measurements

These settings apply to the test selected in the tree view of the
configuration section.

Limits Editor (Source
only)

Shows the upper and lower limits for the applicable measurement using
different types of comparisons.

In Compliance Mode, you are able to view the measurement high and low
limits used for the test selected in the tree view of the Measurements tab.
When running tests in User Defined Mode, you can edit the limit settings
in the Limits Editor. When running tests in User Defined Mode, the cells
in the Limits Editor table are active for editing so you can change
parameters.

Limits Editor

A bk el mears s et v s st
Test dome.

LV and saing

WEL-32 TRISE AL

W13 Inker-Pae Sk
WFL-4- Intra-Pas Shew

A Clock Duty Cyle and Choe_

When running tests in User Defined Mode, the cells in the Limits Editor
table are active for editing so you can change parameters.

Specific to Source

Global Settings

= Instruments Detected: Displays the list of instruments connected to
the scope.

= DSP Filter (16GHz): DSP filter bandwidth is set to 16GHz by default.
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Parameter type Parameter
Measurements Scope Settings:
= Sample Rate (GS/sec): Select the required sample rate from the
drop-down menu.
= Record Length (M): Select the required record length from the drop-
down menu.
Clock Setting:
®=  PLL Mode: Configures the type of PLL.
= Clock Recovery Method: Sets the method for recovering the clock.
= Signal Type: Sets the type of signal for clock recovery.
m  Clock Edge: Sets the edges which are used for computation.
= Loop Band Width (MHz): Sets the bandwidth of the PLL.
Specific to Sink
Electrical and Sink
Protocol

Global Settings

Scope Connection:
= Master AWG: Select the Master AWG address.
= Slave AWG: Select the Slave AWG address.

NOTE. Applicable to Sink Electrical and Sink Protocol.

Measurements

Pattern Settings:
= Pattern Type:

= Standard: Select to use the patterns embedded in the
application.

= Custom: Select to use your own patterns.

= Pattern Table button: Click to display and configure available list of
patterns.

NOTE. Applicable to Sink Electrical and Sink Protocol.

AWG Settings:

= AWG Gain: Configure the gain.

= Test Lane: Configure test lane for Sink Intrapair Skew Test.
= Error Detector: Check if Error Detector is connected.
Power Supply:

= Others: Used for further settings like frequency profile.

NOTE. Applicable only to Sink Electrical.
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Status panel overview

The Status panel provides status on test acquisition and analysis (Test Status tab)
and a listing of test tasks performed (Log View tab). The application opens the
Test Status tab when you start a test run. You can select the Test Status or the
Log View tab to view these items while tests are running.

Test Status tab

Test status

TestMame Acquisition Acquire Status  Analysis Sta!ua
& Clock

HF1-2- TRISE, TFALL Short Record-length for Rise Fall |To be started

HF1-5- Differential WVoltage S!mrl Record-length for To be started To be started
Differential Voltage

HF1-8- Clock Duty Cycle and Clock Rate Short Record-length for Clock
Duty Cycle

HF1-7- Clock Jitter Short Record-length for Clock
Jitter

HF1-1- VL and VSwing Short Record-length for Intra-Pair
Skew and Viow

HF1-4- Intra-Pair Skew Short Record-length for Intra-Pair
Skew and Viow

HF1-8- Data Eye Diagram Short Record-length for Data Eye
Diagram

To be started To be started

To be started To be started

To be started To be started

To be started To be started

To be stared To be started

& Do
HF1-2- TRISE, TFALL Short Record-length for Rige Fall To be started To be started

HF1-5- Differential Voltage Short Record-length for
Differential Voltage

HF1-1- VL and VSwing Short Record-length for Intra-Pair
Skew and Viow

HF1-4- Intra-Pair Skew Short Record-length for Intra-Pair
Skew and Viow

HF1-8- Data Eye Diagram Short Record-length for Data Eye
Diagram

To be started To be started

To be started To be started

To be started To be started

To be stared To be started

& D1

HF1-2- TRISE, TFALL Short Record-length for Rige Fall To be started To be started a

] ————————— a

The Test Status tab lists a high level status for each test.

Table 15: Test Status tab

Column Description

Test Name Name of the test

Acquire Status, Analysis Status | Status of the signal acquisition or test analysis
= To be started

= In progress

= Completed

= Aborted

NOTE. Sink tests have a minimal set of status indicators.
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The Log View tab provides a list of the actions executed during the test. Use this
information to review or troubleshoot tests.

Log View tab

Initializing run time environment. This might take some time.
04/09/15 23:24:14 ; Initailize Real Time Scope
04/09/15 23:24:14 : Launching DPOJET and guerying version information
04/09/15 23:24:14 : DPOJET Version : 6.2.1.8
04/09/15 23:24:17 : Starting test: HF1-2- TRISE, TFALL
04/09/15 23:24:17 : Record length: 6000000.0
04/09/15 23:24:17 : Sample rate: 50000000000.0
04/09/15 23:24:25 : Inside the TBit measurement
04/09/15 23:24:25 : Executing AUTOSET
04/09/15 23:24:31 : Setting up Trigger Parameter
04/09/15 23:24.44 : Running the TBit measurement
04/09/15 23:24:44 : Querying the results
04/09/15 23:24:45 : Thit: 2. 6802021880210
04,/05/15 23:24:45 : Setting up the Channel Display
04/09/15 23:24:49 : Executing AUTOSET
04/09/15 23:24.52 : Setting up the Probe Parameters
04/09/15 23:24.56 : Setting up Horzontal and Vertical parameter
04/09/15 23:24.57 : Setting up Trigger Parameter
04/09/15 23:24:59 : Acquirng and saving the Clock and DO Signals for Rise Time_Fall Time
04/09/15 23:25:07 : Zooming the waveform for CH1
04,/05/15 23:25:17 : Zooming the waveform for CH2
04,/05/15 23:25:27 : Saving snapshat at X \HDM'\Untitled Session . DUT001"20150405_2324124Rise Time_FallTime png
04,/09/15 23:25:37 : Caliing Rise Time Fall Time algorithm for Clock
04/09/15 23:25:37 : waveform path: X A\HDM\Untitled Session\DUT00142015040%_232412\RiseTime_FallTime_Clock wft
04/09/15 23:25:47 : Clock Rise Time (ps):941.730878840
04/09/15 23:25:47 : Clock Fall Time {ps):932. 263570732
04/09/15 23:25:47 : Rise time Limit to check is 75
04/09/15 23:25:47 : Fall time Limit to check is 75
N4/N8/1R 73-25-47 - | Indatinn the reeult for Clnck of the teet HE1-2- TRISE_TFALL
(1]

Table 16: Log View fields

Item Description

Message History Displays all run messages with timestamp
information

Auto Scroll Sets the program to automatically scroll down

the Message History window as information is
added to the log during the test.

Clear Log button Clears all messages in the Message History
window.
Save button Saves the log file as a text file for examination.

Displays a standard Save As File window and
saves the status messages in the file that you

specify.
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See also .
View test results

Results panel

Results panel overview ~ When a test finishes, the application switches to the Results panel to display a
summary of test results. Set viewing preferences for this panel from the
Preferences menu in the upper right corner. Viewing preferences include showing
whether a test passed or failed, summary results or detailed results, and enabling
wordwrap. For information on using this panel, see View test results.

Results panel - Source results

'l.-‘muum Dotaf. Valse Unis  Passl  Margin

3 m-&mm Clock  Clock 188350 371 ll'ﬂ.lﬂn#
Madmu  1ps Gl 6

Voage
oo 168350 371
Minkru  1ps Gbygrs.
]

DifTerprt

al
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Results panel - Sink results for CTS 2.0
_V%TekExpness HDM - i v ] °

Test Name Details Pass/Fail
Timing-6G-2160p 24 bit  24Bit RGB 60Hz s Pass
Color Depth

HF2-6: Sink Video SVT2160BCD 3840x2160p VICI7 GRAY
Timing-6G-2160p 24 bit  24Bit RGB 60HL s Pass
Color Depth

HF2-6: Sink Video SVT2160BCD 3840x2160p VIC96 GRAY

Timing-6G-2160p 24 bit  24Bit RGB 50H1 s Pass
Color Depth

HF2-6: Sink Video SVT2160BCD 3840x2160p VIC96 GRAY
Timing-6G-2160p 24 bit  24Bit RGB 50Hz s Pass
Color Depth

HF2-6: Sink Video SVT2160BCD 3840x2160p VIC96 GRAY
13 Timing-6G-2160p 24 bit | 24Bit RGB 50Hz
Color Depth

HF2-6: Sink Video SVT2160BCD 4096x2160p VIC102
Timing-6G-2160p 24 bit  GRAY 24Bit RGB 60Hz 4 Pass
Color Depth

HF2-6: Sink Video SVT2160BCD 4096x2160p VIC102
Timing-6G-2160p 24 bit  GRAY 24Bit RGB 80Hz # Pass
Color Depth

HF2-6: Sink Video SVT2160BCD 4096x2160p VIC102
Timing-6G-2160p 24 bit  GRAY 24Bit RGB 60Hz & Pass
Color Depth

HF2-6: Sink Video SVT2160BCD 4086x2160p VIC101
Timing-6G-2160p 24 bit  GRAY 24Bit RGB 50Hz L Pass
Color Depth

HF2-6: Sink Video SVT2160BCD 4096x2160p VIC101
Timing-6G-2160p 24 bit  GRAY 24Bit RGB 50Hz & Pass
Color Depth

View test results =~ When a test finishes, the application switches to the Results panel, which displays
a summary of test results. The overall test result is displayed at the top left of the
Results table. If all of the tests for the session pass, the overall test result will be
Pass. If one or more tests fail, the overall test result will show Fail.

Each test result occupies a row in the Results table. By default, results are
displayed in summary format with the measurement details collapsed and with
the Pass/Fail column visible. Change the view in the following ways:

= To expand all tests listed, select View Results Details from the Preferences
menu in the upper right corner.

= To expand and collapse tests, click the plus and minus buttons.

= To collapse all expanded tests, select Preferences > View Results
Summary.

m  To remove or restore the Pass/Fail column, select Preferences > Show Pass/
Fail.

= To enable or disable the wordwrap feature, select Preferences > Enable
Wordwrap.

= To expand the width of a column, place the cursor over the vertical line that
separates the column from the column to the right. When the cursor changes
to a double-ended arrow, hold down the mouse button and drag the column to
the desired width.

m  To sort the test information by column, click the column head. When sorted
in ascending order, a small up arrow is displayed. When sorted in descending
order, a small down arrow is displayed.

= To clear all test results displayed, click Clear.
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See also.

View a report

View test-related files  Files related to tests are stored in the My TekExpress\HDM folder. In the HDM
folder, each test setup has a test setup file and a test setup folder, both with the
test setup name. The test setup file is preceded by the HDM icon and usually has
no visible file extension.

Inside the test setup folder is another folder named for the DUT ID used in the
test sessions. The default is DUTO001.

Inside the DUTO0O01 folder are the session folders and files. Each session has a
folder and file pair, both named for the test session using the naming convention
(date) (time). Each session file is stored outside its matching session folder.

20110811 162533
20110811 165306
20110811 165407
v 20110811_162533
vii 20110811_165306
v 20110811_165407

The first time you run a new, unsaved session, the session files are stored in the
Untitled Session folder located at ..\My TekExpress\HDM. When you name and
save the session, the files are placed in a folder with the name that you specify.

See also.

File name extensions

68 TekExpress HDM Advanced Analysis and Compliance Solution



Application basics

Reports panel

Reports panel overview

Select report options

Use the Reports panel to open reports, name and save reports, select report
content to include, and select report viewing options.

For information on setting up reports, see Select report options. For information
on viewing reports, see View the report.

Web Archive (*.mht;*. mhtml)

Use the Reports panel to select which test information to include in the report,
and the naming conventions to use for the report. For example, always give the
report a unique name or select to have the same name increment each time you
run a particular test. Generally, you would select report options before running a
test or when creating and saving test setups. Report settings are included in saved
test setups.

In the Reports panel, select from the following options:

Table 17: Report options

Setting Description

Generate new report Creates a new report.

Append with previous run session Appends the last run session and the previous
run session.
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Setting Description
Replace current test results in previous run Replaces the current test results in the previous
session run session. Newly added tests results are

appended to the end of the report.

Report name Displays the name and location from which to
open a report. The default location is at X:\ HDM
\Reports. The report file in this folder gets
overwritten each time you run a test unless you
specify a unique name or select to auto
increment the report name.

To change the report name or location.

Do one of the following:

m  In the Report Name field, type over the
current folder path and name.

m  Click inside Report Name field and Click on
<image> or Double click inside the field to
launch Tek keyboard. Provide Report path
in the Tek keyboard and Click Enter key.

Be sure to include the entire folder path, the file
name, and the file type. For example: C:\Users
UnserName\Documents\My TekExpress\HDM
DUTO001_Test_85.mht.

NOTE. You cannot change the file location using
the Browse button.

Open an existing report.

Click Browse, locate and select the report file
and then click View at the bottom of the panel.

Save as type Lists the available report formats for user to
generate. Supported formats are MHT and PDF.

NOTE. If you select a file type different from the
default, be sure to change the report file name
extension in the Report Name field to match.

Auto increment report name if duplicate Sets the application to automatically increment
the name of the report file if the application finds
a file with the same name as the one being
generated. For example: DUT001, DUT002,
DUTO03. This option is enabled by default.

Include pass/fail results summary Sets the application to include the color block
labeled Test Result (indicating whether the test
passed or failed) in the report. For details, see
Report Contents in View a report.

Include detailed results Sets the application to include parameter limits,
execution time, and test-specific comments
generated during the test.
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Setting

Description

Include plot images

Sets the application to include plotted diagrams.

Include setup configuration

Sets the application to include information about
hardware and software used in the test in the
summary box at the top of the report.
Information includes: the oscilloscope model and
serial number, probe model and serial number,
the oscilloscope firmware version, SPC and
factory calibration status, and software versions
for applications used in the measurements.

Include Complete Application Configuration

Sets the application to include a table listing
general, common, and acquired parameters
used in the test. This option is disabled by
default.

Include user comments

Select to include any comments about the test
that you or another user added in the DUT tab of
the Setup panel. Comments appear in the
Comments section under the summary box at
the beginning of each report.

View report after generating

Automatically opens the report in your Web
browser when the test completes. This option is
selected by default.

See also.

View a report

View areport  The application automatically generates a report when test analysis is completed
and displays the report in your default Web browser (unless you cleared the View
Report After Generating check box in the Reports panel before running the
test). If you cleared this check box, or if you want to view a different test report,

do the following:

1. Click the Reports > Browse button and locate and select the report file to

View.

NOTE. If you did not save the test setup after running the test and you either
closed the application or you ran another test, the report file was not saved.

2. At the bottom of the Reports panel, click View.

For information on changing the file type, file name, and other report options, see

Select report options.
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Report contents

A report shows specified test details, as defined in the Reports panel.
Setup configuration information

Setup configuration information is listed in the summary box at the top of the
report. This information includes the oscilloscope model and serial number,
probe model and serial number, and software versions. To exclude this
information from the report, clear the Include setup configuration check box in
the Reports panel before running the test.

- TekExpress HDM
Tektronix P!
Source Test Report
DuTID spe Model
Sl 3cope 5eai3) rumbes
Dewee Type PC, FactoryCalibration
TekExprass Version Scope £ /W Varsion
Spec versian DROIT Version
Overall Compllance Mot Yes Probel Nodel
Execution Mooe Live Probe: Serial humber
Overall Execution Time 50748 Prane? Mode!
Overall Test Result Fail Probe? Serial Nurriber
Prabes Model
Probes Serial Number
Probed Mode!
Probed Sesial Number
DUT COMMENT. General Comment - HOM2.D Source
Sink
Tektronix TekExpress HDM
Sink Electrical Test Report
Setup
DUT ID. DUTO01 Scope Model DPO73304D
Date /Time 2014-05-23 11:37:54 Scope Serial Number Flash Failed
Device Type HDM Physical Layer Solution SPC, FactoryCalibration PASS;PASS
TekExpress Version HDM:1.0.1.235 Framework:3.0.1.43 Scope F/W Version 7.1.1 Build 1
Spec Version C1s2.0 Master AWG Model AWG70002A
Overall Compliance Mode No Master AWG F/W Version 2.0.0211
Execution Mode Live Slave AWG Model AWG70002A
Overall Execution Time 0:09:59 Slave AWG F/W Version 2.0.0211
Overall Test Result Pass AFG Model AFG3252C
DUT COMMENT: General Comment - HDM2.0 Sink Electrical

User comments

If you selected to include comments in the test report, any comments you added
in the DUT tab of the Setup panel appear in the Comments section directly below
the summary box.

Cornrmerts

Test results

This table lists the tests results. The contents of this table depend on the
selections made in the Reports panel before running the test (Include pass/fail
results summary, Include user comments, Include detailed results, Include setup
configuration, and Include user comments).

If Include plots images is selected, then measurement waveform plots are shown
below the test results table.
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See also.
View test results

View test-related files
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About the programmatic interface

The Programmatic interface allows you to seamlessly integrate the TekExpress
test automation application with the high-level automation layer. This also allows
you to control the state of the TekExpress application running on a local or a
remote computer.

For simplifying the descriptions, the following terminologies are used in this
section:

= TekExpress Client: A high-level automation application that communicates
with TekExpress using TekExpress Programmatic Interface.

= TekExpress Server: The TekExpress application when being controlled by
TekExpress Client.

TekExpress leverages .Net Marshalling to enable the Programmatic Interface for
TekExpress Client. TekExpress provides a client library for TekExpress clients to
use the programmatic interface. The TekExpress client library is inherited

from .Net MarshalByRef class to provide the proxy object for the clients. The
TekExpress client library maintains a reference to the TekExpress Server and this
reference allows the client to control the server state.

et C# Het VB et Web TestStand
Client Client Chient Client
F 3 '
‘\‘ L 4 v /'
TekEzpressClient Library
¥
TekExpress
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See also

Requirements for developing TekExpress client

Remote proxy object

Client proxy object

To enable remote access

To access and remotely control an instrument using the TekExpress
programmatic interface, you need to change specific firewall settings as follows:

1.

76

Access the Windows Control Panel and open the Windows Firewall tool
(Start > Control Panel > All Control Panel Items > Windows Firewall).

Click Advance Settings > Inbound Rules.

Scroll through the Inbound Rules list to see if the following items (or with a
similar name) are shown:

= TekExpress HDM
= TekExpress

W Wind ows Firewall with Advanced Security folla=s
File w

TP nbound Rules Actions

Narme Group Profile  * || Inbound Rules
oy Rules || @T0SCSA8000 il
(@ TD5Cs48000 Al
O T Y T
TekmDNSRespander Al
Tekscope i
TekScope Al View
e

All
G Refres

Al =

Al (2 ExportLis

If both items are shown, you do not need to set up any rules. Exit the
Windows Firewall tool.

If one or both are missing, use the following procedure to run the New
Inbound Rule Wizard and add these executables to the rules to enable
remote access to the TekExpress application.

On the client side include Client application.exe through which TekExpress
application is remotely controlled. For example if the application is
controlled using python scripts then "ipy64.exe" should be included as part of
Inbound rules.
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Run the New Inbound Rule 1. Click on New Rule (in Actions column) to start the New Inbound Rule
Wizard Wizard.

I | Actions

Action  * || Inbound Rules -
Allow || W New Rule...

Allow T Filter by Profile 3
Allow 7 =

Allow Filter by State »
Allow ' Filter by Group »
Allow View »

2. Verify that Program is selected in the Rule Type panel and click Next.

Click Browse in the Program panel and navigate to and select one of the
following TekExpress applications (depending on the one for which you need
to create a rule):

4. TekExpress HDM.exe
5. TekExpress.exe

NOTE. See for the path to the application files.

Click Next.

Verify that Allow the connection is selected in the Action panel and click
Next.

8. Verify that all fields are selected (Domain, Private, and Public) in the
Profile panel and click Next.

9. Use the fields in the Name panel to enter a name and optional description for
the rule. For example, a name for the TekExpress HDM application could be
TekExpress HDM Application. Add description text to further identify the
rule.

10. Click Finish to return to the main Windows Firewall screen.

11. Scroll through the Inbound Rules list and verify that the list shows the rule
that you just entered.

[E=mE=E <

Hame Group ’ Profile * || Inbiound Rules
o s || @ToSCS28000 AH
@oscsason Al

TekScape Al
TekScapell Al

o | TekExpress HOM -
Private # Disable Ruls

Al N

[ copr

privae || K Delre

privte (|5 properties

privte | B
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To use the remote access:

12. Repeat steps / through /7 to enter the other TekExpress executable if it is
missing from the list. Enter TekExpress PI as the name.

13. Scroll through the Inbound Rules list and verify that the list shows the rule
that you just entered.

14. Exit the Windows Firewall tool.

1. Obtain the IP address of the instrument on which you are running
TekExpress HDM. For example, 134.64.235.198.

2. On the PC from which you are accessing the remote instrument, use the
instrument IP address as part of the TekExpress HDM PI code to access that
instrument. For example:

object obj = piClient.Connect(*“134.64.235.198”,out clientid);

Requirements for developing TekExpress client

References required

Required steps for a client
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While developing the TekExpress Client, use the TekExpressClient.dll. The
client can be a VB .Net, C# .Net, TestStand or Web application. The examples
for interfaces in each of these applications are in the Samples folder.

TekExpressClient.dll has an internal reference to [Remotelnterface.dll.

m [Remotelnterface.dll provides the interfaces required to perform the remote
automations. It is an interface that forms the communication line between the
server and the client.

NOTE. The end-user client application does not need any reference to the above
mentioned DLL files. It is essential to have these DLLs (IRemotelnterface.dll and
TekDotNetLib.dll) in the same folder as that of TekExpressClient.dll.

The following steps are used by the client to programmatically control the server
using TekExpressClient.dll:

Develop a client Ul to access the interfaces exposed through the server. This
client loads TekExpressClient.dll to access the interfaces. After
TekExpressClient.dll is loaded, the client UI can call the specific functions to run
the operations requested by the client. When the client is up and running, it does
the following to run a remote operation:

1. To connect to the server, the client provides the IP address of the PC where
the server is running.

2. The client locks the server application to avoid conflict with any other Client
that may try to control the server simultaneously. “Lock” would also disable
all user controls on the server so that server state cannot be changed by
manual operation.
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If any other client tries to access a server that is locked, it will receive a
notification that the server is locked by another client.

3. When the client has connected to and locked the server, the client can access
any of the programmatic controls needed to run the remote automations.

4. After the client operations finish, the client unlocks the server.

See also HDM application commands flow

Remote proxy object

The server exposes a remote object to let the remote client access and perform the
server-side operations remotely. The proxy object is instantiated and exposed at
the server-end through marshalling.

MarshalByEef

TekExpress [ ——o— oy Ohject TekExpressClient

The following is an example:

RemotingConfiguration.RegisterWellKnownServiceType (typeof
(TekExpressRemotelnterface), “TekExpress Remote interface”,
WellKnownObjectMode.Singleton);

This object lets the remote client access the interfaces exposed at the server side.
The client gets the reference to this object when the client gets connected to the
server.

For example,
//Get a reference to the remote object

remoteObject =
(IRemotelnterface)Activator.GetObject(typeof(IRemotelnterface),
URL.ToString());
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Client proxy object

80

Client exposes a proxy object to receive certain information.

MarshalByEef

TekExpress [ ohonprm ryCbject TekExpressClient

For example,
//Register the client proxy object

WellKnownServiceTypeEntry[] e =
RemotingConfiguration.GetRegisteredWellKnownServiceTypes();

clientInterface = new ClientInterface();

RemotingConfiguration.RegisterWellKnownService Type(typeof(ClientInterface)
, “Remote Client Interface”, WellKnownObjectMode.Singleton);

//Expose the client proxy object through marshalling
RemotingServices.Marshal(clientInterface, "Remote Client Inteface");
The client proxy object is used for the following:

= To get the secondary dialog messages from the server.

m  To get the file transfer commands from the server while transferring the
report.

Examples
clientObject.clientIntf.DisplayDialog(caption, msg,iconType, btnType);
clientObject.clientIntf. TransferBytes(buffer, read, fileLength);

For more information, click the following links:

Secondary dialog message handling
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MarshalByEef
¥
Client Proxyobject .
TekEzpress |4 TelExpressClient
T Display Diskogl)
sSecondary Dialog

The secondary dialog messages from the Secondary Dialog library are redirected
to the client-end when a client is performing the automations at the remote end.

In the secondary dialog library, the assembly that is calling for the dialog box to
be displayed is checked and if a remote connection is detected, the messages are
directed to the remote end.

File Transfer Events

When the client requests the transfer of the report, the server reads the report and
transfers the file by calling the file transfer methods at the client-end.

Client programmatic interface overview

The following is an overview of the client programmatic interface:

Process flowchart
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Connect to Remote Object

'

Get Client ID

!

Lock Server

!

Register for Status Change Notification
l Handler for Status Change Notification

Select the requested tests

'

Set the necessary Patameters for eash selected test

!

Run the test

Status = ‘Wait/ Error’

Get Status Info
Get Status l

Do Action based on Status

No i

SetResponse

Status="Ready’

Get Results Return to Main Flow

!

Process the Results

!

Unlock Server

!

Disconnect from Remote Object

Stop

Process overview:
1. Connect to a server or remote object using a programmatic interface.

2. Get the client ID that is created when connecting to the remote object. This
client ID is one of the required parameters to communicate with the server.

NOTE. The server identifies the client with this ID only and rejects any
request if the ID is invalid.

TekExpress HDM Advanced Analysis and Compliance Solution



TekExpress programmatic interface

3. Lock the server for further operations. This disables the application interface.

NOTE. You can get values from the server or set values from the server to the
client only if the application is locked.

4. Register for receiving notifications on status change events on the server. To
register you need to give a handler as a parameter. For details, see Handler of
status change notification.

NOTE. Whenever there is a change in the status of the server, all the clients
registered with the server receive a notification from the server.

Select the tests to run through the programmatic interface.
Set the necessary parameters for each test.

Run the tests.

e BN

Poll for the status of the application.

NOTE. Skip this step if you are registered for the status change notification
and the status is Ready.

9. After completing the tests, get the results.
10. Create a report or display the results and verify or process the results.
11. Unlock the server after completing all the tasks.

12. Disconnect from the remote object.

Handler of status change 1. Get the status. If the status is Wait or Error, get the information that contains
notification the title, message description, and the expected responses for the status.

2. Perform the actions based on the status information.

Set the response as expected.

Seealso ... application commands flow

Program remote access code example
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Program remote access code example

This code example shows how to communicate between a remote PC and
TekExpress HDM.

Table 18: Remote access code example

Task Code

Start the application

Connect through an IP address. m_Client.Connect("localhost") 'True or False
clientlD = m_Client.getClientlD

Lock the server m_Client.LockServer(clientID)

Disable the Popups m_Client.SetVerboseMode(clientID, false)

Set the DUT ID m_Client.SetDutld(clientID, "DUT_Name")

Select a test For Source: SelectTest(clientld, device, Suite,

test name, true) m_Client.SelectTest(clientID,
"HDM Physical Layer Solution", "Source",
"HF1-2- TRISE, TFALL", true);

Run with set configurations m_Client.Run(clientID)
Wait for the test to complete. Do
Thread.Sleep(500)

m_Client.Application_Status(clientID)
Select Case status
Case "Wait"

Get the current state information mClient.GetCurrentStatelnfo(clientID,
WaitingMsbBxCaption, WaitingMsbBxMessage,
WaitingMsbBxButtontexts)

Send the response mClient.SendResponse(clientID,
WaitingMsbBxCaption, WaitingMsbBxMessage,
WaitingMsbBxResponse)

End Select

Loop Until status = "Ready"

Save results 'Save all results values from folder for current
run
m_Client.TransferResult(clientlD, logDirname)

Unlock the server m_Client.UnlockServer(clientID)

Disconnect from server m_Client.Disconnect()

Exit the application
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HDM application commands

HDM application  Click a client action link to see the associated command name, description,
commands flow  parameters, return value, and an example.

Connect through an IP address

Lock the server

Disable the popups

Set or get the DUT ID

Set the configuration parameters for a suite or measurement
Query the configuration parameters for a suite or measurement
Select a test

Select a suite

Run with set configurations or stop the run operation
Handle error codes

Get or set the timeout value

Wait for the test to complete

After the test is complete

Save, recall, or query a saved session

Unlock the server

Disconnect from the server

Connect through an IP Command name | Parameters Description Return value Example
address Connect() string ipAddress | This method Return valueis | m_Client = new
out string clientlD | connects the client| either True or Client() //m_Client

to the server. Note| False. is a reference to
The client provides the Client class in
the IP address to the Client DLL.
connect to the returnval as
server. boolean
The server returnval =
provides a unique m_Client.Connect(
client identification ipaddress,m_client
number when ID)
connected to it.
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string ipAddress

Name Type Direction Description

ipAddress string IN The ip address of the
server to which the
client is trying to
connect. This is
required to establish
the connection between
the server and the

client.
out string clientiD
Name Type Direction Description
clientlD string ouTt Identifier of the client
that is connected to the
server.

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70

NOTE. The server must be active and running for the client to connect to the
server. Any number of clients can be connected to the server at a time

NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client".
If the session is UNLOCKED the command returns "Lock Session to execute the

command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".
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Lock the server

Command name

Parameters

Description

Return value

Example

LockSession()

string clientlD

This method locks
the server. Note
The client must
call this method
before running any
of the remote
automations. The

String value that
gives the status of
the operation after
it has been
performed.

The return value is
"Session

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL.
returnval as string
returnval =

server can be Locked...” on m_Client.LockServ
locked by only one| success. er(clientlD)
client.
out string clientlD
Name Type Direction Description
clientlD string ouT Identifier of the client

that is connected to the
server.

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70

NOTE. When the client tries to lock a server that is locked by another client, the
client gets a notification that the server is already locked and it must wait until
the server is unlocked. If the client locks the server and is idle for a certain
amount of time then the server is unlocked automatically from that client.

NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client”.

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".
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Disable the popups

Use these commands to disable popup messages that require user intervention.

Command name | Parameters

Description

Return value

Example

SetVerboseMode() string clientID

bool -verbose

This method sets
the verbose mode
to either true or
false.

When the value is
set to true, any
message boxes
that appear during
the application will
be routed to the
client machine that
is controlling
TekExpress.
When the value is
set to false, all the
message boxes
are shown on the
server machine.

String that gives
the status of the
operation after it
has been
performed.
When Verbose
mode is set to
true, the return
value is “Verbose
mode turned on.
All dialog boxes
will be shown to
client”.

When Verbose
mode is set to
false, the return
value is “Verbose
mode turned off.
All dialog boxes
will be shown to
server’.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL.
returnval as string
Verbose mode is
turned on
return=m_Client.S
etVerboseMode(cli
entlD, true)
Verbose mode is
turned off
returnval=m_Clien
t.SetVerboseMod
e(clientID, false)

out string clientiD

Name

Type

Direction

Description

clientlD string ouTt Identifier of the client
that is connected to the
server.

clientID = unique
number + ipaddress of
the client. For example,

1065-192.157.98.70

bool-verbose

Name Type Direction Description

-verbose bool IN Specifies whether the
verbose mode should

be turned ON or OFF.
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NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another

client”.

If the session is UNLOCKED the command returns "Lock Session to execute the

command”.

If the server is NOTFOUND the command returns "Server not

found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".

Set or get the DUT ID Command name | Parameters Description Return value Example
SetDutld() string clientlD This method String that gives | m_Client = new
string dutName | changes the DUT | the status of the | Client() //m_Client
ID of the setup. | operation afterit | is a reference to
The client must | has been the Client class in
provide a valid performed. the Client DLL.
DUT ID. Return value is returnval as string
“DUT Id Changed” | return=m_Client.S
0N success . etDutld(clientID,de
siredDutld) Note
GetDutld() string clientlD This method gets | String that gives | m_Client = new
string dutld the DUT ID of the | the status of the | Client() //m_Client
current setup. operation afterit | is a reference to
has been the Client class in
performed. the Client DLL.
returnval as string
return=m_Client.G
etDutid(clientID,
out Dutld)
out string clientlD
Name Type Direction Description
clientlD string ouTt Identifier of the client

that is connected to the
server.

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70
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string dutName

Name Type Direction Description
dutName string IN The new DUT ID of the
setup.
string dutld
Name Type Direction Description
dutld string ouTt The DUT ID of the
setup.

The dutld parameter is set after the server processes the request.

NOTE. If the dutName parameter is null, the client is prompted to provide a valid
DIT ID.

NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client”.

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".
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Set the configuration
parameters for a suite or

measurement

Command name | Parameters Description Return value Example
SetGeneralParam | string clientlD This method sets | String that gives | Sets the value for
eter string device the general the status of the | the general
string suite parameter values. | operation after it | Parameter.
string test __ |hasbeen mClient.SetGener
string NOTE. Use this | performed. alParameter(clientl
parameterString | command to select The return value is| D, "HDM Physical
a lane, channel, or| ™ (an empty Layer Solution",
source type. String) on "Source", "HF1-2-
success. TRISE, TFALL",
"Voltage
termination
$Internal"
SetAnalyzeParam | string clientID This method sets | String that gives | Sets the value for
eter() string device the configuration | the status of the | the Analyze
string suite parameters in the | operation afterit | Parameter.
string test Analyze panel of | has been mClient.SetAnalyz
string the Configuration | performed. eParameter(clientl
parameterString | Panel dialog box | The return value is| D, "HDM Physical
for a suite or " (an empty Layer Solution",
measurement. String) on "Source", "HF1-2-
success. TRISE, TFALL",
"Signal Type
$DATA")
SetAcquireParame; string clientlD This method sets | String that gives | Sets the value for
ter() string device the configuration | the status of the | the Acquire
string suite parameters in the | operation afterit | Parameter.
string test Acquire panel of | has been mClient.SetAcquir
string the Configuration | performed. eParameter(clientl
parameterString | Panel dialog box | The return value is| D, "HDM Physical
for a suite or " (an empty Layer Solution",
measurement. String) on "Source", "HF1-2-
success. TRISE, TFALL",
"Short Record-
length for VLow
$Record Length
(M)$4"
out string clientiD
Name Type Direction Description
clientlD string out Identifier of the client

that is connected to the
server.

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70
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string device

Name Type Direction Description
device string IN Specifies the name of
the device.

For example "HDM
Physical Layer

Solution”
string suite
Name Type Direction Description
suite string IN Specifies the name of
the suite.
For Example "Source";
"Sink Electrical"; "Sink
Protocol"
string test
Name Type Direction Description
test string IN Specifies the name of

the test to obtain the
pass or fail status.
Test Names for Source:
"HF1-1- VL and
VSwing"; "HF1-2-
TRISE, TFALL";
"HF1-3- Inter-Pair
Skew"; "HF 1-4- Intra-
Pair Skew"; "HF 1-5-
Differential Voltage";
"HF1-6- Clock Duty
Cycle and Clock Rate";
"HF1-7- Clock Jitter";
"HF1-8- Data Eye

Diagram"
string parameterString
Name Type Direction Description
parameterString string IN Selects or deselects a
test.
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Query the configuration
parameters for a suite or

measurement

NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another

client”.

If the session is UNLOCKED the command returns "Lock Session to execute the

command”.

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".
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Command name | Parameters Description Return value Example
GetGeneralParam | string clientID This method gets | The return value is| Gets the value for
eter() string device the general the general the general
string suite configuration configuration Parameter.
string test parameters fora | parameter fora | mClient.GetGener
string suite or specified suite or | alParameter(client|
parameterString | measurement. measurement that | D, "HDM Physical
is set. Layer Solution",
"Source", "HF1-2-
TRISE, TFALL",
"Voltage
termination")
GetAnalyzeParam | string client/D This method gets | The return value is| Gets the value for
eter() string device the configuration | the configuration | the Analyze
string suite parameters setin | parameter setin | Parameter.
string test the Analyze panel | the Analyze panel | mClient.GetAnalyz
string of the of the eParameter(clientl
parameterString | Configuration Configuration D, "HDM Physical
Panel dialog box | Panel dialog box | Layer Solution”,
for a specified for a specified "Source", "HF1-2-
suite or suite or TRISE, TFALL",
measurement. measurement. "Signal Type")
GetAcquireParam | string clientID This method gets | The return value is| Gets the value for
eter() string device the configuration | the configuration | the Acquire
string suite parameters set in | parameter setin | Parameter.
string test the Acquire panel | the Acquire panel | mClient.GetAcquir
string for a specified for a specified eParameter(clientl
parameterString | suite or suite or D, "HDM Physical
measurement. measurement. Layer Solution",
"Source", "HF1-2-
TRISE, TFALL",
"Short Record-
length for VLow
$Record Length
M)
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out string clientiD

Name Type Direction Description

clientlD string ouTt Identifier of the client
that is connected to the
Server.

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70

string device

Name Type Direction Description
device string IN Specifies the name of
the device.
For example "HDM
Physical Layer
Solution”
string suite
Name Type Direction Description
suite string IN Specifies the name of
the suite.
For Example "Source";
"Sink Electrical"; "Sink
Protocol"
string test
Name Type Direction Description
test string IN Specifies the name of

the test to obtain the
pass or fail status.
Test Names for Source:
"HF1-1- VL and
VSwing"; "HF1-2-
TRISE, TFALL";
"HF1-3- Inter-Pair
Skew"; "HF 1-4- Intra-
Pair Skew"; "HF1-5-
Differential Voltage";
"HF1-6- Clock Duty
Cycle and Clock Rate";
"HF1-7- Clock Jitter";
"HF1-8- Data Eye
Diagram"
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string parameterString

Name Type Direction Description
parameterString string IN Selects or deselects a
test.

NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client".

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".

Query parameter example

returnval=mClient.GetAnalyzeParameter(clientID, "Transmitter", "Drive",
"5.3.9 - Random Jitter (RJ)", "Clock Edge")

Select a test Command name | Parameters Description Return value Example
SelectTest() string clientlD This method String that m_Client = new
string device selects or displays the status| Client() //m_Client
string suite deselects a of the operation | is a reference to
string test specified test. after it has been | the Client class in
bool isSelected | If this Setting performed. the Client DLL
parameter is set to| The return value is| returnval as string
true, you can " (an empty For Source:
selecta String) on SelectTest(clientld
measurement. success. , device, Suite,
If this Setting test name, true)
parameter is set to m_Client.SelectTe
false, you can st(clientlD, "HDM
deselecta Physical Layer
measurement. Solution",
"Source", "HF1-2-
TRISE, TFALL",
true);
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out string clientiD

Name Type Direction Description

clientlD string ouTt Identifier of the client
that is connected to the
Server.

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70

string device

Name Type Direction Description
device string IN Specifies the name of
the device.

For example "HDM
Physical Layer

Solution”
string suite
Name Type Direction Description
suite string IN Specifies the name of
the suite.

For Example "Source";
"Sink Electrical"; "Sink
Protocol"
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string test
Name Type Direction Description
test string IN Specifies the name of

the test to obtain the
pass or fail status.
Test Names for Source:
"HF1-1- VL and
VSwing"; "HF1-2-
TRISE, TFALL";
"HF1-3- Inter-Pair
Skew"; "HF 1-4- Intra-
Pair Skew"; "HF1-5-
Differential Voltage";
"HF1-6- Clock Duty
Cycle and Clock Rate";
"HF1-7- Clock Jitter";
"HF1-8- Data Eye
Diagram"

Test Names for Sink:
Electrical for CTS

2.0 "HF2-1 Min-Max
Differential Swing
Tolerance";

"HF2-2 Intra-Pair skew
test"; "HF2-3-Jitter
Tolerance test".

Test Names for Sink
protocol: For CTS

2.0 "HF2-6 Sink Video
Timing - 6G - 2160p
24 bit Color Depth",
"HF2-7 Sink Video
Timing - 6G - 2160p
Deep Color";

"HF2-8 Sink Video
Timing - 6G - 2160p
3D"; "HF2-23- Sink
Pixel Decoding YCBCR
4:2:0" "HF2-24 Sink
Pixel Decoding YCBCR
4:2:0 Deep Color";
"HF2-25 Sink Video
Timing - 21:9 (64:27)";
"HF2-36 Sink Video
Timing - 6G -
Non-2160p 24 bit Color
Depth"; "HF2-37 Sink
Video Timing - 6G -
Non-2160p Deep
Color"; "HF2-38 Sink
Video Timing - 6G -
Non-2160p 3D".
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bool isSelected

Name Type Direction Description
isSelected bool IN Selects or deselects a
test.

NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client".

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".

Select a device Command name | Parameters Description Return value Example
SelectDevice() string clientlD This method The return value is| m_Client.SelctDev
value selects device. " (an empty ice(Client_ID,"HD
String) on M Physical Layer
success. Solution")

out string clientlD

Name Type Direction Description

clientlD string ouTt Identifier of the client
that is connected to the
server.

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70

value
Name Type Direction Description
device string IN Specifies the name of

the device.

For example "HDM
Physical Layer
Solution"
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Select pattern(s) | Command name | Parameters Description Return value Example
SetAnalyzeParam | string clientlD This method sets | String that gives | Sets the value for
eter() string device the configuration | the status of the | the Analyze

string suite parameters in the | operation after it | Parameter.
string test Analyze panel of | has been mClient.SetAnalyz
string the Configuration | performed. eParameter( client
parameterString | Panel dialog box | The return value is| ID, "HDM
for a suite or " (an empty PhysicalLayer
measurement. String) on Solution","Sink
success. Electrical",
"HF2-2- Intra-Pair
Skew","Patterns
Selected
$4096x2160p@50
Hz_101 8Bit RGB
GRAY
5.94,3840x2160p
@50Hz_96 8Bit
RGB GRAY
5.94")
out string clientlD
Name Type Direction Description
clientlD string ouT Identifier of the client
that is connected to the
server.
clientlD = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70
string device
Name Type Direction Description
device string IN Specifies the name of
the device.
For example; "HDM
Physical Layer
Solution"
string suite
Name Type Direction Description
suite string IN Specifies the name of

the suite.

For Example; "Sink
Electrical"; "Sink
Protocol"
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string test
Name Type Direction Description
test string IN Specifies the name of

the test.

Test Names for Sink
Electrical and Sink
Protocol: "HF 2-1-Min/
Max Differential Swing
Tolerance"; "HF 2-2-
Intra-Pair Skew"; "HF
2-3-Jitter Tolerance";
"HF2-6 Sink Video
Timing - 6G - 2160p
24 bit Color Depth";
"HF2-7 Sink Video
Timing - 6G - 2160p
Deep Color";

"HF2-8 Sink Video
Timing - 6G - 2160p
3D"; "HF2-23 Sink Pixel
Decoding YCBCR
4:2:0" "HF2-24 Sink
Pixel Decoding YCBCR
4:2:0 Deep Color";
"HF2-25 Sink Video
Timing - 21:9"
"HF2-36 Sink Video
Timing - 6G -
Non-2160p 24 bit Color
Depth"; "HF2-37 Sink
Video Timing - 6G -
Non-2160p Deep
Color"; "HF2-38 Sink
Video Timing - 6G -

Non-2160p 3D"
string parameterString
Name Type Direction Description
parameterString string IN Selects the pattern for
the test.

Multiple patterns can
be selected using
comma separator(,) as
shown in the example
SetAnalyzeParameter()
example.
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NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client".

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".

Select a suite Command name | Parameters Description Return value Example
SelectSuite() string clientlD This method String that gives | m_Client.SelectSu
string device selects or the status of the | ite(clientID, "HDM
string suite deselects a operation after it | Physical Layer
bool isSelected | specified suite. has been Solution",
When this performed. "Source", true)

parameter is set to| The return value is

true, you can " (an empty
select a suite. String) on
When this success.
parameter is set to
false, you can
deselect a suite.
out string clientlD
Name Type Direction Description
clientlD string out Identifier of the client
that is connected to the
server.
clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70
string device
Name Type Direction Description
device string IN Specifies the name of

the device.

For example "HDM
Physical Layer
Solution"
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string suite
Name Type Direction Description
suite string IN Specifies the name of

the suite.
For Example "Source";
"Sink Electrical"; "Sink

Protocol"
bool isSelected
Name Type Direction Description
isSelected bool IN Selects or deselects a
test.

NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client”.

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".

Select a version Command name | Parameters Description Return value Example
SelectVersions() | string clientID This method The return value is| m_Client.SelectVe
string device selects version. | ™ (an empty rsions(Client_ID,"
string suite String) on HDM Physical
value success. Layer Solution",
"Sink Electrical",
['CTS2.0")

out string clientiD

Name Type Direction Description

clientlD string out Identifier of the client
that is connected to the
server.

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70
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value
Name Type Direction Description
device string IN Specifies the name of
the device.
For example "HDM
Physical Layer
Solution”
string device
Name Type Direction Description
device string IN Specifies the name of
the device.
For example "HDM
Physical Layer
Solution”
string suite
Name Type Direction Description
suite string IN Specifies the name of
the suite.
For Example "Source";
"Sink Electrical"; "Sink
Protocol"
Run with set | Command name | Parameters Description Return value Example
configurations or stop the Run() string clientlD Runs the selected | String that gives | m_Client = new

run operation

TekExpress HDM Advanced Analysis and Compliance Solution

tests. Note

After the server is
set up and
configured, run it
remotely using this
function.

the status of the
operation after it
has been
performed.

The return value is
"Run started..." on
success.

Client() //m_Client
is a reference to
the Client class in
the Client DLL.
returnval as string
returnval=m_Clien
t.Run(clientID)

Stop()

string clientlD

Stops the currently
running tests. Note

String that gives
the status of the
operation after it
has been
performed.

The return value is
"Stopped..." on
success.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL.
returnval as string
returnval=m_Clien
t.Stop(clientID)
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Handle error codes

out string clientiD

Type Direction Description

string ouTt

Name

Identifier of the client
that is connected to the
server.

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70

clientlD

NOTE. When the run is performed, the status of the run is updated periodically
using a timer.

NOTE. When the session is stopped, the client is prompted to stop the session and
is stopped at the consent.

NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client".

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".

The return value of the remote automations at the server-end is OP_STATUS,
which changes to a string value depending on its code, and returned to the client.
The values of OP_STATUS are as follows:

Code Value Description
-1 FAIL The operation failed.
1 SUCCESS The operation succeeded.
2 NOT FOUND Server not found.
LOCKED The server is locked by another
client, so the operation cannot
be performed.
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Get or set the timeout
value

Code Value Description

4 UNLOCK The server is not locked; lock
the server before performing
the operation.

0 NULL Nothing

NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another

client”.

If the session is UNLOCKED the command returns "Lock Session to execute the

command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".

Command name | Parameters Description Return value Example
GetTimeOut() string clientlD Returns the String that gives | m_Client = new
current timeout | the status of the | Client() //m_Client
period set by the | operation afterit | is a reference to
client. has been the Client class in
performed. the Client DLL.
The default return | returnval as string
value is 1800000. | returnval=m_Clien
t.GetTimeOut()
SetTimeOut() string clientlD Sets a timeout String that gives | m_Client = new
string time period specified by| the status of the | Client() //m_Client
the client. After | operation after it | is a reference to
this timeout period| has been the Client class in
expires, the server| performed. the Client DLL.
is unlocked On success the | returnval as string
automatically. return value is returnval=m_Clien
“TimeOut Period | t.SetTimeOut(clien
Changed”. tiD,
desiredTimeOut)
string time
Name Type Direction Description
time string IN The time in seconds

that refers to the
timeout period.
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The time parameter gives the timeout period, which is the time the client is
allowed to be locked and idle. After the timeout period if the client is still idle, it
gets unlocked.

The time parameter should be a positive integer; otherwise, the client is prompted
to provide a valid timeout period.

out string clientiD

Name Type Direction Description

clientlD string ouTt Identifier of the client
that is connected to the
server.

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70

NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client".

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".

Wait for the testto =~ The commands in this group execute while tests are running. The
complete GetCurrentStatelnfo() and SendResponse() commands are executed when the
application is running and in the wait state.
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Command name | Parameters Description Return value Example
ApplicationStatus() string clientD This method gets | String value that | m_Client = new
the status of the | gives the status of | Client() //m_Client
server application. | the server is a reference to
The states are application. the Client class in
Ready, Running, the Client DLL.
Paused, Wait, or returnval as string
Error. returnval=m_Clien
t.ApplicationStatu
s(clientID)
QueryStatus() string clientlD An interface for | String that gives | m_Client = new
out string[] status | the user to transfer the status of the | Client() //m_Client
Analyze panel operation after it | is a reference to
status messages | has been the Client class in
from the server to | performed. the Client DLL.
the client. On success the | returnval as string
return value is Query status
“Transferred...”. | example
GetCurrentStatelnf| string clientlD This method gets | This command m_Client = new
o() out string the additional does not return | Client() /m_Client
WaitingMsbBxCap | information of the | any value. is a reference to
NOTE. This tion states when the | This function the Client class in
command is used | out string applicationisin | populates the Out | the Client DLL.
when the WaitingMsbBxMes| Wait or Error state| parameters that | mClient.GetCurren
application is sage Except client ID, | are passed when | tStatelnfo(clientID,
running and is in | out string(] all the others are | invoking this WaitingMsbBxCap
the wait or error | WaitingMsbBxButt| Out parameters. | function. tion,
State. ontexts WaitingMsbBxMes
sage,
WaitingMsbBxButt
ontexts)
107
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Command name | Parameters Description Return value Example
SendResponse() | string clientlD After receiving the | This command m_Client = new
— loutstring additional does not return | Client() //m_Client
NOTE. This WaitingMsbBxCap | information using | any value. is a reference to
command is used | tion the method the Client class in
when the out string GetCurrentStatelnf the Client DLL.
application is WaitingMsbBxMes| o(), the client can mClient.SendResp
running and is in | sage decide which onse(clientID,
the wait or error | string response to send WaitingMsbBxCap
state. WaitingMsbBxRes | and then send the tion,
ponse response to the WaitingMsbBxMes
application using sage,
this function. The WaitingMsbBxRes
response should ponse)
be one of the
strings that was
received earlier as
a string array in
the
GetCurrentStatelnf
o function. The
_caption and
_message should
match the
information
received earlier in
the
GetCurrentStatelnf
o function.
Ready: Test configured and ready to start.
Running: Test running.
Paused: Test paused.
Wait: A popup that needs your inputs.
Error: An error is occurred.
out string clientlD
Name Type Direction Description
clientlD string ouT Identifier of the client

that is connected to the
server.

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70
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Name Type Direction Description
status string array ouTt The list of status
messages generated
during the run.
out string WaitingMsbBxCaption
Name Type Direction Description
caption string out The wait state or error
state message sent to
yo.u
out string WaitingMsbBxMessage
Name Type Direction Description
message string out The wait state/error
state message sent to
you.
out string[] WaitingMsbBxButtontexts
Name Type Direction Description
buttonTexts string array out An array of strings
containing the possible
response types that
you can send.
string WaitingMsbBxResponse
Name Type Direction Description
response string IN A string containing the

response type that you
can select (it must be
one of the strings in the
string array
buttonTexts).
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After the test is complete

110

NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another

client”.

If the session is UNLOCKED the command returns "Lock Session to execute the

command”.

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".

Query status example

returnVal=m_Client.QueryStatus(clientID, out statusMessages)
if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)

return “Status updated...”

else

return CommandFailed(returnVal)

Command name

Parameters

Description

Return value

Example

GetPassFailStatu
s()

string clientlD
string device

This method gets
the pass or fail

String that gives
the status of the

m_Client = new
Client() //m_Client

value in the form
of a string.

string suite status of the operation afterit | is a reference to
string test measurement aften has been the Client class in
test completion. | performed. the Client DLL.
| Returnsthe pass |returnval as string
NOTE. Execute | or fail status in the | returnval=m_Clien
this command form of a string. | t.GetPass-
after completing FailStatus(clientID,
the measurement. device,suite,
— "HF1-1- VL and
VSwing”)
GetResultsValue() | string clientlD This method gets | String that gives | m_Client = new
string device the result values of the status of the | Client() //m_Client
string suite the measurement | operation after it | is a reference to
string test after the run. has been the Client class in
string performed. the Client DLL.
parameterString Returns the result | returnval as srting

returnval=m_Clien
t.GetResultsValug(
clientID,device,suit
e, "HF1-1- VL and
VSwing")
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Command name

Parameters

Description

Return value

Example

GetResultsValueF
orSubMeasureme

string clientlD
string device

This method gets
the result values

String that gives
the status of the

m_Client = new
Client() //m_Client

nts() string suite for individual sub- | operation after it | is a reference to
string test measurements | has been the Client class in
Results Panel after the run. performed. the Client DLL.
Column Name Returns the result | returnval as string
int rowNr value in the form | Get results for a
of a string. submeasurement
example
GetReportParametf string client/D This method gets | The return value is| m_Client = new
er() string device the general report | the oscilloscope | Client() /m_Client
string suite details such as model, is a reference to
string test oscilloscope TekExpress the Client class in
string model, version, and HDM | the Client DLL.
parameterString | TekExpress version. returnval as string

version, and HDM
Version.

Oscilloscope
Model
returnval=m_Clien
t.GetReportParam
eter(clientlD,"Scop
e Model")
TekExpress
Version
returnval=m_Clien
t.GetReportParam
eter(clientlD,"TekE|
xpress Version")
HDM Version
returnval=m_Clien
t.GetReportParam
eter(clientID,"Appli
cation Version")
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Command name | Parameters Description Return value Example
TransferResult() | string clientlD This method String that gives | m_Client = new
string filePath transfers the the status of the | Client() //m_Client

report generated | operation afterit | is a reference to
after the run. has been the Client class in
The report performed. the Client DLL.
contains the Transfers all the | returnval as string
summary of the | result values in the| returnval=m_Clien
run. form of a string. | t.TransferResult(cli
The client must entID,"C:\Report”)
provide the

location where the
report is to be
saved at the client-
end.

Transferimages() | string clientlD

string filePath

This method
transfers all the
images (screen
shots) from the
specified client
and folder for the
current run (for a
suite or
measurement).

NOTE. Every time
you click Start, a
folder is created in

String that gives
the status of the
operation after it
has been
performed.
Transfers all the
images in the form
of a string.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL.
returnval as string
returnval=m_Clien
t.Transferimages(c
lientlD, "C:
\Waveforms”)

the X: drive.
Transfer the
waveforms before
clicking Start.
out string clientlD
Name Type Direction Description
clientlD string ouTt Identifier of the client

that is connected to the
server.

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70
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TekExpress programmatic interface

Name

Type

Direction

Description

device

string

IN

Specifies the name of
the device.

For example "HDM
Physical Layer
Solution”

string suite

Name

Type

Direction

Description

suite

string

IN

Specifies the name of
the suite.
For Example "Source";
"Sink Electrical"; "Sink
Protocol"

string test

Name

Type

Direction

Description

test

string

IN

Specifies the name of
the test to obtain the
pass or fail status.
Test Names for Source:
"HF1-1- VL and
VSwing"; "HF1-2-
TRISE, TFALL";
"HF1-3- Inter-Pair
Skew"; "HF 1-4- Intra-
Pair Skew"; "HF 1-5-
Differential Voltage";
"HF1-6- Clock Duty
Cycle and Clock Rate";
"HF1-7- Clock Jitter";
"HF1-8- Data Eye
Diagram"

int rowNr

Name

Type

Direction

Description

rowNr

int

IN

Specifies the zero
based row index of the
sub-measurement for
obtaining the result
value.
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NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client".

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".

string parameterString

Name Type Direction Description

parameterString string IN Specifies the
oscilloscope model,
TekExpress version,
and HDM version.

string filePath

Name Type Direction Description

filePath string IN The location where the
report must be saved in
the client.

NOTE. If the client does not provide the location to save the report, the report is
saved at C:\ProgramkFiles.

Get results for a submeasurement example

This example returns the specified submeasurement results for test HF1-2-
TRISE, TFALL.

returnval=m_Client.GetResultsValue( clientID," "HDM Physical Layer
Solution", "Source", "HF1-2- TRISE, TFALL","Value",0)

returnval=m_Client.GetResultsValue( clientID," "HDM Physical Layer
Solution", "Source", "HF1-2- TRISE, TFALL","Value",1)
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Save recall or query a

saved session

Command name | Parameters Description Return value Example
CheckSessionSav | string clientlD This method Return valueis | m_Client = new
ed() out bool saved checks whether | either True or Client() //m_Client
the current False. is a reference to
session is saved. the Client class in
the Client DLL.
returnval as string
returnval=m_Clien
t.CheckSessionSa
ved(m_clientID,
out savedStatus)
RecallSession() | string clientlD Recalls a saved | String that gives | m_Client = new

string name

session. The client
provides the

the status of the
operation after it

Client() //m_Client
is a reference to

session name. has been the Client class in
performed. the Client DLL.
The return value is| returnval as string
“Session returnval=m_Clien
Recalled...” t.RecallSession(cli
entlD,
savedSessionNam
e)
SaveSession() string clientlD Saves the current | String that gives | m_Client = new
string name session. The client| the status of the | Client() //m_Client
provides the operation after it | is a reference to
session name. has been the Client class in
performed. the Client DLL.
The return value is| returnval as string
"Session returnval=m_Clien
Saved..."/"Failed...| t.SaveSession(clie
" ntiD,
desiredSessionNa
me)
SaveSessionAs() | string clientID Saves the current | String that gives | m_Client = new
string name session undera | the status of the | Client() /m_Client
different name operation after it | is a reference to
every time this has been the Client class in
method is called. | performed. the Client DLL.
The client provides| The return value is| returnval as string
the session name. | "Session Saved..."| returnval=m_Clien
t.SaveSessionAs(c
lientID,
desiredSessionNa
me)
string name
Name Type Direction Description
name string IN The name of the
session being recalled.
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The name parameter cannot be empty. If it is empty, the client is prompted to
provide a valid name.

out bool saved

Name Type Direction Description

saved bool ouTt Boolean representing
whether the current

session is saved.

This parameter is used as a check in SaveSession() and SaveSessionAs()
functions.

out string clientlD

Name Type Direction Description

clientlD string ouT Identifier of the client
that is connected to the
server.

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70

NOTE. The Fail condition for this command occurs in the following conditions:
If the server is LOCKED the command returns "Server is locked by another
client".

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".
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Unlock the server Command name | Parameters Description Return value Example

UnlockSession() | string clientID This method String that gives | m_Client = new
unlocks the server | the status of the | Client() /m_Client
from the client. operation after it | is a reference to

The ID of the client has been the Client class in
to be unlocked performed. the Client DLL.
must be provided. | The return value is| returnval as string
Note "Session Un- returnval=m_Clien
Locked..." t.UnlockServer(clie
ntID)
out string clientlD
Name Type Direction Description
clientlD string ouT Identifier of the client
that is connected to the
server.

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70

NOTE. When the client is disconnected, the client is unlocked automatically.

NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client”.

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".
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Disconnect from the Command name | Parameters Description Return value Example
server Disconnect() string clientlD This method Integer value that | m_Client = new
disconnects the | gives the status of | Client() //m_Client
client from the the operation after | is a reference to
server. Note it has been the Client class in
performed. the Client DLL.
1 for Success returnval as string
—1 for Failure returnval=m_Clien
t.Disconnect(m_cli
entID)
out string clientlD
Name Type Direction Description
clientlD string ouT Identifier of the client
that is connected to the
server.

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70

NOTE. When the client is disconnected, it is unlocked from the server and then
disconnected. The id is reused.

NOTE. The Fail condition for this command occurs in the following conditions:
If the server is LOCKED the command returns "Server is locked by another
client”.

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".
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About algorithms

For all measurements, use the following guidelines to set up the oscilloscope.

Oscilloscope Setup  The following guidelines are generalized.

Guidelines .
The signal refers to channel, reference, or math waveform.

m The vertical scale for the waveform must be set so that the waveform does
not exceed the vertical range of the oscilloscope.

m  The sample rate must be set to capture sufficient waveform detail and avoid
aliasing.

= Longer record lengths increase measurement accuracy but the oscilloscope
takes longer to measure each waveform.
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HDM Source tests

NOTE. In single stack 2 channel oscilloscopes, select appropriate channel
configurations in TekExpress HDM sofiware: DPO72302S8X, DPO733025X,
DPO750025SX, DPO759028X, and DPO770025X.

HF1- 2 - Source TMDS electrical - 6G 'TRISE7 TFALL

This test confirms that the rise times and fall times on the TMDS differential
signals fall within the limits of the specification.

Required test equipment  In addition to the DUT, you will need the following:

m Digital storage oscilloscope: DPO/DSA/MSO series oscilloscope with BW
greater than or equal to 16 GHz

m  Four Differential probes — P7313SMA, for single ended and differential tests
m  Test fixture: TF-HDM-TPA-S fixture for Source to be used for source testing

= Power supply: PWS4205 or PWS2185 (if using external power supply
option)

Connect the equipment as shown in the Source differential diagram.
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Differential measurement

Power supply *
03.30 N
P 2

(ele

] S ' L

L6 CLOCKN

\E\CLOCK_P

\"-P“” = DATAO_P
o Do I
DATAO_N

CLK CLOCK_P

T

7

Notes:

Connect to Biased 5002 Termination of all unoccupied lanes.

*Scupe has the capability to support the probe termination voltage.

Set the DUT to operate in normal mode.
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Differential measurement

[Fmron

Power supply *

] CLOCK_;
W EDID emulator / EDID PCB

Ragy
- |
|
\

Second row of

connectors below |,
\ CLK CLOCK_P
- CLOCK_N

Notes:

Connect to TF-HDMI-T termination fixture

*Scope has the capability to support the probe termination voltage. 0626:080
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Measurement algorithm

The algorithm calculates the rise and fall time of the waveform as per the
following steps:

1.
2.

Given a waveform, find the Vg and Vi gy
Measure the Vi gy,

a. Capture 1000 or more repetitions, triggered at the vertical mid-point of
the High-to-Low transition of a H-L-L-L bit sequence. Each capture must
be of duration 3 times TBIT.

b. Display the voltage (vertical) histogram on the scope, with the histogram
data accumulated only from the last 2-bits of the H-L-L-L sequence.

c. Read the V[, value as the most common low-level (mode) voltage
shown on the histogram.

Measure the Vy;gp

a. Capture the 1000 or more repetitions, triggered at the vertical mid-point
of the High-to-Low transition of a L-H-H-H bit sequence. Each capture
must be of duration 3 times TBIT.

b. Display the voltage (vertical) histogram on the scope, with the histogram
data accumulated only from the last 2-bits of the L-H-H-H sequence.

¢. Read the Vyjgp, value as the most common low-level (mode) voltage
shown on the histogram.

Measure Tgisg as the mode of the sampled edge times from 20% to 80% of
the differential swing voltage (Vyign) rising edge.

Measure Tgap 1 as the mode of the sampled edge times from 80% to 20% of
the differential swing voltage (Vi) on the falling edge.

HF1- 3 - Source TMDS Electrical - 6G - Inter-Pair Skew

This test confirms that the skew between two data lanes on the TMDS differential
signals fall within the limits of the specification.

Required test equipment

124

In addition to the DUT, you will need the following:

Digital Storage oscilloscope: DPO/DSA/MSO series oscilloscope with BW
greater than or equal to 16 GHz

Four Differential probes — P7313SMA, for single ended and differential tests
Test fixture: TF-HDM-TPA-S fixture for Source to be used for source testing

Power supply: PWS4205 or PWS2185 (if using external power supply
option)

Connect the equipment as shown in the Source differential diagram.
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Differential measurement

Power supply *

e

leJo)

| _~CLOCK_N

= \E’\CLOCK_F'
_‘T! EDID emulator / EDID PCB

DuT
D0 DATAO0_P al
Wl DATAO_N ~
) = -
Second row of 1 ¥

connectors below

CLK CLOCK_P

CLOCK_N

Notes:

Connect to Biased 5002 Termination of all unoccupied lanes.
*,
Scope has the capability to support the probe termination voltage. 5016
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Differential measurement

[Fmron

Power supply *

] CLOCK_;
W EDID emulator / EDID PCB

Ragy
- |
|
\

Second row of

connectors below |,
\ CLK CLOCK_P
- CLOCK_N

Notes:

Connect to TF-HDMI-T termination fixture

*Scope has the capability to support the probe termination voltage. 0626:080
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Measurement algorithm  The algorithm calculates the skew between the differential pairs in the TMDS
portion as per the below steps. Inter pair skew test is a differential test and is only

for data signals. Clock signal is excluded for this test, but is used for calculating
the Tbit.

1. Connect and acquire the Data 0 and Data 1 signals.

2. Set the Digital Oscilloscope horizontal setting: sampling rate >= 25 Gs/sec
and Record Length set to 100 M.

Decode the bit stream of Data 0 and Data 1.

4. Search for the 20 bit unscrambled control code (SSCP) on Data 0 and Data 1.
SSCP might have one of the following 10 bit values:

= 1101010100
= 0010101011
= 0101010100
= 1010101011
Stop the acquisition and measure the TSKEW between channels.
6. Repeat the test for the remaining combinations of TMDS DATAX pairs.

HF1- 6 - Source TMDS Electrical - 6G - Clock Duty Cycle and Clock Rate

This test confirms that the duty cycle and clock rate of the TMDS differential
clock complies with the limits mentioned in specification.

Required test equipment  In addition to the DUT, you will need the following:

m  Digital Storage oscilloscope: DPO/DSA/MSO series oscilloscope with BW
greater than or equal to 16 GHz

m  Four Differential probes — P7313SMA, for Single Ended and Differential
tests

m  Test fixture: TF-HDM-TPA-S fixture for Source to be used for source testing

= Power supply: PWS4205 or PWS2185 (if using external Power Supply
option)

Connect the equipment as shown in the Source differential diagram.
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Differential measurement

Power supply *

Notes:
Connect to TF-HDMI-TPA-T termination fixture
*Scope has the capability to support the probe termination voltage

o

Set the DUT to operate in normal mode.
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Differential measurement

[Fmron

Power supply *

] CLOCK_;
W EDID emulator / EDID PCB

Ragy
- |
|
\

Second row of

connectors below |,
\ CLK CLOCK_P
- CLOCK_N

Notes:

Connect to TF-HDMI-T termination fixture

*Scope has the capability to support the probe termination voltage. 0626:080
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Measurement algorithm

The algorithm calculates the Clock Duty Cycle of the waveform as per the
following steps:

1.

DPOJET Duty Cycle measurement is used to perform this measurement.

2. The Duty Cycle (Max) and Duty Cycle (Min) value calculate the difference

in positive (or negative) pulse widths from one cycle to the next.

The application calculates these measurements using the following equations:

AW =AW —AW

AW =AW —AW.

Where:

m AW+ is the difference between positive pulse widths of adjacent clock
cycles.

m  AW-is the difference between negative pulse widths of adjacent clock
cycles.

m W+ is the positive pulse width measurement.

m  W-is the negative pulse width measurement.

HF1- 7- Source TMDS Electrical - 6G - Clock jitter

This test confirms that the clock jitter of the TMDS differential clock complies
with the limits mentioned in specification.

Required test equipment

130

In addition to the DUT, you will need the following:

Digital Storage oscilloscope: DPO/DSA/MSO series oscilloscope with BW
greater than or equal to 16 GHz

Four Differential probes — P7313SMA, for single ended and differential tests
Test fixture: TF-HDM-TPA-S fixture for Source to be used for source testing

Power supply: PWS4205 or PWS2185 (if using external power supply
option)

Connect the equipment as shown in the Source differential diagram.
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Differential measurement

DPCB

|

connectors below | .
| 4
i

Notes:
Connect to TF-HDMI-TPA-T termination fixture
*Scope has the capability to support the probe termination voltage —

Set the DUT to operate in normal mode.
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Differential measurement

[Fmron

Power supply *

] CLOCK_;
W EDID emulator / EDID PCB

Ragy
- |
|
\

Second row of

connectors below |,
\ CLK CLOCK_P
- CLOCK_N

Notes:

Connect to TF-HDMI-T termination fixture

*Scope has the capability to support the probe termination voltage. 0626:080
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Measurement algorithm  TekExpress HDM automatically executes the following calculations:

1. Acquire the differential clock signal with same settings as before:
Compliance Mode: 50 GS/sec Compliance Mode: 18M.

2. Apply 12.5x BW enhancement filter and save the wfm: - C:\TekScope\Math
Arbitrary Filters\Probe-Filters\P7313 SMA 12.5x 16GHz 50GSs.flt and
save this wfm as Clk. BWE.wfm.

Pass Clk. BWE.wfm from step 2 to algorithm for swing calculation.
Swing limits: If (Vs > 1200 mV) OR (Vs <400 mV) then FAIL.

5. Apply the Cable effect on Clk. BWE.wfm from step 2, that is apply
sdlaTp2clk.flt filter. Save this wfm as Clock CableEffect.wfm.

= Recall Clk BWE.wfm on Refl

m  Load Arbfiltl = sdlaTp2clk.flt

m  Mathl = Arbfiltl(Refl)

= Save Mathl as Clock CableEffect.wfm
Recall Clock CableEffect.wfm on Refl
Load load arbfilt] = HDMI2 _EQ 50G.flt
Mathl = arbfiltl(Ref1)

Pass Math1 from step 8 to DPOJET for jitter calculation. DPOJET settings
are same as before:

» Edge->Rising->50% TIE CH1
m  Signal Type: Clock
= Clock Edge: Rise
m  Clock Recovery => Method: PLL Custom BW
= PLL Model: Type ]
= Loop BW :4 MHz
m  Filter Spec : I st Order
m  Freq(F1):4 MHz
10. If Clock jitter exceeds 0.3 times TBIT then FAIL.

L e A

HF1-1- Source TMDS Electrical - 6G -V|_and Vgying

This test confirms that the low voltage level of the TMDS single-ended signals
and the Swing of the single-ended signals complies with the limits listed in the
specification.

Required test equipment  In addition to the DUT, you will need the following:

= Digital Storage oscilloscope: DPO/DSA/MSO series oscilloscope with BW
greater than or equal to 16 GHz

m  Four Differential probes — P7313SMA, for single ended and differential tests
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m  Test fixture: TF-HDM-TPA-S fixture for Source to be used for source testing

= Power supply: PWS4205 or PWS2185 (if using external power supply
option)

Connect the equipment as shown in the Source single ended diagram.

Single ended measurement

o -‘|

‘ - \”');'7““—CLOCK_P

ji-

EDID emulator / EDID PCB

‘ - |
T

D2 DATA2_P

Second row of
connectors below

CLOCK_N

Notes:

Connect to Biased 502 Termination of all unoccupied lanes.

*Scnpe has the capability to support the probe termination voltage.

Set the DUT to operate in normal mode.
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Single ended measurement

L

L J
O
e

00OG00___ 00000000000000o00d

iﬂu

Power supply *

D2 DATA2_P

DATA2N

(G
[

DUT

Second row of
connectors below

R
|
:
| /
N CLK CLOCK P
L
CLOCK N
Notes:

gonnect to Biased 50Q2 Termination of all unoccupied lanes.
Scope has the capability to support the probe termination voltage. 0926-062
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Measurement algorithm  The algorithm calculates the Vi 4, and Vin, of the waveform as per the
following steps:

1. Ifthe signal is a Data Channel, perform the following procedure:

a. Acquire the waveform using real time oscilloscope with record length
good enough to analyze the 1000 region of H-L-L-L for the
measurement. (If not, re-acquire it again till 1000 population is
considered for the measurement).

b. Locate the region of H-L-L-L transition on region of single ended
measurement.

¢. Measure and record the histogram value with the histogram data
accumulated only from the last 2-bits of the H-L-L-L sequence.

d. Measure and record VL value as the most common low-level voltage of
histogram data.

e. Capture 1,000 or more repetitions, triggered at the vertical mid-point of
the Low-to-High transition of a L-H-H-H bit sequence. Each capture
shall be of a duration of at least 3*Ty;,.

f. Generate a voltage (vertical) histogram, with the histogram data
accumulated only from the last 2-bits of the L-H-H-H sequence.

g. Read the Vg value as the most common high-level voltage shown on the
histogram.

h. Calculate Vswing = Vg - Vi,
i. If(Vp<230V)OR (2.90V <V ), then FAIL.
j-  If(Vswing <400 mV) or ( 600mV < Vswing ), then FAIL.
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2. Ifthe signal is the Clock , then perform the following procedure:

a.

g.
h.

i

Capture 1,000 or more repetitions of the clock signal of suitable duration
such that the Low state captured includes the measurement interval
described in the step below

Generate a voltage (vertical) histogram, with the histogram data
accumulated only from the segment in the Low clock state, starting
17*Ty;; after each High to Low transition that is analyzed, until 19*Ty;;
after the transition.

Read the V value as the most common low-level voltage shown on the
histogram.

Capture 1,000 or more repetitions of the clock signal of suitable duration
such that the High state captured includes the measurement interval
described in the step below.

Generate a voltage (vertical) histogram, with the histogram data
accumulated only from the segment in the High clock state, starting
17*Ty; after each Low to High transition that is analyzed, until 19*Ty;;
after the transition.

Read the Vg value as the most common high-level voltage shown on the
histogram.

Calculate Vswing = Vg - VL.
If (VL <230 V) OR (3.10V < V), then FAIL.
If (Vswing < 200 mV) or (600 mV < Vswing), then FAIL.

3. Repeat the steps for all the remaining untested TMDS signals.

HF1- 8 - Source TMDS Electrical - 6G - Data Eye Diagram

This test confirms that the HDMI Data output has signal quality that meets the
eye opening required by the specification.

Required test equipment  In addition to the DUT, you will need the following:

m  Digital Storage oscilloscope: DPO/DSA/MSO series oscilloscope with BW
greater than or equal to 16 GHz

m  Four Differential probes — P7313SMA, for single ended and differential tests

m  Test fixture: TF-HDM-TPA-S fixture for Source to be used for source testing

= Power supply: PWS4205 or PWS2185 (if using external power supply
option)

Connect the equipment as shown in the Source data eye diagram.
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138

Data eye diagram measurement

Power supply

D0 DATAQ_P 2y
DATAO_N s
Second row of
conneclors below
T CLK CLOCK P
FRA CLOCK_N
Notes:
Connect to Biased 5002 Termination of all unoccupied lanes.
*Sunpe has the capability to support the probe termination voltage. Lot

Set the DUT to operate in normal mode.
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Data eye diagram measurement

Power supply

|j@n @

s o ¢ - . X \' !‘
Power supply *| . 4 A=

) ] P
@%DataMPIN
03.30}

CLOCK_P
_TJM_ EDID emulator / EDID PCB

A
/g Pull up

~(Pulup)

h Do DATAO_P AN
N o DATAON P
Second row of w;;“’r'

connectors below -
!
L

i
%__ CLK CLOCK P
CLOCK_N
Notes:
s,onnecl to Biased 50€) Termination of all unoccupied lanes.
Scope has the capability to support the probe termination voltage.

0526063
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Measurement algorithm

140

TekExpress HDM automatically executes the following calculations:
This is a DPOJET based measurement.

CTS Procedure

m  Source Eye Diagram test is measured at TP2 EQ.

m  TP2 is the signal after passing along a worst cable.

= Worst cable has worst attenuation and skew of 112 ps.
Measurement procedure

1. Connect the Clock of the HDMI 2.0 source DUT to Chl of the oscilloscope.
(Adding Type 4 Cable Emulator and inserting 112 ps delay on all TMDS data
positive lanes.)

2. Connect Data0 (0/1/2/) +ve of the HDMI 2.0 Source to Ch3 of the
oscilloscope.

3. Connect Data0 (0/1/2/) -ve of the HDMI 2.0 Source to Ch4 of the
oscilloscope.

4. On Clock signal :
m  Load Arbfiltl = sdlaTp3DIFFSrcl.flt — sdlaTp2clk.flt
= Mathl = Arbfiltl (Chl)
m  Save Mathl as 1-7 TMDS Data Eye Diagram_Clock.wfm
5. On Data signal, load below filter files:
m  ArbFiltl =sdlaTp2ADp.flt
m  ArbFilt2 = sdlaTp2ADn.flt
= ArbFilt3 = sdlaTp2BDp.flt
= Arbfilt4 = sdlaTp2BDn.flt
6. Define Math waveforms
m  Math2 = Arbfiltl (Ch3) + Arbfilt2 (Ch4)
= Math3 = ArbFilt3 (Ch3) + Arbfilt4 (Ch4)

= Save Math4 = Math 2 — Math3 as 1-7 TMDS Data Eye
Diagram_Data.wfm

7. Clear all Maths and filter file definitions.
Recall 1-7 TMDS Data Eye Diagram_Clock.wfm on Refl.
Recall 1-7 TMDS Data Eye Diagram_Data.wfm on Ref2.
10. Load arbfiltl = HDMI2 EQ 50G.flt.
Math1 = arbfilt]l (Ref1)
Math2 = arbfiltl (Ref2)
11. Perform DPOJET ->Mask Hits measurements with below settings:
m  Clock Recovery => Method: Explicit Clock — PLL,
m  Clock Source: Math1
m  Clock Edge: Rise
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= Clock Multiplier: 40
= PLL Model: Type I
= Damping: 700 m
= Loop BW:4 MHz
= Mask File = Data Rate 5.92 Gbps.msk
= Clock offset = Auto
m  BitType = All
= Plot = Eye Diagram
12. Perform DPOJET ->Eye width measurements with below settings:
m  Clock Recovery => Method: Explicit Clock — PLL,
m  Clock Source: Math1
m  Clock Edge: Rise
m  Clock Multiplier: 40
m  PLL Model: Type I
®  Damping: 700 m
= Loop BW:4 MHz
m  Clock offset = Auto
m  Bit Type = All
m  Measurement setting ->Cursor gating ON

13. Enable the measurement with vertical cursors on at 5% and 95% of the
oscilloscope acquisition.

14. Perform the above measurement on Datal and Data2 by repeating the steps
from (2) to (13).

(Adding Type4 Cable Emulator and inserting 112 psec delay on all TMDS data
negative lanes.)

1. Connect the Clock of the HDMI 2.0 source DUT to Chl of the oscilloscope.

2. Connect Data0 (0/1/2/) +ve of the HDMI 2.0 Source to Ch3 of the
oscilloscope.

3. Connect Data0 (0/1/2/) -ve of the HDMI 2.0 Source to Ch4 of the
oscilloscope.

4. On Clock signal:

m  Load Arbfiltl = sdlaTp3DIFFSrcl.flt — sdlaTp2clk.flt

= Mathl = Arbfiltl (Chl)

m  Save Mathl as 1-7 TMDS Data Eye Diagram_Clock.wfm
5. On Data signal, load these filter files:

= ArbFIltl =sdlaTp2ADp.flt

m  ArbFilt2 = sdlaTp2ADn.flt
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m  Arbfilt3 = sdlaTp2BDp.flt
m  Arbfilt4 = sdlaTp2BDn.flt
6. Define Math waveforms:
®=  Math2 = Arbfiltl (Ch4) + Arbfilt2 (Ch3)
®=  Math3 = ArbFilt3 (Ch4) + Arbfilt4 (Ch3)

= Save Math4 = Math 3 — Math2 as 1-7 TMDS Data Eye
Diagram_Data.wfm

7. Clear all Maths and filter file definitions.
Recall 1-7 TMDS Data Eye Diagram Clock.wfm on Refl
9. Recall 1-7 TMDS Data Eye Diagram Data.wfm on Ref2
10. Load arbfilt] = HDMI2 EQ 50G-flt
Mathl = arbfiltl(Refl)
Math2 = arbfilt](Ref2).
11. Perform DPOJET ->Auto Fit Mask Hits with below settings:
m  Clock Recovery => Method: Explicit Clock — PLL,
m  Clock Source: Math1
m  Clock Edge: Rise
m  Clock Multiplier: 40
= PLL Model: Type I
m  Damping: 700 m
= Loop BW:4 MHz
m  Mask File = Data Rate_5.92 Gbps.msk
m  Clock offset = Auto
= BitType = All
m  Plot = Eye Diagram
12. Perform DPOJET ->Eye width measurements with below settings:
m  Clock Recovery == Method: Explicit Clock — PLL,
m  Clock Source: Math1
m  Clock Edge: Rise
m  Clock Multiplier: 40
= PLL Model: Type ]
= Damping: 700 m
= Loop BW:4 MHz
m  Clock offset = Auto
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HDM Data Eye Diagram
Test - Mask Movement

= Bit Type = All
m  Measurement setting ->Cursor gating ON

13. Enable the measurement with vertical cursors on at 5% and 95% of the scope
acquisition. Perform the above measurement on Data 1 and Data 2 by
repeating the steps from (2) to (13). Repeat the test for remaining supported
test character rates. Only one video format/pixel-size combination is required
per TMDS character rate.

TP2 mask

Table 19: Mask coordinates at different data rates

TMDS Bit Rate (Gbps) H (Tbit) V (mv)
3.71 0.6 335
4.46 0.56 295
5.94 0.4 150

When performing the HDM Data Eye Diagram test (Source), if the test fails due
to mask hits, you are presented with a dialog box to enter a timing value that will
be used to shift the Mask horizontally, thus allowing the test to pass. You will
have up to three opportunities to adjust the mask position. If, after three attempts,
the test still fails due to any mask hits, the test will stop and report the test as
failed. The first message you see when the Eye Diagram test fails due to mask
hits provides a short description of what you need to adjust the mask position.

After you select OK, the Measure the Deskew Value dialog box displays. Once
you determine the amount of time (in picoseconds) to shift the mask horizontally,
enter the value here.

Measure the Deskew Value
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HF1- 4 - Source TMDS Electrical - 6G - Intra-Pair Skew

This test confirms that the skew between the positive and negative lane of the
TMDS single ended signals complies with the limits mentioned in specification.

Required test equipment  In addition to the DUT, you will need the following:

m Digital Storage oscilloscope: DPO/DSA/MSO series oscilloscope with BW
greater than or equal to 16 GHz

®  Four Differential probes — P7313SMA, for single ended and differential tests)
m  Test fixture: TF-HDM-TPA-S fixture for Source to be used for source testing

= Power supply: PWS4205 or PWS2185 (if using external power supply
option)

Connect the equipment as shown in the Source single ended diagram.

Set the DUT to operate in normal mode.
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Single ended measurement

Power supply *

Ry~
\ ] Q%CLOCK_P

.TH%EDID emulator / EDID PCB

D2 DATA2_P
DATA2_N

Second row of
connectors below

CLK CLOCK_P
CLOCK_N

Notes:

Connect to Biased 502 Termination of all unoccupied lanes.

*
Scope has the capability to support the probe termination vollage. -
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Single ended measurement

J
6 [Egee]  wHE
Tk ] ' Elm ; é:
640
AT
Power supply * 1
DD K@J/\\CLOCK p
HHH‘H EDID emulator / EDID PCB
D2 DATA2_ P N M
DATA2N TN/
buT
i
:‘i\@gﬁ
Second row of
connectors below wl /;@
! CLK CLOCK_P
L
CLOCK_N

Notes:

Connect to Biased 50Q2 Termination of all unoccupied lanes.

Scope has the capability to support the probe termination voltage. 0926-062
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Measurement algorithm  TekExpress HDM automatically executes the following described calculations
described:

The algorithm calculates the skew within any Differential pair in the TMDS
portion as per below steps. Intra-pair skew test is a single-ended measurement.

1.

2
3.
4

10.

Capture DO+, DO- single-ended signals.
Calculate the mean voltage of the TMDS positive signal under test.
Calculate the mean voltage of the TMDS negative signal under test.

Measure the time skew of 10,000 or more time differences taken between
rising edges of the positive signal under test and corresponding falling edges
of the TMDS negative signal under test.

The time measurement used for each rising edge on the positive signal shall
be the time when the edge crosses mean voltage of the TMDS positive

The time measurement used for each falling edge on the positive signal shall
be the time when the edge crosses mean voltage of the TMDS negative.

Calculate the time differences for at least 10,000 edge pairs.
Compute the mean skew of the time difference values.
If (-0.15*Ty,;; ) < mean skew< (0.15*Ty;,), then PASS.

Repeat the test for all of the remaining untested TMDS DATA and CLK
differential pairs.

HF1- 5 - Source TMDS Electrical - 6G - Differential Voltage

This test confirms that the voltage level of the TMDS differential signals
complies with the limits in the specification.

Required test equipment  In addition to the DUT, you will need the following:

Digital Storage oscilloscope: DPO/DSA/MSO series oscilloscope with BW
greater than or equal to 16 GHz

Four Differential probes — P7313SMA, for single ended and differential tests
Test fixture: TF-HDM-TPA-S fixture for Source to be used for source testing

Power supply: PWS4205 or PWS2185 (if using external power supply
option)

Connect the equipment as shown in the Source differential diagram.
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Differential measurement

Power supply *
03.30 N
P 2

(ele

] S ' L

L6 CLOCKN

\E\CLOCK_P

\"-P“” = DATAO_P
o Do I
DATAO_N

CLK CLOCK_P

T

7

Notes:

Connect to Biased 5002 Termination of all unoccupied lanes.

*Scupe has the capability to support the probe termination voltage.

Set the DUT to operate in normal mode.
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Differential measurement

[Fmron

Power supply *

] CLOCK_;
W EDID emulator / EDID PCB

Ragy
- |
|
\

Second row of

connectors below |,
\ CLK CLOCK_P
- CLOCK_N

Notes:

Connect to TF-HDMI-T termination fixture

*Scope has the capability to support the probe termination voltage. 0626:080
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Measurement algorithm

150

The algorithm calculates the Differential voltage on Differential TMDS lanes
clock, DO, D1, D2 as per following steps:

Given a waveform, find the Maximum Differential Voltage and Minimum
Differential Voltage.

Measure the Minimum Differential voltage:

1.

Capture 1000 or more repetitions, triggered at the vertical mid-point of the
High-to-Low transition of a H-L-L-L bit sequence. Each capture must be of
duration 3 times TBIT.

Display the voltage (vertical) histogram on the scope, with the histogram data
accumulated only from the last 2-bits of the H-L-L-L sequence.

Read the Minimum Differential Voltage value as the most common low-level
(mode) voltage shown on the histogram.

Measure the Maximum Differential voltage:

1.

Capture 1000 or more repetitions, triggered at the vertical mid-point of the
High-to-Low transition of a L-H-H-H bit sequence. Each capture must be of
duration 3 times TBIT.

Display the voltage (vertical) histogram on the scope, with the histogram data
accumulated only from the last 2-bits of the L-H-H-H sequence.

Read the Maximum Differential Voltage value as the most common low-
level (mode) voltage shown on the histogram.
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Test ID 8-5 TMDS Min-max differential swing tolerance

This HDMI Receiver test confirms that The sink DUT supports the maximum
allowed clock jitter on TMDS signal.

Required Test Equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

HDMI signal generator: Two AWG70002A instruments with options 01,
03 and 225 with direct synthesis capability to simulate cable emulator effect
and rise time filter effect.

Eight SMA cables

Rise time filter: Eight 120 ps TTC filters (PSPL5915)

Test fixture: A set of ET-HDM-TPA-S or TF-HDMIE-TPA-KIT fixtures
DC Power Supply

Bias Tees: Eight bias tees from Mini-Circuits — ZX85-12G-S+
Audio/Video display

Measurement algorithm  The following procedure is fully automated by Tektronix HDM Compliance
Software (Option HT3-DS ):

1.

Connect the equipment as shown in Sink min differential swing tolerance
diagram for AWG70002A and Sink max differential swing tolerance diagram
for AWG70002A .
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AFG w ExtRefIn

10 MHz Ref
AWGT0002 Out Master)

AWGT0002 w
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CLK ( - = | Y Marker
: D2 output
YYY) b5p 00" YYY
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J . | o=
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Power supply
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HDMI Connector

Sink DUT
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AWGT70002A

AFG w ExtRef In

[5

10 MHz Ref
Qut (Master)

| AWG70002A (Slave) w

Trig In A l

120ps TTC Fi\teréa-‘
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o

HDMI Connector

Sink DUT

st

Calibrate the HDM Signal Generator AWG70K output for these settings:

Frequency: Highest frequency supported by the Sink DUT

Pattern: HDMI Gray Ramp data streams

Set the common mode voltage (VICM) as the following:

2.9V- if the Sink supports TMDS clock rates > 165MHz

3.0V -if the Sink supports only TMDS clock rates <= 165MHz

Set the differential swing voltage to 170 mV. Search the min supported
differential swing. If this value is greater than or equal to 150mV then
FAIL, 'Min diff swing unsupported at Vicm1 range'

153



HDM Sink Electrical tests for CTS version 1.4

= Set the swing to 170mV and set the Vicm to 3.3V. Search the min
supported differential swing. If this value is greater than or equal to
150mV then FAIL, 'Min diff swing unsupported at Vicm2 range'

m  Change the differential swing to 1.2V (Viem =3.3V) and if the DUT does
not support this voltage then FAIL, 'Max diff swing unsupported at
Viem?2 range'

Test ID 8-6 TMDS Intra-pair skew test

This HDMI Receiver test confirms that Sink DUT supports the maximum
allowed timing skew within each TMDS pair.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

= HDMI signal generator: Two AWG70002A instruments with options 01,
03 and 225, or two AWG7122C instruments with options 1, 2/6, 8, with
direct synthesis capability to simulate cable emulator effect and rise time
filter effect.

=  Eight SMA cables

m  Test fixture: A set of TF-HDM-TPA-S fixtures

= DC Power Supply

m Bias Tees: Eight bias tees from Mini-Circuits — ZX85-12G-S+
®  Audio/Video display

= Eight 6400 MHz filters are needed

Measurement algorithm  The following procedure is fully automated by Tektronix HDM Compliance
Software (Option HT3-DS):

1. Connect the equipment as shown in the Sink Intra-pair skew diagram for
AWG70002A for single lane and Sink Intra-pair skew diagram for
AWG70002A for all lanes.

NOTE. Based on the Lane you are testing, do these connection changes

m  Clock: Connect CLOCK N from Slave AWG CHI1-Marker 1 -ve channel
m  DO: Connect DATAO_N from Slave AWG CHI-Marker 2 -ve channel

m  DI: Connect DATAI N from Slave AWG CH2-Marker I -ve channel

m  D2: Connect DATA2 N from Slave AWG CH2-Marker 2 -ve channel
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AFG w ExtRef In

Trigin A J\
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AWG70002A | Out (Master)

AWGT70002A (Slave) w
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o ; Marker
oufput
Analog
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6.4 GHz Filter 6.4 GHz Filter
Bias Bias
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1_‘
HDMI Connector
Sink DUT
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Figure 1: Sink Intra-pair skew diagram for AWG70002A for single lane
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AFG WExt Ref In

10 MHz Ref

AWGT0002A | Out (Master)
i y of [@ & L L Ext

‘ = 79 Clock In
_ [o & o TrigIn A TrighA_J
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== 1‘* Py . o o || Marker
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6.4 GHz Filter U — %-%%
¢ o Bias -
H voltage ‘ O | Power supply voltage H
(L o J) U

N %2010
d oviva

HDMI Connector

Sink DUT

w60

Figure 2: Sink Intra-pair skew diagram for AWG70002A for all lanes

2. Calibrate the HDM Signal Generator AWG7K/70K output for the following
settings:

= Frequency: High frequency supported by the Sink DUT
= Pattern: HDMI Gray Ramp data streams
m Set VICM to 3.05 V.
m  Set Single Ended Swing to 500 mV.
m  Rise/Fall time should be between 75pS and 110pS.
3. Do the following for each TMDS differential pair Clock and Data:

Configure the Signal generator to add skew between + and -signal fo the
tested pair.
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4.
5.

Increase the skew by steps of less than or equal to 0.1*Tbit, until the Sink
DUT outputs errors or until reaching 0.6*Tbit or 1nSec.

If the DUT errors
Reduce the skew one step, so that the DUT outputs no errors
If the TMDS clock frequency is <=222.75 MHz
m  If the skew <0.4*Tbit, then FAIL
c. If TMDS clock frequency > 222.75 MHz
m  If skew <112psec+0.15.*TBit, then FAIL
Repeat the test but add the skew in the opposite direction.

Repeat the test for untested pairs.

Test ID 8-7 TMDS Jitter tolerance test

This HDMI Receiver test confirms that the maximum allowed clock jitter on
TMDS signal is supported by the Sink DUT.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

HDMI signal generator: Two AWG70002A instruments with options 01,
03 and 225, with direct synthesis capability to simulate cable emulator effect
and rise time filter effect.

Eight SMA cables

Rise time filter: Eight 120 ps TTC filters (PSPL5915)

Test Fixture: A set of ET-HDM-TPA-S or TF-HDMIE-TPA-KIT fixtures
DC Power Supply

Bias Tees: Eight bias tees from Mini-Circuits — ZX85-12G-S+

Audio/ Video display

Measurement algorithm  The following procedure is fully automated by Tektronix HDM Compliance
Software (Option HT3-DS ):
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1. Connect the equipment as shown in the Sink Jitter tolerance diagram for
AWGT70002A.

NOTE. Rise time filters are not required for testing 297MHz patterns

-~

|
|
10 MHz Ref I

AFG erxff RefIn

AWGT0002 Out (Master)

AWGT0002 w

1=

D1
YYY
120ps TTC Filter U ‘ ‘ © /eaaog 120ps TTC Filier‘ } H ‘
e sea) B BYEE
by =) lll: _ﬁﬂ'i‘\t[:‘
YYYY DPO/DSAMSO 70000 Series
Bias =i
1] woige | | | |
]
Power supply
\\_ J/
|
-
JHEEEEEE
ololdlza|=alzml2a=
le:glgljj\?ilg!a
slz||=z|7|=z|m]|=

111 QdH
7 QdH
=

[
[
]
-

HDMI Connector

Sink DUT

sz

2. The Application generates the pattern with these settings.

m  Frequency: Highest frequency supported by the Sink DUT

m Pattern: HDMI Gray Ramp data streams
= VCIMissetto3.1V.
m Single Ended Swing of each TMDS signal is set to 400 mV.

m  Below are the jitter frequencies inserted on the signal:
D _JITTER=500 kHz (on TMDS_CLOCK), C JITTER=10 MHz.
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D JITTER=1 MHz (on TMDS_CLOCK), C_JITTER=7 MHz.

NOTE. All jitter amounts described below are relative to a recovered
clock as measured with a Clock Recovery Unit). All four jitter
frequencies define sinusoidal jitter). [Make TP2 worst condition]

m  Selected cable emulator is applied
m TP2 signal is generated and the jitter amplitude us adjusted as follows:

C _JITTER to be 0.3*Tbit at TP2 after processing with the CRU and
applying the Reference Cable Equalizer.

3. Connect the TMDS Signal Generator to the Sink DUT and follow the on
screen instructions to complete the test.
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Test ID 8-15 Character synchronization test

This test confirms that sink establishes synchronization with the data when it
receives only minimum length control periods.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

= HDMI signal generator: Two AWG70002A instruments with options 01,
03 and 225, with direct synthesis capability to simulate cable emulator effect
and rise time filter effect.

m  Fight SMA cables

m  Rise time filter: Eight 120 ps TTC filters (PSPL5915)

m  Test fixture: HDMI 1.4B Type A fixtures

= DC Power Supply

m  Bias Tees: Eight bias tees from Mini-Circuits — ZX85-12G-S+
= Audio/ Video display

Measurement algorithm  The following procedure is fully automated by TekExpress HDM software:

1. Connect the equipment as shown in the Sink Protocol diagram for
AWGT70002A.
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2. Start the transmission of valid 640X480p video frame with every horizontal
and vertical blanking interval completely filled with one or more Data island
periods and all Control periods either 12 or 13 characters in length.

3. Ifthe sink DUT does not support the transmitted signal then FAIL.
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Test ID 8-16 Acceptance of all valid packet types test

This test confirms the reception of all valid packet types.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

= HDMI signal generator: Two AWG70002A instruments with options 01,
03 and 225, with direct synthesis capability to simulate cable emulator effect
and rise time filter effect.

m  Rise time filter: Eight 120 ps TTC filters (PSPL5915)

m  Test Fixture: HDMI 1.4B Type A fixtures

= DC Power Supply

m  Bias Tees: Eight bias tees from Mini-Circuits — ZX85-12G-S+
®  Audio/ Video display

Measurement algorithm  The following procedure is fully automated by TekExpress HDM software:

1. Connect the equipment as shown in the Sink Protocol diagram for
AWGT70002A.
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Start the transmission of valid 720X480p (if Sink 60Hz ="Y") or 720X576p

(if Sink_60Hz="N", 2 channel 48 KHz audio HDMI signal with following
characteristics.

m  Duringthe VBLANK, one or more Data Islands contain a valid

Null Packet (0x03)

General Control Packet (0x03)

m  with Set AVMUTE and Clear AVMUTE clear (0).
Vendor-specific InfoFrame Packet (0x81)

m  with a length of 3 and a 24-bit IEEE registration identifier
belonging to the HDMI Licensing, LLC (0x000C03)

AVI InfoFrame Packet (0x82)
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3.

= Source Product Description Packet (0x83)

®m  Audio InfoFrame Packet (0x84)

m  MPEG Source InfoFrame Packet (0x85)
= Ifthe sink DUT does not adequately suport the signal then FAIL.
= Ifthe CDF filed Sink Supports Alis Y:

m  Configure protocol generator to also transmit, during VBLANK, one
or more Data Islands containing a valid

= ACP Packet (0x04)
m ISRCI Packet (0x05)
m ISRC2 Packet (0x06)
m Ifthe sink DUT does not adequately support the signal then FAIL
m Ifthe CDF field Sink xvYCCis Y:

m  Configure protocol generator to also transmit valid xvY CC-encoded
video and, during VBLANK, one or more Data Islands containing a
valid

®  Gamut Metadata Packet (0x0A) with PO transmission profile
If the sink DUT does not support the transmitted signal then FAIL.

Test ID 8-19 Pixel encoding requirements test

This test confirms that Sink supports YCgCp pixel encoding when required.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

HDMI signal generator: Two AWG70002A instruments with options 01,
03 and 225, with direct synthesis capability to simulate cable emulator effect
and rise time filter effect.

Rise time filter: Eight 120 ps TTC filters (PSPL5915)

Test Fixture: HDMI 1.4B Type A fixture

DC Power Supply

Bias Tees: Eight bias tees from Mini-Circuits — ZX85-12G-S+
Audio/ Video display

Measurement algorithm  The following procedure is fully automated by the TekExpress HDM Software:

1.

Connect the equipment as shown in the Sink Protocol diagram for
AWGT70002A.
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2. Check if the Sink supports either YCgCpg 4:2:2 or YCgCp 4:4:4 then both
should be supported.

m  Check bits #4 and #5 of byte #3 of the CEA EDID Timing Extension.
[861-D: Table 27]

m Ifbit# 4 ==1 and bit #5 ==1 then FAIL
m Ifbit # 4 ==0 and bit #5 ==1 then FAIL

3. All HDMI Sinks shall be capable of supporting both the YCgCpg 4:4:4 and
YCgCk 4:2:2 pixel encoding when that device is capable of supporting a
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color-difference color space from any other component analog or digital
video input.

m Ifthe CDF field Sink YUV _On_Other =="Y":
m  Check bits #4 and #5 of byte #3 of the EDID Timing Extension
m Ifeither bit is clear (0) then FAIL

4. All HDMI sink should support RGB 4:4:4 pixel encoding. Transmit
720X480p (if Sink 60Hz =Y”") or 720X576p (if Sink 60Hz ="N”’) Video
signal with RGB signal encoding to sink DUT.

m Ifthe sink DUT does not adequately support the transmitted signal then
FAIL.

5. All HDMI sink should support RGB 4:4:4 pixel encoding. Transmit
720X480p (if Sink 60Hz ="Y") or 720X576p (if Sink_60Hz ="N”’) Video
signal with YCgCR 4:2:2 signal encoding to sink DUT.

m  Ifthe sink DUT does not adequately support the transmitted signal then
FAIL.

6. All the HDMI sink should support RGB 4:4:4 pixel encoding. Transmit
720X480p (if Sink 60Hz ="Y’) or 720X576p (if Sink_60Hz ="N”’) Video
signal with YCgCp 4:4:4 signal encoding to sink DUT.

m Ifthe sink DUT does not adequately support the transmitted signal then
FAIL.

Test ID 8-20 Video format timing test

This test confirms that Sink supports the required variations on mandatory video
formats and CEA video formats indicated in EDID.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

= HDMI signal generator: Two AWG70002A instruments with options 01,
03 and 225, with direct synthesis capability to simulate cable emulator effect
and rise time filter effect.

m  Rise time rilter: Eight 120 ps TTC filters (PSPL5915)

m  Test fixture: HDMI 1.4B Type A fixture

= DC Power Supply

m  Bias Tees: Eight bias tees from Mini-Circuits — ZX85-12G-S+
®m  Audio/ Video display
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Measurement algorithm  The following procedure is fully automated by the TekExpress HDM Software:

1. Connect the equipment as shown in the Sink Protocol diagram for
AWG70002A.
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Sink DUT

2. Perform the following test for each of the video formats listed in the EDID.
This test should be performed at two different frequencies, the minimum and
maximum permitted for a source. These values are minimum (frame rate
-0.5%) and Maximum (frame rate +0.5%).

3. Verify the Sink DUT supports 640X480p.

= Configure the TMDS Signal Generator to transmit 640x480p @ 60 Hz to
the Sink DUT at the minimum allowable pixel clock frequency.

= Ifthe Sink DUT does not adequately support format then FAIL,
"640x480p, Min".
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= Configure TMDS Signal Generator to transmit 640x480p @ 60 Hz to
Sink DUT at the maximum allowable pixel clock frequency.

= Ifthe Sink DUT does not adequately support format then FAIL,
"640x480p, Max".

Transmit each of the video formats supported by EDID and perform the steps
below.

Configure TMDS generator to transmit selected video format at the minimum
allowable clock frequency.

If the sink DUT does not adequately support then FAIL.

Configure TMDS generator to transmit selected video format at the
maximum allowable clock frequency.

If the sink DUT does not adequately support then FAIL.

Test ID 8-21 Audio clock regeneration test

This test confirms that proper sink operation with respect to Audio Clock
Regeneration.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

HDMI signal generator: Two AWG70002A instruments with options 01,
03 and 225, with direct synthesis capability to simulate cable emulator effect
and rise time filter effect.

Rise time filter: Eight 120 ps TTC filters (PSPL5915)

Test fixture: HDMI 1.4B Type A fixturs

DC Power Supply

Bias Tees: Eight bias tees from Mini-Circuits — ZX85-12G-S+
Audio/ Video display

Measurement algorithm  The following procedure is fully automated by the TekExpress HDM Software:

1.

Connect the equipment as shown in the Sink Protocol diagram for
AWGT70002A.
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2. Ifthe CDF field Sink Basic_Audio =="N” then

= Examine the DUT for any other analog or digital audio input (e.g. analog
RCA jacks,S/PDIF, etc).

m Ifany other audio input is present on DUT, then FAIL
= Else, PASS (end test)

3. Configure the TMDS protocol generate to transmit 480p video format with a
48 kHz audio sample rate and ACR packets with maximum N parameter with
minimum integer value not less than 128*Fs/1500 and audio sample data
with audio tone frequency of 1 khz with amplitude -20dB.

4. Perform the listening test.

If no sound, extraneous sound or unnecessary mute then FAIL.
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6. Configure TMDS protocol generate to transmit 480p video format with a
48 kHz audio sample rate and ACR packets with maximum N parameter
which maximum integer value no more than 128*Fs/300 and audio sample
data with audio tone frequency of 1khz with amplitude -20dB.

Perform thelistening test.

If no sound, extraneous sound or unnecessary mute then FAIL.

Test ID 8-22 Audio sample packet jitter test

This test confirms that Sink supports Audio sample packets with minimum jitter.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

= HDMI signal generator: Two AWG70002A instruments with options 01,
03 and 225, with direct synthesis capability to simulate cable emulator effect
and rise time filter effect.

®  Rise time filter: Eight 120 ps TTC filters (PSPL5915)

m  Test Fixture: HDMI 1.4B Type A fixture

= DC Power Supply

m Bias Tees: Eight bias tees from Mini-Circuits — ZX85-12G-S+
= Audio/ Video display

Measurement algorithm  The following procedure is fully automated by TekExpress HDM Software:

1. Connect the equipment as shown in the Sink Protocol diagram for
AWGT70002A.
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2. If CDF field Sink Basic_Audio =="N” then PASS.
3. Transmit the HDMI audio/video stream containing the following:

m  FEither 480p, 576p, or VGA (640x480p @ 60 Hz) with a 48 kHz audio
sample rate.

m  ACR packets contain the recommended N and CTS values per [HDMI:
7.2.3].

®  Audio Sample packet transmission timing has jitter of one horizontal
video (total) line time plus the period of 1 audio sample (i.e. 1/Fs).

4. Perform the listening test.

If no sound, extraneous sound or unnecessary mute then FAIL.
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Test ID 8-23 Audio formats test

This test confirms that Sink supports every audio packet specified in EDID.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

= HDMI signal generator: Two AWG70002A instruments with options 01,
03 and 225, with direct synthesis capability to simulate cable emulator effect
and rise time filter effect.

m  Rise time filter: Eight 120 ps TTC filters (PSPL5915)

m  Test Fixture: HDMI 1.4B Type A fixture

= DC Power Supply

m  Bias Tees: Eight bias tees from Mini-Circuits — ZX85-12G-S+
®  Audio/ Video display

Measurement algorithm  The following procedure is fully automated by TekExpress HDM Software:

1. Connect the equipment as shown in the Sink Protocol diagram for
AWGT70002A.
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2. [Ifthe CDF field Sink Basic_Audio =="N” then PASS.

3. Transmit the HDMI signal with any DUT supported video format and 2-
channel 32 kHz PCM signal to sink DUT.

4. Ifthe Sink DUT does not adequately support audio format then FAIL.

5. Transmit the HDMI signal with any DUT supported video format and 2-
channel 44.1 kHz PCM signal to sink DUT

If the Sink DUT does not adequately support audio format then FAIL.

Transmit the HDMI signal with any DUT supported video format and 2-
channel 48 kHz PCM signal to sink DUT.

8. [Ifthe Sink DUT does not adequately support audio format then FAIL.
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Test ID 8-24 Interoperability with DVI test

This test confirms that Sink DUT handles required transmission from DVI to
HDMI mode.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

HDMI signal generator: Two AWG70002A instruments with options 01,
03 and 225, with direct synthesis capability to simulate cable emulator effect
and rise time filter effect.

Rise time filter: Eight 120 ps TTC filters (PSPL5915)

Test Fixture: HDMI 1.4B Type A fixture

DC Power Supply

Bias Tees: Eight bias tees from Mini-Circuits — ZX85-12G-S+
Audio/ Video display

Measurement algorithm  The following procedure is fully automated by TekExpress HDM Software:

1.

Connect the equipment as shown in the Sink Protocol diagram for

AWG70002A.
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2. Transmit the 720X480p (if Sink 60 Hz ="Y"") or 720X576p (if Sink 60 Hz
="N""), RGB pixel encoding, no guard bands, no Data Islands.

Turn on the Sink DUT and verify that the HDMI port is active.

Verify that the Sink DUT supports signal with correct pixel encoding and no
audio.

5. [If the Sink does not adequately support signal then FAIL.
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Test ID 8-25 Deep color test

This test confirms that a Deep color-capable sink DUT supports deep color
packing and signaling.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

HDMI signal generator: Two AWG70002A instruments with options 01,
03 and 225, with direct synthesis capability to simulate cable emulator effect
and rise time filter effect.

Rise time filter: Eight 120 ps TTC filters (PSPL5915)

Test Fixture: HDMI 1.4B Type A fixture

DC Power Supply

Bias Tees: Eight bias tees from Mini-Circuits — ZX85-12G-S+
Audio/ Video display

Measurement algorithm  The following procedure is fully automated by TekExpress HDM Software:

1.

Connect the equipment as shown in the Sink Protocol diagram for

AWG70002A.
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2. Ifthe CDF field Sink Deep Color =="N” then Skip.
If the CDF field Sink Max_ TMDS_CLOCKk if Zero then FAIL.

4. For each video formats indicated in the CDF filed Sink Video Formats
m Ifthe CDF field Sink DC 36 bit is “N” then FAIL, else

= Output 36 bit depth video format and RGB pixel encoding from
TMDS signal generator.

m Ifthe sink DUT does not adequately support format then FAIL.

m Ifthe CDF filed Sink DC Y444 is “Y” then Output 36 bit depth
video format and YCgCrr 4:4:4 pixel encoding from TMDS signal
generator.
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Test ID 8-28 One bit audio test

If the sink DUT does not adequately support format then FAIL.

m Ifthe CDF field Sink DC_30 bit is “N” then FAIL, else

Output the 30 bit depth video format and RGB pixel encoding from
TMDS signal generator.

If the sink DUT does not adequately support format then FAIL.

If the CDF filed Sink DC_Y444 is “Y” then Output 30 bit depth
video format and YCgCp 4:4:4 pixel encoding from TMDS signal
generator.

If the sink DUT does not adequately support format then FAIL.

m Ifthe CDF field Sink DC 48bit is “N” then FAIL, else

Output the 48bit depth video format and RGB pixel encoding from
TMDS signal generator.

If the sink DUT does not adequately support format then FAIL.

If the CDF filed Sink DC_Y444 is “Y” then Output 48 bit depth
video format and YCgCp 4:4:4 pixel encoding from TMDS signal
generator.

If the sink DUT does not adequately support format then FAIL.

This test confirms that a One bit audio-capable sink supports One bit audio
sample packets and signaling.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

HDMI signal generator: Two AWG70002A instruments with options 01,

03 and 225, with direct synthesis capability to simulate cable emulator effect
and rise time filter effect.

Rise time filter: Eight 120 ps TTC filters (PSPL5915)

Test fixture: HDMI 1.4B Type A fixture

DC Power Supply

Bias Tees: Eight bias tees from Mini-Circuits — ZX85-12G-S+
Audio/ Video display
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Measurement algorithm  The following procedure is fully automated by the TekExpress HDM Software:

1. Connect the equipment as shown in the Sink Protocol diagram for
AWG70002A.
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2. Transmit the HDMI Signal with 480p or 576p with 2X pixel repetition
(1140X480p or 1140X576p) video format or DUT-supported video format,
and a Bit Audio Sample packet to Sink DUT.

Perform teh listening test.

4. Ifno sound, extraneous sound or unnecessary mute then FAIL.
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Test ID 8-29 3D video format timing test

This test confirms that a 3D-Capable Sink DUT supports required variation on
mandatory 3D video formats and other primary formats listed in the EDID.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

HDMI signal generator: Two AWG70002A instruments with options 01,
03 and 225, with direct synthesis capability to simulate cable emulator effect
and rise time filter effect.

Rise time filter: Eight 120 ps TTC filters (PSPL5915)

Test fixture: HDMI 1.4B Type A fixture

DC Power Supply

Bias Tees: Eight bias tees from Mini-Circuits — ZX85-12G-S+
Audio/ Video display

Measurement algorithm  The following procedure is fully automated by the TekExpress HDM Software:

1.

Connect the equipment as shown in the Sink Protocol diagram for

AWG70002A.
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2. Perform the following test for each of the video formats listed in the EDID.
This test should performed at two different frequencies, minimum and
maximum permitted for a source. These values are minimum (frame rate
-0.5%) and maximum (frame rate +0.5%).

3. Transmit each of the video formats supported by EDID and perform the
below steps:

4. Configure the TMDS generator to transmit selected video format at the
minimum allowable clock frequency.

If the sink DUT does not adequately support then FAIL.

6. Configure the TMDS generator to transmit selected video format at the
maximum allowable clock frequency.

7. If the sink DUT does not adequately support then FAIL.

182 TekExpress HDM Advanced Analysis and Compliance Solution



HDM - Sink Protocol tests for 1.4

Test ID 8-30 4Kx2K video format timing test

This test confirms that a 4K-2K Sink DUT supports 4K2K video formats and
other primary formats listed in the EDID.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

HDMI signal generator: Two AWG70002A instruments with options 01,
03 and 225, with direct synthesis capability to simulate cable emulator effect
and rise time filter effect.

Rise time filter: Eight 120 ps TTC filters (PSPL5915)

Test fixture: HDMI 1.4B Type A fixture

DC Power Supply

Bias Tees: Eight bias tees from Mini-Circuits — ZX85-12G-S+
Audio/ Video display

Measurement algorithm  The following procedure is fully automated by the TekExpress HDM Software:

1.

Connect the equipment as shown in the Sink Protocol diagram for

AWG70002A.
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2. Perform the following test for each of the video formats listed in the EDID.
This test should performed at two different frequencies, minimum and
maximum permitted for a source. These values are minimum (frame rate
-0.5%) and Maximum (frame rate +0.5%).

3. Transmit each of the video formats supported by the HDMI_VIC X in the
EDID and perform the below steps :

4. Configure the TMDS generator to transmit selected video format at the
minimum allowable clock frequency.

If the sink DUT does not adequately support then FAIL.

6. Configure the TMDS generator to transmit selected video format at the
maximum allowable clock frequency.

7. If the sink DUT does not adequately support then FAIL.
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Test ID 8-31 Extended colors and contents test

This test confirms that Sink supports reception of particular AVI info frame
packets supporting Extended Colorimetry, Content Type and Selectable YCC
Quantization Range Settings, and the sink displays the image with significant
distortions.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

HDMI signal generator: Two AWG70002A instruments with options 01,
03 and 225, with direct synthesis capability to simulate cable emulator effect
and rise time filter effect.

Rise time filter: Eight 120 ps TTC filters (PSPL5915)

Test fixture: HDMI 1.4B Type A fixture

DC Power Supply

Bias Tees: Eight bias tees from Mini-Circuits — ZX85-12G-S+
Audio/ Video display

Measurement algorithm  The following procedure is fully automated by the TekExpress HDM Software:

1.

Connect the equipment as shown in the Sink Protocol diagram for

AWG70002A .
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2. Configure the TMDS signal generator to Transmit 720X480p (if Sink 60 Hz
="Y") or 720X576p (if Sink_60 Hz ="N").

3. Ifbit #3 of byte#3 the Colorimetry Data Block in the EDID of Sink DUT is
set to one.

m  Configurethe TMDS generator to transmit video signal with following
AVI Info Frame which has sYCC601 =1.

m If Sink DUT does not adequately support the signal then FAIL.

4. Ifbit #4 of byte#3 the Colorimetry Data Block in the EDID of Sink DUT is
set to one.

m  Configure the TMDS generator to transmit video signal with following
AVI Info Frame which has AdobeYCC601 =1.

m If Sink DUT does not adequately support the signal then FAIL.
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5. Ifbit #5 of byte#3 the Colorimetry Data Block in the EDID of Sink DUT is
set to one.

m  Configure the TMDS generator to transmit video signal with following
AVI Info Frame which has AdobeRGB =1.

m Ifthe Sink DUT does not adequately support the signal then FAIL.

6. If bit #7 of byte#3 the Colorimetry Data Block in the EDID of Sink DUT is
set to one.

m  Configure the TMDS generator to transmit video signal with following
AVI Info Frame which has YQ1,YQO = 0,1 (Full range).

m Ifthe Sink DUT does not adequately support the signal then FAIL.

7. If bit #0 of byte#8 the Colorimetry Data Block in the EDID of Sink DUT is
set to one.

= Configure the TMDS generator to transmit video signal with following
AVI Info Frame which has ITC=1 and CNO, CN1 = 0, 0 (Graphics).

m Ifthe Sink DUT does not adequately support the signal then FAIL.

8. Ifbit #1 of byte#8 the Colorimetry Data Block in the EDID of Sink DUT is
set to one.

m  Configure the TMDS generator to transmit video signal with following
AVI Info Frame which CNO, CN1 =0, 1 (Photo).

m Ifthe Sink DUT does not adequately support the signal then FAIL.

9. IfDbit #2 of byte#8 the Colorimetry Data Block in the EDID of Sink DUT is
set to one.

= Configure the TMDS generator to transmit video signal with following
AVI Info Frame which CNO, CN1 =1, 0 (Cinema).

m Ifthe Sink DUT does not adequately support the signal then FAIL.

10. If bit #3 of byte#8 the Colorimetry Data Block in the EDID of Sink DUT is
set to one.

= Configure the TMDS generator to transmit video signal with following
AVI Info Frame which CNO, CN1 =1, 1 (Game).

= Ifthe Sink DUT does not adequately support the signal then FAIL.
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NOTE. In single stack 2 channel oscilloscopes, select the appropriate channel
configurations in TekExpress HDM software: DPO7230258X, DPO73302SX,
DPO75002SX, DPO75902SX, and DPO77002SX.

HF2-1 Min-max Differential Swing Tolerance

This HDMI Receiver test confirms that the Sink properly supports TMDS
differential voltages at minimum and maximum levels.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

= HDMI signal generator: Two AWG70002A with options 01, 03 and 225, or
two AWG7122C with options 1, 2/6, 8, and Option SDX with direct
synthesis capability to simulate cable emulator effect and rise time filter
effect.

m  Rise time filter: Two 120 ps TTC filters (PSPL5915)

m  Test fixture: A set of TF-HDM-TPA-S fixtures

= DC Power Supply

m  Bias Tees: Eight bias tees from Mini-Circuits — ZX85-12G-S+
®  Audio/Video display

Measurement algorithm  The following procedure is fully automated by Tektronix HDM Compliance
Software (Option HDM-DS):

1. Connect the equipment as shown in the Sink Min diagram for AWG7122C or
Sink Min diagram for AWG70002A.
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Sink Min diagram for AWG7122C
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Sink Min diagram for AWG70002A
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2. Calibrate the HDM Signal Generator AWG7K/70K output for the following
settings.

a. Frequency: Highest frequency supported by the Sink DUT

b. Pattern: HDMI Gray Ramp data streams

c. Rise/fall times:
Set the rise/fall time of the TMDS CLOCK to between 75 ps and 110 ps.
Set the rise/fall time of the TMDS DATA between 42.5 ps and 65 ps.

d. Set the common mode voltage (VICM) to 3.1 V.

e. Set the differential swing voltage to 150 mV. Confirm the Sink DUT
support. If the Sink DUT does not support the transmitted resolution,
then FAIL: “Min diff swing unsupported at VICM1 range”.

TekExpress HDM Advanced Analysis and Compliance Solution

193



HDM - Sink Electrical tests for CTS 2.0

f. Change the VICM to 3.3 V. Confirm that the Sink DUT continues to
support the transmitted image without errors. If the Sink DUT does not
support the transmitted resolution, then FAIL: “Min diff swing
unsupported at VICM2 range”.
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g. Connect the equipment as shown in the Sink Max diagram for
AWGT7122C or Sink Max diagram for AWG70002A.

Sink Min/Nominal/Max Diagram for AWG7122C
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Sink Max diagram for AWG70002A
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HDMI Connector
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NOTE. For AWG7122C, the connection remains the same as the nominal
pattern.

h. Set the common mode voltage (VICM) to 2.6 V.

i. Change the differential voltage to 1200 mV (600 mV/single-ended signal
= max swing).

j- Verify that the Sink DUT continues to support the transmitted image
without errors.

k. Ifthe Sink DUT does not support the transmitted image, then FAIL:
“Max diff swing unsupported at VICM1 range”.

I.  Change the VICM to 3.3 V. Verify that the Sink DUT continues to
support the transmitted image without errors.

m. If the Sink DUT fails to support the transmitted image, then FAIL: “Max
diff swing unsupported at VICM2 range”.
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HF2-2 Intra-pair skew test

This HDMI Receiver test confirms that the maximum allowed timing skew
within each TMDS pair is supported by the Sink DUT.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

HDMI signal generator: Two AWG70002A with options 01, 03 and 225, or
two AWG7122C with options 1, 2/6, 8, and option SDX with direct synthesis
capability to simulate cable emulator effect and Rise time filter effect.

Rise time Filter: Two 120 ps TTC filters (PSPL5915)

Test Fixture: A set of TF-HDM-TPA-S fixtures

DC Power Suppl

Bias Tees: Eight bias tees from Mini-Circuits — ZX85-12G-S+
Audio/Video display

Measurement algorithm  The following procedure is fully automated by Tektronix HDM Compliance
Software (Option HDM-DS):

1.

Connect the equipment as shown in the Sink Intra-pair skew diagram for

AWG7122C-Nominal/Skew on DO positive or Sink Intra-pair skew diagram

for AWG70002A-Nominal/Skew on DO positive.
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Sink Intra-pair skew diagram for AWG7122C-Nominal
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Sink Intra-pair skew diagram for AWG7122C-Skew on D0 positive
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*Variable Delay Line: Delay can be adjusted as per
the data rate: 5 .94Gbps: Sps Sink DUT
4.46Gbps: 8ps
3.71Gbps: 12ps
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Sink Intra-pair skew diagram for AWG70002A-Nominal

-

PFG wExt RefIn

10 Uk Rof ”:E

AWGT0002A | Out (Master) = c 578 0 e
Trig In A l Trig InA

ceagpfooo ]

| EX. D
120 ps TTC Filter %EJ [[e_a
DC =— L.L.T X Bias

DPO/DSA/MSO 70000 Series Bias XY,

H ] voltage vollage‘
RFDC=—TTTT

=)
17

5

Pouer supply

d 0vlvQ
N oviva

d viva

d %0010
N %0010

[

HDMI Connector

Sink DUT

204 TekExpress HDM Advanced Analysis and Compliance Solution



HDM - Sink Electrical tests for CTS 2.0

AFG w Ext Ref In
10 MHz Ref
Qut (Master)

Trig In A

AWGT0002A

Q .

CLK 1

120 ps TTC Filter

ll aRy
DC ~— Y Y YY Bias gias Y Y Y—~pC
‘ ‘ ‘ voltage voltage‘ | ‘
RF+DC =—— Y —=RF+DC
Power supply
O 7
=
olol9ljo|lo|lg|lo|o
—l1=liE=lIElIElIElIElE
olzdlz|za|=z2|=2]12
§ ‘9 |g lg |2 I2 WB I':‘5
olzlm|z|o|z]|o]|=

HOMI Connector
Sink DUT

]

TekExpress HDM Advanced Analysis and Compliance Solution 205



HDM - Sink Electrical tests for CTS 2.0

Sink Intra-pair skew diagram for AWG70002A-Skew on D0 positive
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4.46Gbps: 8ps
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2. Calibrate the HDM Signal Generator AWG7K/70K output for the following
settings.

= Frequency: Highest frequency supported by the Sink DUT

= Pattern: HDMI Gray Ramp data streams

m  Rise/fall times:
Set the rise/fall time of the TMDS CLOCK to between 75 ps and 110 ps.
Set the rise/fall time of the TMDS DATA between 42.5 ps and 65 ps.

= Set the Single Ended Swing to 500 mV.

= Setthe VICM to 2.8 V.

3. Do the following for each TMDS differential pair Clock and Data:
a. Apply the worst skew at TP2 to the pair being tested:
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Set skew of .15*Tbit on one line against the other line.

Apply the Worst Cable Emulator after the TMDS Signal Generator to
cause 112 ps signal delay on the line of the TMDS differential pair
against the other line.

b. Enable the Scrambling mode on DUT.
Operate the TMDS Signal Generator to output the tested Video Format.

d. If the Sink DUT fails to adequately support the transmitted image, then
FAIL.

e. Switch the setting of the signal delay on the other line for the tested
TMDS differential pair.

f. Ifthe Sink DUT fails to adequately support the transmitted image, then
FAIL

g. Repeat the test for the remaining untested pairs.
h. For all TMDS signals, set (VICM) to 3.3 V and repeat the procedure.

HF2-3-Jitter Tolerance test

This HDMI Receiver test confirms that the maximum allowed clock jitter on
TMDS signal is supported by the Sink DUT.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

HDMI signal generator: Two AWG70002A with options 01, 03 and 225, or
two AWG7122C with options 1, 2/6, 8, and option SDX with direct synthesis
capability to simulate cable emulator effect and Rise time filter effect.

Rise time filter: Two 120 ps TTC filters (PSPL5915)

Test fixture: A set of TF-HDM-TPA-S fixtures

DC Power Supply

Bias Tees: Eight bias tees from Mini-Circuits — ZX85-12G-S+
Audio/ Video display

Measurement algorithm  The following procedure is fully automated by Tektronix HDM Compliance
Software (Option HDM-DS ):

1.

208

Connect the equipment as shown in the Sink Jitter tolerance diagram for
AWG7122C-Nominal/Skew on Do positive or Sink Jitter tolerance diagram
for AWG70002A-Nominal/Skew on Do positive.
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Sink Jitter tolerance diagram for AWG7122C-Nominal
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Sink Jitter tolerance diagram for AWG7122C-Skew on D0 positive
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Sink Jitter tolerance diagram for AWG70002A-Nominal
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Sink Jitter tolerance diagram for AWG70002A-Skew on D0 positive
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2. Calibrate the HDM Signal Generator AWG7K/70K output for the following

settings.

a. Frequency: Highest frequency supported by the Sink DUT

b. Pattern: HDMI Gray Ramp data streams

c. Rise/fall times:
Set the rise/fall time of the TMDS CLOCK to between 75 ps and 110 ps.
Set the rise/fall time of the TMDS DATA between 42.5 ps and 65 ps.

d. SetVICMto29V.

e. Set Single Ended Swing to 400 mV.
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f. Below are the jitter frequencies inserted on the signal:
D JITTER =500 kHz (on TMDS_CLOCK), C JITTER = 10 MHz.
D JITTER = 1 MHz (on TMDS_CLOCK), C_JITTER =7 MHz.

NOTE. All jitter amounts described below are relative to a recovered
clock as measured with a Clock Recovery Unit).All four jitter frequencies
define sinusoidal jitter). [Make TP2 worst condition]

g. Apply the Worst Cable Emulator under the condition that the Worst
Cable Emulator causes delay on all TMDS DATA positive (+) lines
against negative (—) lines.

h. Generate TP2 signal and adjust the jitter amplitude as follows:

C _JITTER to be 0.3*Tbit at TP2 after processing with the CRU and
applying the Reference Cable Equalizer for 3.4 Gbps—6 Gbps.

Data waveform (eye diagram) to nearly touch the 2 corners (right and
left) points of the TP2 EQ eye mask, but without causing a TP2_EQ eye
mask violation after processing with the CRU and applying the
Reference Cable Equalizer for 3.4 Gbps—6 Gbps.

i. Connect the TMDS Signal Generator to the Sink DUT.

a. Use the [2C Analyzer to write 1 to the Scrambling Enable bit of the
Sink DUT.

b. Operate the TMDS Signal Generator to output the tested Video
Format.

c. Ifthe CDF field Sink Error Counter is “Y” and the DUT passed all
tests in Section 8.2.3 (Test ID HF2-18, HF2-19, HF2-20), then
measure the error rate using the Error Counter. If the Error rate is
more than 10-9, then FAIL.

NOTE. For Auto Calibration algorithm details, refer HDMXpress Online Help.
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HF2-6 Sink video timing - 6G - 2160p 24 bit color depth

This test confirms that the Sink DUT supports 24-bit color depth 2160p video
format for TMDS Character rate above 340 Mcsc up to 600 Mcsc.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

= HDMI Signal generator: Two AWG70002A instruments with options 01,
03 and 225 or two AWG7122C instruments with options 1, 2/6, 8, and
Option SDX with Direct Synthesis capability to simulate Cable emulator
effect and Rise time filter effect.

m  Rise time Filter: Two 120 ps TTC filter from Pico Second Pulse Labs
(5915-100-1200)

m  Test Fixture: One set of TF-HDM-TPA-S fixture

m  DC Power Supply: Tektronix Power Supply or any other

m  Bias Tees: Eight Bias Tees from Mini-Circuits — ZX85-12G-S+
®  Audio/Video Display

Measurement algorithm  The following procedure is fully automated by TekExpress HDM Software:

1. Connect the equipment as shown in the Sink Protocol diagram for
AWG7122C or Sink Protocol diagram for AWG70002A.
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Sink Protocol diagram for AWG7122C
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Sink Protocol diagram for AWG70002A
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2. Select the required video formats supported by the sink.
Perform the following test for each of the video formats listed in the EDID:

a. In the case of 60 Hz formats, the TMDS Clock frequency minimum and
maximum values are +0.5%/-0.6% of 148.5 MHz.

b. In the case of 50Hz formats, the TMDS Clock frequency minimum and
maximum values are +0.5%/-0.5% of 148.5 MHz.

Check that the TMDS clock frequency accuracy is +/- 0.5%.

4. Output each one of the video format timing listed in step 3, at a minimum
allowable TMDS clock frequency and maximum allowable TDMS clock
frequency. Perform steps 3 through 6 for each frequency.
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5.

If you use an auxiliary power supply, set the DC voltage in the pop-up field.
If you use a Tektronix power supply, automatically the Vicml would be set to
26V.

Recall the pattern on the AWG, synchronize the master and the slave AWGS.
Verify the Display is working, if not the result is FAIL.

a. Ifthe Sink DUT does not adequately support this video format, then
FAIL.

b. Ifthis step fails for any video format listed in step 2, then FAIL.

HF2-7 Sink video timing - 6G - 2160p deep color

This test confirms that the Sink DUT supports deep color 2160p video formats
for TMDS Character rate 340 Mcsc upto 600 Mcsc.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

HDMI Signal generator: Two AWG70002A instruments with options 01,
03 and 225 or two AWG7122C instruments with options 1, 2/6, 8

AFG: AFG3102/AFG3102C/AFG3252/AFG3252C

Rise time filter: Two 120 ps TTC filter from Pico Second Pulse Labs
(5915-100-1200)

Test fixture: HDMI 2-0 compatible fixture
Cables: One TF-HDM-TPA-S, one BNC T connector, three BNC cables

External power supply: PWS4721 / PWS4602 / PWS4323 / PWS4305 /
PWS4205

Bias Tees: Eight Bias Tees from Mini-Circuits — ZX85-12G-S+
DDC Master: Any approved DDC Master
EDID Analyzer: Any approved EDID analyzer

Measurement algorithm  The following procedure is fully automated by Tektronix HDM Software:

1.

224

Connect the equipment as shown in the Sink Protocol diagram for
AWG7122C or Sink Protocol diagram for AWG70002A.
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Sink Protocol diagram for AWG7122C
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Sink Protocol diagram for AWG70002A
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2. Select the required video format and color depth.

Perform the following tests for each of the video formats in the EDID:

a. In the case of 24/30 Hz formats, the TMDS clock frequency minimum
and maximum values are +0.5%/-0.6% of 92.8125 MHz, 111.375 MHz
or 148.5 MH.

b. In the case of 25Hz formats, the TMDS clock frequency minimum and
maximum values are +0.5%/-0.5% of 92.8125 MHz, 111.375 MHz or
148.5 MHz.

Check that the TMDS clock frequency accuracy is +/- 0.5%.

4. Then if DC_36bit of H14b-VSDB is equal to 1 in the EDID:
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If the value of Max TMDS Character Rate of HF-VSDB in the EDID x 5 is
greater than 445.5 then:

a.

Configure the TMDS Signal generator to transmit that video format to
the Sink DUT using 36-bit Pixel depth and RGB Pixel encoding at the
minimum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

Configure the TMDS Signal generator to transmit the tested video format
to the Sink DUT at the maximum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

If DC Y444 of H14b-VSDB is equal to 1 in the EDID, then configure
the TMDS Signal generator to transmit that video format to the Sink
DUT using 36-bit Pixel depth and YCBCR 4:4:4 Pixel encoding at the
minimum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

Configure the TMDS Signal generator to transmit the tested video format
to the Sink DUT at the maximum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

5. Then if DC_30bit of H14b-VSDB is equal to 1 in the EDID:

If the value of Max_TMDS_Character Rate of HF-VSDB in the EDID x 5 is
greater than 371.25 then:

a.

Configure the TMDS Signal generator to transmit that video format to
the Sink DUT using 30-bit Pixel depth and RGB Pixel encoding at the
minimum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

Configure the TMDS Signal generator to transmit the tested video format
to the Sink DUT at the maximum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

If DC_Y444 of H14b-VSDB is equal to 1 in the EDID, then configure
the TMDS Signal generator to transmit that video format to the Sink
DUT using 30-bit Pixel depth and YCBCR 4:4:4 Pixel encoding at the
minimum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

Configure the TMDS Signal generator to transmit the tested video format
to the Sink DUT at the maximum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

6. Then if DC_48bit of H14b-VSDB is equal to 1 in the EDID:
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If the value of Max TMDS Character Rate of HF-VSDB in the EDID x 5 is
greater than 594 then:

a. Configure the TMDS Signal generator to transmit that video format to
the Sink DUT using 48-bit Pixel depth and RGB Pixel encoding at the
minimum allowable TMDS clock frequency.

b. Ifthe Sink DUT does not adequately support this video format, then
FAIL.

c. Configure the TMDS Signal generator to transmit the tested video format
to the Sink DUT at the maximum allowable TMDS clock frequency.

d. Ifthe Sink DUT does not adequately support this video format, then
FAIL.

e. IfDC Y444 of H14b-VSDB is equal to 1 in the EDID, then configure
the TMDS Signal generator to transmit that video format to the Sink
DUT using 48-bit Pixel depth and YCBCR 4:4:4 Pixel encoding at the
minimum allowable TMDS clock frequency.

f. Ifthe Sink DUT does not adequately support this video format, then
FAIL.

g. Configure the TMDS Signal generator to transmit the tested video format
to the Sink DUT at the maximum allowable TMDS clock frequency.

h. If the Sink DUT does not adequately support this video format, then
FAIL.

HF2-8 Sink video timing - 6G - 2160p 3D

This test confirms that the Sink DUT supports 2160p 3D 2160p video formats for
TMDS Character rate above 340 Mcsc up to 600 Mcsc.

Required test equipment
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In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

HDMI Signal generator: AWG70002A instrument with options 01, 03 and
225 (quantity 2) OR AWG7122C instrument with options 1, 2/6, 8 (quantity

2)
AFG: AFG3102/AFG3102C/AFG3252/AFG3252C

Rise time Filter: Two 120 ps TTC filter from Pico Second Pulse Labs
(5915-100-1200)

Test Fixture: HDMI 2-0 compatible Fixture
Cables: One TF-HDM-TPA-S, one BNC T connector, three BNC cables

External power supply: PWS4721 / PWS4602 / PWS4323 / PWS4305 /
PWS4205

Bias Tees: Eight Bias Tees from Mini-Circuits — ZX85-12G-S+
DDC Master: Any approved DDC Master
EDID Analyzer: Any approved EDID analyzer
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Measurement algorithm  The following procedure is fully automated by Tektronix HDM Compliance
Software (Option HDM-DS):

1. CDF field Sink Above 340 is “N”, then Skip this test and go to the next test.

2. Connect the equipment as shown in the Sink Protocol diagram for
AWG7122C or Sink Protocol diagram for AWG70002A.

Sink Protocol diagram for AWG7122C

AFG WEmR‘eIIn
P

‘ )

AWGT122C (Siave)

 ——— |

JYYY —0c

Y P [—RF+DC

Power sui;ply

N™M0010

&

HDMI Connector

Sink DUT

TekExpress HDM Advanced Analysis and Compliance Solution 231



HDM - Sink Protocol tests for CTS 2.0

AWGT122C (10 FHz Ref Out (Master)

a6 |ExtReti

AWGT122C (Siave)

e ||

==l

DPQ700005X Series

g

{ @

232

DPO/DSAMSO 70000 Seri
e pias VY YY —=0C
2= ]1]
S —=RFDC
J
S

HDM! Connector

Sink DUT

TekExpress HDM Advanced Analysis and Compliance Solution



HDM - Sink Protocol tests for CTS 2.0

Sink Protocol diagram for AWG70002A
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a. In the case of 24/30/60Hz formats, the TMDS clock frequency minimum

and maximum values are +0.5%/-0.6% of 148.5 MH.

b. In the case of 25/50 Hz formats, the TMDS clock frequency minimum

and maximum values are +0.5%/-0.5% of 148.5 MHz.

Check that the TMDS clock frequency accuracy is +/- 0.5%.

frequency. Perform steps 3 through 6 for each frequency.

2.6 V.
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Perform the following test for each of the video formats listed in the EDID:

Output each of the video format timing listed in step 3, to a minimum
allowable TMDS clock frequency and maximum allowable TMDS clock

If you use an auxiliary power supply, set the DC voltage in the pop-up field.
If you use a Tektronix power supply, automatcally the Vicml would be set to
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6. Recall the pattern on the AWG, then synchronize the master and slave
AWGS. Verify the Display is working, if not the result is FAIL.

7. Ifthe Sink DUT does not adequately support this video format, then FAIL.
If this step fails for any video format listed in step 2, then FAIL.

HF2-23- Sink pixel decoding YCBCR 4:2:0

This test confirms that the Sink DUT supports YCBCR 4:2:0 Pixel decoding and
signaling.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

= HDMI Signal generator: Two AWG70002A instruments with options 01,
03 and 225 or two AWG7122C instruments with options 1, 2/6, 8

®  AFG: One AFG3102/AFG3102C/AFG3252/AFG3252C

®  Rise time filter: Two 120 ps TTC filter from Pico Second Pulse Labs
(5915-100-1200)

m  Test fixture: HDMI 2-0 compatible fixture
m Cables: one TF-HDM-TPA-S, one BNC T connector, three BNC cables

m  External power supply: 1- PWS4721 / PWS4602 / PWS4323 / PWS4305 /
PWS4205

m Bias Tees: Eight Bias Tees from Mini-Circuits — ZX85-12G-S+
= DDC Master: Any approved DDC Master
= EDID Analyzer: Any approved EDID analyzer

Measurement algorithm  The following procedure is fully automated by TekExpress HDM Software:

1. Ifthe CDF field Sink HDMI YCBCR 420 is “N”, then Skip this test and go
to the next test.

2. Connect the Sink DUT to any approved DDC master and EDID analyzer.

Turn on the Sink DUT, have the DDC Master output +5 V power and read
the sink DUT’s EDID in response to a hotplug.

4. If hotplug detect signal is not received or EDID is unreadable, then FAIL.
Connect the Sink DUT to the 297 MHz video generator.

6. Make the connection as shown in the Sink Protocol diagram for AWG7122C
or Sink Protocol diagram for AWG70002A.
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Sink Protocol diagram for AWG7122C
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Sink Protocol diagram for AWG70002A
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7. Recall nominal pattern YCBCR 420 8 Bit Pattern with pixel clock frequency
297 MHz -0.5 % (or -0.6% when the frame rate is 60 Hz) with test image as
shown in following Figure, AVI Infoframe with Y2, Y1, YO=011 and
appropriate VIC, synchronize AWG’s.

If the Image /Video appear to be distorted or incorrect, then FAIL.

If color bars in the upper half of the active video are not in the order shown in
the Figure, then FAIL.

10. If black and white bars in the lower half of the active video are not evenly
spaced, then FAIL.

11. If black and white bars in the lower half of the active video contain a strong
blue or red tint when examined at close range, then FAIL.
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12. Change Pixel clock frequency to 297 MHz +0.5%, synchronize AWG’s and

repeat steps 5 through 8.

13. If steps 5 through 8 pass then the test results are Pass; for all other conditions

it is Fail.

HF2-24 Sink pixel decoding YCBCR 4:2:0 deep color

This test confirms that a YCBCR 4:2:0 Pixel encoding-capable Sink DUT
supports YCBCR 4:2:0 deep color pixel decoding and signaling.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

240

HDMI Signal generator: Two AWG70002A instruments with options 01,
03 and 225 or two AWG7122C instruments with options 1, 2/6, 8

AFG: One AFG3102/AFG3102C/AFG3252/AFG3252C

Rise time filter: Two 120 ps TTC filter from Pico Second Pulse Labs
(5915-100-1200)

Test fixture: HDMI 2-0 compatible fixture
Cables: one TF-HDM-TPA-S, one BNC T connector, three BNC cables

External power supply: One PWS4721 / PWS4602 / PWS4323 / PWS4305 /
PWS4205

Bias Tees: Eight Bias Tees from Mini-Circuits — ZX85-12G-S+
DDC Master: Any approved DDC Master
EDID Analyzer: Any approved EDID analyzer
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Measurement algorithm

The following procedure is fully automated by TekExpress HDM Software:

1. Connect the equipment as shown in the connection diagram for Sink pixel
decoding — YCBCR 4:2:0. Recall the Nominal signal for the selected data
rate, synchronize the AWGS, and verify that the display is working fine; if
not, it will give result as fail. For nominal operation the connection diagram
should be same as shown in the Sink Protocol diagram for AWG7122C or
Sink Protocol diagram for AWG70002A.
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Sink Protocol diagram for AWG70002A
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Output a YCBCR 4:2:0 Pixel encoded signal with a specified Pixel clock
frequency.

If you use an auxiliary power supply, set the DC voltage in the pop-up field.
If you use a Tektronix power supply, automatically the Vicml would be set to
26V.

Recall the pattern on the AWG, then synchronize AWGS. Verify that the
Display continues to work, if not the result is FAIL.

If the image/video appears to be distorted or incorrect, then FAIL.

If the color bars in the upper half of the active video are not in the order
described in appendix A, then FAIL.

If the black and white bars in the lower half of the active video are not evenly
spaced, then FAIL.
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If the black and white bars in the lower half of the active video contain a
strong blue or red tint when examined at close range, then FAIL.

If all of the steps 4 through 8 pass, then the test passes, for all other
conditions, the test has failed.

HF2-25 Sink video timing - 21:9 (64:27)

This test confirms that a "21:9" (64:27)-capable Sink DUT, when it receives a
supported "21:9" (64:27) video format, it correctly decodes and displays it.

Required test Equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

HDMI Signal generator: Two AWG70002A instruments with options 01,
03 and 225 or two AWG7122C instruments with options 1, 2/6, 8

AFG: 1 AFG3102/AFG3102C/AFG3252/AFG3252C

Rise time filter: Two 120 ps TTC filter from Pico Second Pulse Labs
(5915-100-1200)

Test fixture: HDMI 2-0 compatible fixture
Cables: One TF-HDM-TPA-S, one BNC T connector, three BNC cables

External power supply: 1- PWS4721 / PWS4602 / PWS4323 / PWS4305 /
PWS4205

Bias Tees: Eight Bias Tees from Mini-Circuits (ZX85-12G-S+)
DDC Master: Any approved DDC Master
EDID Analyzer: Any approved EDID analyzer

Measurement algorithm  The following procedure is fully automated by TekExpress HDM Software:

1.

Connect the equipment as shown in the Sink Protocol diagram for
AWGT7122C or Sink Protocol diagram for AWG70002A.
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Sink Protocol diagram for AWG7122C
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Sink Protocol diagram for AWG70002A
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2. Ifthe CDF field SINK Video Formats 21by9 is all “N”, then Skip this test
and go the next test.

3. Read the EDID of the Sink DUT.

4. For each of the VIC codes in the ranges 65..92 and 103..107, check the Short
video descriptors and the CDF field.

a. If support for this video format is listed in the EDID, but it is not
declared in the CDF field, then FAIL.

b. If support for this video format is not listed in the EDID, but it is
declared in the CDF field, then FAIL.

5. If aux power is used, give the popup to set the DC voltage. If Tektronix
power supply is used, then set the Viem1 = 2.6 V, automatically.

6. Connect the Test signal generator to the Sink DUT.

7. For each of the VIC codes listed in CDF field SINK Video Formats 21by9,
configure the Test signal generator to generate the video timing specified by
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the VIC code. The Test signal generator should have a Pixel clock frequency
accuracy of £0.05% or better. Also configure the Test signal generator to
output a test image that will allow the tester to observe if the Sink DUT
displays the image properly (for example., No distortions such as spurious
dots, jitter, wrong colors; correct aspect ratio and position).

a. If the Sink supports both VIC codes of a dual aspect ratio pair that share
a common video timing (see the rows in CEA-861-F Table 1 that have
two values in the “VIC” column), then test these VIC codes together by
doing the following:

a.

If necessary, put the Sink is in an automatic mode using CDF field.
Sink AutoZoomStretch procedure, where the user has not forced a
certain zoom or stretch.

Configure the Test signal generator to send the video timing
associated with the dual aspect ratio pair.

Configure the Test signal generator to output an AVI InfoFrame
containing the first VIC of the dual aspect ratio pair along with a test
image matching the aspect ratio of the VIC being sent in the AVL.
This allows the correct aspect ratio to be determined.

Observe the displayed aspect ratio #1. If the displayed picture is not
geometrically correct, then FAIL.

Reconfigure the Test signal generator to output an AVI InfoFrame
containing the other VIC of the dual aspect ratio pair along with a
test image matching the aspect ratio of the VIC being sent in the
AVIL. This allows the correct aspect ratio to be determined.

Observe the displayed aspect ratio #2. If the displayed picture is not
geometrically correct, then FAIL.

b. For each unique video timing, test both the minimum and maximum
permitted Pixel clock frequencies as follows:

a.

For video formats with a 25 Hz frame rate (or multiples thereof),
these values are the nominal rate -0.5% and the nominal rate +0.5%.

For video formats with a 24 or 30 Hz frame rate (or multiples
thereof), these values are the nominal rate -0.6% and the nominal rate
+0.5%.
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HF2-36 Sink video timing - 6G - non-2160p 24 bit color depth

This test confirms that the Sink DUT supports 24-bit color depth non-2160p
video timings with a TMDS Character rate that is greater than 340 Mcsc
indicated in the EDID.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

HDMI Signal generator: Two AWG70002A instruments with options 01,
03 and 225 or two AWG7122C instruments with options 1, 2/6, 8

AFG: One AFG3102/AFG3102C/AFG3252/AFG3252C

Rise time filter: Two 120 ps TTC filter from Pico Second Pulse Labs
(5915-100-1200)

Test fixture: HDMI 2-0 compatible fixture and
Cables: One TF-HDM-TPA-S, one BNC T connector, three BNC cables

External power supply: One PWS4721 / PWS4602 / PWS4323 / PWS4305 /
PWS4205

Bias Tees: Eight Bias Tees from Mini-Circuits — ZX85-12G-S+
DDC Master: Any approved DDC Master
EDID Analyzer: Any approved EDID analyzer

Measurement algorithm  The following procedure is fully automated by TekExpress HDM Software:

1.

If the CDF field Sink_ Above 340 is “N”, then Skip this test and go to the
next test.

Connect the equipment as shown in the Sink Protocol diagram for
AWG7122C or Sink Protocol diagram for AWG70002A.
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Sink Protocol diagram for AWG7122C
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Sink Protocol diagram for AWG70002A
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3. Perform the following test for each of the video formats listed in the EDID:

a. In the case of 24/30/60 Hz formats (or multiples thereof), the TDMS
clock frequency the minimum and maximum values permitted are
+0.5%/-0.6%.

b. In the case of 25/50 Hz formats, the TDMS clock frequency minimum
and maximum values permitted are +0.5%/-0.5%.

Check that the TMDS clock frequency accuracy is +/- 0.5%.

4. Output each of the non -2160p 24 bit color depth signal with minimum
allowable TMDS clock frequency and maximum allowable TMDS clock
frequency. Perform the steps 3 through 6 for each frequency.

5. Ifyou use an auxiliary power supply, set the DC voltage in the pop-up field.
If you use a Tektronix power supply, automatically the Vicml would be set to
2.6 V.
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6. Recall the pattern on the AWG, synchronize the master and the slave AWGS.
Verify the Display is working, if not the result is FAIL.

7. Ifthe Sink DUT does not adequately support this video format, then FAIL.
If this step fails for any video format listed in step 2 then FAIL.

HF2-37 Sink video timing - 6G - non-2160p deep color

This test confirms that the Sink DUT supports deep color non-2160p video
formats for TMDS Character rate greater than 340 Mcsc indicated in the EDID.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

= HDMI Signal Generator: Two AWG70002A instruments with options 01,
03 and 225 or two AWG7122C instruments with options 1, 2/6, 8

®  AFG: One AFG3102/AFG3102C/AFG3252/AFG3252C

® Rise time Filter: Two 120 ps TTC filter from Pico Second Pulse Labs
(5915-100-1200)

m  Test Fixture: HDMI 2-0 compatible fixture
m  Cables: One TF-HDM-TPA-S, one BNC T connector, three BNC cables

m  External power supply: One PWS4721 / PWS4602 / PWS4323 / PWS4305 /
PWS4205

m Bias Tees: Eight Bias Tees from Mini-Circuits — ZX85-12G-S+
= DDC Master: Any approved DDC Master
= EDID Analyzer: Any approved EDID analyzer

Measurement algorithm  The following procedure is fully automated by TekExpress HDM Software:

1. Ifthe CDF field Sink Above 340 is “N”, then Skip this test and go to the
next test.

2. Connect the equipment as shown in the Sink Protocol diagram for
AWGT7122C or Sink Protocol diagram for AWG70002A.
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Sink Protocol diagram for AWG7122C
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Sink Protocol diagram for AWG70002A
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Select the required color depths supported by the sink DUT.
Perform the following test for each of the video formats listed in the EDID:

a. In the case of 24/30 Hz formats, the TMDS clock frequency minimum
and maximum values are +0.5%/-0.6% of 92.8125 MHz, 111.375 MHz
or 148.5 MHz.

b. In the case of 25 Hz formats, the TMDS clock frequency minimum and
maximum values are +0.5%/-0.5% of 92.8125 MHz, 111.375 MHz or
148.5 MHz.

Check that the TMDS clock frequency accuracy is +/- 0.5%.
5. Then if DC_36bit of H14b-VSDB is equal to 1 in the EDID:
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If the value of Max TMDS Character Rate of the HF-VSDB in the EDID x
5 is greater than or equal to 1.5 times the TMDS Character rate
corresponding to the video timing (when using 24 bit per Pixel) then:

a.

Configure the TMDS Signal generator to transmit that video format to
the Sink DUT using 36-bit Pixel depth and RGB Pixel encoding at the
minimum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

Configure the TMDS Signal generator to transmit the tested video format
to the Sink DUT at the maximum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

a. a. If DC Y444 of H14b-VSDB is equal to 1 in the EDID, then
configure the TMDS Signal generator to transmit that video format to
the Sink DUT using 36-bit Pixel depth and YCBCR 4:4:4 Pixel
encoding at the minimum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

Configure the TMDS Signal generator to transmit the tested video format
to the Sink DUT at the maximum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

6. Then if DC_30bit of H14b-VSDB is equal to 1 in the EDID:
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If the value of Max TMDS_ Character Rate of the HF-VSDB in the EDID x
5 is greater than or equal to 1.25 times the TMDS Character rate
corresponding to the video timing (when using 24 bit per Pixel) then:

a.

Configure the TMDS Signal generator to transmit that video format to
the Sink DUT using 30-bit Pixel depth and RGB Pixel encoding at the
minimum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL

Configure the TMDS Signal generator to transmit the tested video format
to the Sink DUT at the maximum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video Format, then
FAIL.

If DC_Y444 of H14b-VSDB is equal to 1 in the EDID, then configure
the TMDS Signal generator to transmit that video format to the Sink
DUT using 30-bit Pixel depth and YCBCR 4:4:4 Pixel encoding at the
minimum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

Configure the TMDS Signal generator to transmit the tested video format
to the Sink DUT at the maximum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

Then if DC_48bit of H14b-VSDB is equal to 1 in the EDID:

If the value of Max TMDS_Character Rate of HF-VSDB in the EDID x 5 is
greater than or equal to 2 times the TMDS Character rate corresponding to
the video timing (when using 24 bit per Pixel) then:

a.

Configure the TMDS Signal generator to transmit that video format to
the Sink DUT using 48-bit Pixel depth and RGB Pixel encoding at the
minimum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

Configure the TMDS Signal generator to transmit the tested video format
to the Sink DUT at the maximum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

If DC Y444 of H14b-VSDB is equal to 1 in the EDID, then configure
the TMDS Signal generator to transmit that video format to the Sink
DUT using 48-bit Pixel depth and YCBCR 4:4:4 Pixel encoding at the
minimum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

Configure the TMDS Signal generator to transmit the tested video format
to the Sink DUT at the maximum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.
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HF2-38 Sink video timing - 6G - non-2160p 3D

This test confirms that the Sink supports 3D and non-2160p video timings with a
TMDS Character rate that is greater than 340 Mcsc.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

HDMI Signal generator: Two AWG70002A instruments with options 01,
03 and 225 or two AWG7122C instruments with options 1, 2/6, 8

AFG: 1 AFG3102/AFG3102C/AFG3252/AFG3252C

Rise time filter: Two 120 ps TTC filter from Pico Second Pulse Labs
(5915-100-1200)

Test fixture: HDMI 2-0 compatible fixture
Cables: One TF-HDM-TPA-S, one BNC T connector, three BNC cables

External power supply: One PWS4721 / PWS4602 / PWS4323 / PWS4305 /
PWS4205

Bias Tees: Eight Bias Tees from Mini-Circuits — ZX85-12G-S+
DDC Master: Any approved DDC Master
EDID Analyzer: Any approved EDID analyzer

Measurement algorithm  The following procedure is fully automated by TekExpress HDM Software:

1.

Connect the equipment as shown in the Sink Protocol diagram for
AWG7122C or Sink Protocol diagram for AWG70002A.
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Sink Protocol diagram for AWG7122C
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Sink Protocol diagram for AWG70002A
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2. Perform the following test for each of the video formats listed in the EDID:

a. In the case of 24/30/60 Hz formats (or multiples thereof), the TDMS
clock frequency minimum and maximum values permitted are
+0.5%/-0.6%.

b. In the case of 25/50 Hz formats, the TDMS clock frequency minimum
and maximum values permitted are +0.5%/-0.5%.

Check that the TMDS clock frequency accuracy is +/- 0.5%.

3. Output non -2160p 3D signal with minimum allowable TMDS clock
frequency and maximum allowable TMDS clock frequency and perform
steps 4 through 6 for each frequency.

4. Ifyou use an auxiliary power supply, set the DC voltage in the pop-up field.
If you use a Tektronix power supply, automatically the Vicml would be set to
2.6 V.
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5. Recall the pattern on the AWG, synchronize the master and slave AWGS.
Verify the Display is working, if not the result is FAIL.

6. Ifthe Sink DUT does not adequately support this video format, then FAIL.
If this step fails for any video format listed in step 2, then FAIL.
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Map the My TekExpress folder

Map the shared My TekExpress folder as X: (X drive) on all instruments used in
test setup running Microsoft Windows Operating System. The My TekExpress
folder has the shared name format <domain><user ID>My TekExpress. Or, if the
instrument is not connected to a domain, then the share name format is
<instrument name><user ID> My TekExpress. This shared folder is used to save
the waveform files and is used during any other file transfer operations.

To map the My TekExpress folder on the instruments, follow these steps:
1. Open Windows Explorer.

2. From the Windows Explorer menu, click Computer.

3. In the menu bar, click Map network drive.
4

Select the Drive letter as X: (if there is any previous connection on X:,
disconnect it first through Tools > Disconnect Network drive menu of
Windows Explorer. Windows 7 users: if you do not see the Tools menu,
press the Alt key).

5. In the Folder field, enter the remote My TekExpress folder path (for example,
\\192.158.97.65\My TekExpress)

6. Click Finish.

To determine the IP address of the instrument where the My TekExpress folder
exists, do the following:

1. On the instrument where the My TekExpress folder exists, click Start and
select Run.

2. Type “cmd” and then press Enter.
3. At the command prompt, type “ipconfig” and then press Enter.
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Position the application, 43

K Probe setup illustration
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